# Contents

1. **About the Manual** ................................................................. 7  
2. **Basic principles of IDA and IDA Indoor Climate and Energy** ................. 9  
   2.1. **Introduction** ............................................................... 9  
   2.2. **The three levels of user interface** ................................... 9  
   2.3. **Forms and dialogs** ....................................................... 11  
3. **Model description** ............................................................. 12  
   3.1. **The Primary system** ..................................................... 12  
      3.1.1. **The Boiler** ......................................................... 13  
      3.1.2. **The Chiller** ..................................................... 13  
   3.2. **The air handling system** ............................................. 13  
   3.3. **The zone models** ...................................................... 16  
   3.4. **Solar radiation modeling** .......................................... 17  
   3.5. **Airflows** ................................................................. 18  
      3.5.1. **Air flow input forms** ......................................... 19  
   3.6. **General information regarding zone cooling and heating room units** .... 21  
   3.7. **Ideal heaters and coolers** .......................................... 21  
   3.8. **Hydronic heating devices** ........................................... 21  
   3.9. **Cooling units** ......................................................... 22  
      3.9.1. **Active beams** ................................................... 23  
      3.9.2. **Heating/Cooling floor (Expert edition)** ....................... 24  
4. **CAD and image import** ..................................................... 26  
   4.1. **Supported file formats** .............................................. 26  
      4.1.1. **BIM** .................................................................... 26  
      4.1.2. **CAD and vector graphic files** ................................ 26  
      4.1.3. **Image files** ...................................................... 27  
   4.2. **Importing IFC files** ................................................... 27  
   4.3. **Mapping data from IFC** ............................................. 27  
   4.4. **Create zones from IFC spaces** ...................................... 28  
   4.5. **Importing CAD objects as building bodies or zones** ................. 29  
   4.6. **Importing CAD objects and images as background** .................. 30  
   4.7. **Moving and scaling CAD objects and images** ....................... 30  
   4.8. **Shading by imported 3D objects** ................................... 30  
   4.9. **Storage of CAD objects** .............................................. 31  
5. **Getting started with the advanced level** ..................................... 32  
   5.1. **Example 1: Presenting more data in an existing diagram** ........... 34
5.2. Example 2: Shade control by zone temperature (Expert edition required) __ 34

6. Tips and tricks 37

6.1. Speeding up computation 37

6.2. Numerical instabilities 38

7. ICE Reference Manual 40

7.1. General 40

7.1.1. The Geometry in IDA Indoor Climate and Energy 40

7.1.2. Objects in IDA Indoor Climate and Energy (in alphabetical order) 42

7.1.3. Objects in IDA Indoor Climate and Energy (in hierarchical order) 43

7.2. Building simulation 46

7.2.1. General tab 46

7.2.2. Forms for IDA-resources 66

7.2.3. Floor plan tab 67

7.2.4. 3D tab 77

7.2.5. Simulation tab 83

7.2.6. Dialog for choice of output 84

7.2.7. Results tab 88

7.3. HVAC Systems 89

7.3.1. The Primary system 89

7.3.2. Air handling unit 90

7.3.3. Form for Heating Coil 90

7.3.4. Form for cooling coil 91

7.3.5. Form for Heat Exchanger 92

7.3.6. Form for choice of schedule 92

7.3.7. Edit temperature depending input 93

7.4. Zone 95

7.4.1. Zone form 95

7.4.2. Calculation of thermal bridge coefficients 97

7.4.3. Dialog for controller setpoints 98

7.4.4. Operative temperatures 99

7.4.5. Form for occupant load 100

7.4.6. Form for Lights 103

7.4.7. Light Control Macro 104

7.4.8. Form for equipment load 105

7.4.9. Convective internal mass 106

7.4.10. Thermal mass 106

7.4.11. Custom ventilation control 107

7.4.12. Zone Advanced tab 108

7.4.13. Zone central control 108

7.4.14. Walls, Floor and Ceiling 110

7.4.15. Windows and openings 117

7.4.16. Heating, cooling, ventilation 138

7.5. IDA Resources and Database 147

7.5.1. Database objects in IDA Indoor Climate and Energy 147

7.5.2. Dialog for Schedule 147

7.5.3. Editing a Profile 150
<table>
<thead>
<tr>
<th>Section</th>
<th>Title</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>7.6.</td>
<td>Mathematical Model</td>
<td>152</td>
</tr>
<tr>
<td>7.6.1.</td>
<td>Schema for zone (advanced level)</td>
<td>152</td>
</tr>
<tr>
<td>7.6.2.</td>
<td>Custom control</td>
<td>152</td>
</tr>
<tr>
<td>7.7.</td>
<td>Results</td>
<td>157</td>
</tr>
<tr>
<td>7.7.1.</td>
<td>Result – AHU (Air Handling Unit) temperatures</td>
<td>157</td>
</tr>
<tr>
<td>7.7.2.</td>
<td>Result – Airflow through the Air Handling Unit</td>
<td>158</td>
</tr>
<tr>
<td>7.7.3.</td>
<td>Result – Primary system’s temperatures</td>
<td>159</td>
</tr>
<tr>
<td>7.7.4.</td>
<td>Result – Total heating and cooling</td>
<td>160</td>
</tr>
<tr>
<td>7.7.5.</td>
<td>Result – Main temperatures</td>
<td>161</td>
</tr>
<tr>
<td>7.7.6.</td>
<td>Result – Heat balance</td>
<td>162</td>
</tr>
<tr>
<td>7.7.7.</td>
<td>Result – Air temperature at floor and ceiling</td>
<td>164</td>
</tr>
<tr>
<td>7.7.8.</td>
<td>Result – Fanger’s comfort indices</td>
<td>165</td>
</tr>
<tr>
<td>7.7.9.</td>
<td>Result – Air quality</td>
<td>166</td>
</tr>
<tr>
<td>7.7.10.</td>
<td>Result – Daylight level</td>
<td>167</td>
</tr>
<tr>
<td>7.7.11.</td>
<td>Directed operative temperatures</td>
<td>168</td>
</tr>
<tr>
<td>7.7.12.</td>
<td>Air flow in zone</td>
<td>169</td>
</tr>
<tr>
<td>7.7.13.</td>
<td>Airborne heat flow into zone</td>
<td>170</td>
</tr>
<tr>
<td>7.7.14.</td>
<td>Surface temperatures</td>
<td>171</td>
</tr>
<tr>
<td>7.7.15.</td>
<td>Surface heat fluxes</td>
<td>172</td>
</tr>
<tr>
<td>7.7.16.</td>
<td>Delivered Energy</td>
<td>172</td>
</tr>
<tr>
<td>7.7.17.</td>
<td>Result – Systems energy</td>
<td>173</td>
</tr>
<tr>
<td>7.7.18.</td>
<td>Result – Energy report for an air handling unit</td>
<td>176</td>
</tr>
<tr>
<td>7.7.19.</td>
<td>Result - Lost work</td>
<td>177</td>
</tr>
<tr>
<td>7.7.20.</td>
<td>Result – Zone energy</td>
<td>178</td>
</tr>
<tr>
<td>7.7.21.</td>
<td>Thermal comfort report</td>
<td>179</td>
</tr>
</tbody>
</table>
1. About the Manual

This manual gives a general introduction to IDA Indoor Climate and Energy (IDA ICE).

Before or in parallel with reading the manual, it is advisable to follow the Getting Started Guide, which is a separate document. This will bring you through a worked example and fill in supporting information in the process.

The documentation for individual forms, dialog boxes and reports is available as on-line help texts. Pressing F1 on your keyboard while a form or dialog is active will generally open the appropriate topic. Access to the on-line help texts, tutorial movies etc. is also available from the Help menu.

Chapters 2 and 3 provide a general overview of program management and the actual simulation models. Chapter 4 treats import of CAD data and chapter 5 is an introduction to working at the advanced level. In Chapter 6 some tips for getting optimal performance are given.
2. Basic principles of IDA and IDA Indoor Climate and Energy

2.1. Introduction

IDA Indoor Climate and Energy (ICE) is a program for study of the indoor climate of individual zones within a building, as well as energy consumption for the entire building. IDA Indoor Climate and Energy is an extension of the general IDA Simulation Environment. This means that the advanced user can, in principle, simulate any system whatsoever with the aid of the general functionality in the IDA environment.

Normally, the system to be simulated consists of a building with one or more zones, a primary system and one or more air handling systems. Surrounding buildings might shade the building. The air inside the building contains both humidity and carbon dioxide. Weather data is supplied by weather data files, or is artificially created by a model for a given 24-hour period. Consideration of wind and temperature driven airflow can be taken by a bulk air flow model. Predefined building components and other parameter objects can be loaded from a database.

2.2. The three levels of user interface

The user interface is divided into three different levels, with different support and scope for the user. At the simplest level, called wizard, the scope is limited to a certain type of study and level of approximation. The user is given the opportunity of carrying out a simulation directly, or transferring the data entered to the next level, called the standard level. With version 4.5, a new wizard interface IDA Early Stage Building Optimization (IDA ESBO) is included as a beta version, see Figure 2.1. The IDA Room wizard is still also available, both in the Windows version of IDA ICE and as a free web based application, see Figure 2.2. To learn more about IDA ESBO, press on the toolbar and then the F1 key on your keyboard to launch the online help. IDA Room is launched (in your web browser) by the button. Press the “?”-button on the toolbar of IDA Room to get help.

Figure 2.1 The Building tab of IDA ESBO
At the standard level (Figure 2.3), the user is given greater freedom to design a building model. This level defines geometry, materials, controller settings, loads, etc., in a manner that should be easy to handle for a majority of engineers. The basic steps of using the standard level are covered by the Getting Started Guide. An interactive Process guide (Help menu) is also available to guide you, by movies and other support, through the steps of building a model at the standard level.

At the advanced level (Figure 2.4), the simulation model is no longer defined in physical terms, but in the form of connected component models, whose meaning is defined by
equations. At this level, the individual time evolution of variables can be studied. All equations, parameters and variables can be examined at this level.

A user of the Expert edition of the program may also edit the connection structure at the advanced level. Some of these operations are easy to carry out, e.g. changing a proportional controller with a thermostat. Others are more complicated and require a deeper knowledge of the design of the models.

Use of the advanced level is introduced in Chapter 5. EQUA also maintains some exercises that can be used to gain familiarity with the advanced level. There is also a great deal of information in on-line help texts.

![Figure 2.4 Main Form for the building at the advanced level](image)

### 2.3. Forms and dialogs

The Windows part of the program (everything but IDA Room, which runs in a web browser) is built up around forms and dialogs. The forms contain no Cancel button, i.e. there is no access to earlier versions of a form (except by using Undo). Forms do not lock each other, and several windows with forms can be open simultaneously (but only the one where work is in progress is active). A form can be printed. Simulations and many other operations can be carried out without having to first close open forms. Dialogs, i.e. input windows with OK and Cancel buttons, work in IDA as in most other Windows programs. They lock everything else but the current dialog window.
3. Model description

This chapter treats the mathematical models of IDA Indoor Climate and Energy together with some of their input forms. The reader is assumed to have mastered the basics of the program by first following the getting started guides. More information can also be found on the User’s page: Help menu, IDA on the Web, ICE User Support.

A building model consists of a single or several thermal zones, a single or several air handling units and a single primary system. (From version 4.5 it is also possible to operate entirely without an air handling unit.) When a new model is initiated at the standard level, default air handling units and primary systems are normally automatically inserted (may depend on localization). The default systems have unlimited capacity for providing the zones with air and water at given temperatures. By default, the supply air temperature is kept constant at 17°C; the chilled water temperature to zones is 15 °C and the heated water temperature is a function of the outdoor air temperature. For many studies nothing needs to be altered in the HVAC systems.

The default air handling unit (AHU) can be removed, but a plant object must always be present in a model. (However, without an AHU or any water based room units, the plant will not use any energy.)

This description deals firstly with the default primary system (plant), then follows the supply chain to the AHU (Air Handling Unit), and finally to the zones. With IDA ESBO, more complex plants are easy to build. However, here, we will treat only the simple default plant configuration.

3.1. The Primary system

In the default configuration, the primary system consists of seven components (designated 1-6 respectively in Figure 3.1): chiller (1) and a schedule (2) for its operation as well as a boiler (3), a controller (4) for hot water supply temperature and a schedule (5) for night setback operation. Also connected to the boiler is a schedule for its operation (6). The six energy meters in the lower right corner monitor energy consumption of various categories in the primary system.

![Figure 3.1 The primary system in the default configuration](image)
3.1.1. The Boiler

The boiler converts purchased energy, e.g. gas, electricity or district heat, to warm water with given temperature and pressure for circulation through water based heat exchangers in the building. It also consumes energy for production of domestic hot water and pumping. Boiler efficiency is by default constant, as specified in the Defaults form. Open the component to view key parameters.

It is also possible in the standard boiler to model water heating efficiency as a function of boiler temperature and part load. The model and parameter definitions used are the same as those of EnergyPlus. Currently, there is no database support for this performance data since the IDA ESBO interface offers alternative ways of modeling more realistic equipment.

Pumping power consumption for heating water circulation can be specified in three ways: (1) proportional to the water flow through the boiler (default), (2) as a proportion of distributed heat, or (3) as a polynomial function of the water flow. The third option follows the conventions of ASHRAE 90.1.

The first option assumes an ideal pressure controlled pump with constant efficiency. Alternatively, by setting the efficiency to some large number and specifying the \( k_1 \) parameter, pumping effort can be given in proportion to distributed heat. (\( P\text{SetMax} \) should still have a somewhat realistic value.)

In the third option, the efficiency of different types of pumping solutions and control are reflected by a user provided polynomial function. This requires the input of a design massflow as a point of reference. Two standard curves from ASHRAE 90.1 are provided.

Pumping power for domestic hot water circulation can also be specified via \( k_2 \), which specifies pumping power as a fraction of domestic hot water heating power.

The setpoint for the hot water supply temperature comes from a special controller component connected to the boiler. The controller provides a graph showing the setpoint as a function of the outdoor air temperature. (Press F1 in the dialog for detailed instructions.)

3.1.2. The Chiller

The chiller and its circulation circuit operate in a similar way, but differ in some aspects from the boiler. The chiller uses electrical power to produce chilled water at two different constant temperatures (but with the same pressure). The colder water, normally 5 °C, supplies the AHU. The somewhat warmer temperature, normally 15 °C, goes to the zones.

Similarly as for the boiler, EnergyPlus correlations for modeling temperature and part load behavior may be applied. Pumping power is also specified as in the boiler.

3.2. The air handling system

In the default configuration, the air handling system consists of the following components (Figure 3.2): supply air temperature setpoint controller (1), exhaust fan (2), heat exchanger (3), heating coil (4), cooling coil (5), supply fan (6), schedule (7) for operation of both fans.
and a schedule for the operation of the heat exchanger (8). The unit provides temperature-controlled air at a given pressure. Some key parameters of individual components are presented in the form; open them to edit.

The supply air temperature setpoint is connected to the heat exchanger and to both coils. All three components have separate ideal control circuits, which independently strive to maintain the setpoint. After the coils, the supply fan raises the supply air temperature further by either a fixed number of degrees (default) or by depositing motor and drive losses to the air stream.

In the setpoint controller, three methods are provided for setpoint selection. In the default AHU, the setpoint is set to constant, 16 °C. The second alternative is to let the setpoint vary with time according to a schedule. Thirdly, an option is available where the setpoint is calculated as a (user-defined) function of outdoor air temperature. Note that if for example the chiller (that supplies the cooling coil from the plant) has been turned off or has insufficient capacity, the supply air will not be cooled to the setpoint.

The heating coil has two important parameters: the air side temperature effectiveness and the desired water side temperature reduction. Capacity control is achieved by adapting the actual effectiveness up to the given maximum level. The necessary water flow is calculated and the water temperature is reduced, if possible, by the desired number of degrees. There is no bypass on the liquid side; control is achieved by simply restricting the water flow.

In the default configuration, the temperature effectiveness is set at 1.0. There are basically two situations when it may be desirable to change this to a more realistic value: when sizing the actual coil by means of simulation experiments, or when making energy calculations in cases where the boiler efficiency is dependent on temperature conditions. In addition, the simplest and quickest way of removing the entire coil is to set the effectiveness to zero.

The cooling coil works in the same way as the heating coil, but is mathematically more complicated because air dehumidification is calculated. For wet operation the given effectiveness is defined as (1 - "bypass factor"), according to ASHRAE’s nomenclature. Physically, this means that the state of the cooled air in the psychrometric chart lies...
somewhere on a straight line between the state for the incoming air and the apparatus dew point temperature on the saturation curve. In the model, the average temperature of the liquid side defines the apparatus dew point. On this line, the given efficiency indicates the status: 0 is no cooling whatsoever, and 1 indicates maximum cooling, which also means that the air at most is chilled to (the arithmetic) mean value of the liquid incoming and outgoing temperatures.

Similarly, the heat exchanger is controlled by adapting the actual effectiveness selected by the model, up to the maximum limit set by the user, so that the setpoint for the supply air temperature is reached (if enough heat is available). The temperature of the (often chilled) exhaust air, which may not fall below a certain level (TEXHOUTMIN parameter), sets another limit. This is to avoid freezing. Note that for rotating heat exchangers, it is usually possible and desirable to cool the exhaust air below freezing.

The heat exchanger (“3” in Figure 3.2) takes into consideration condensation on both the supply and exhaust sides. During wet processes, the given efficiency is interpreted as (1 - “bypass factor”), in the same way as for the cooling coil, but the apparatus dew point for the heat exchanger is defined as the incoming temperature for the opposite medium.

The fans have ideal pressure control with given setpoints and by default constant efficiencies, i.e. they supply a fixed pressure head. In most cases, both these parameters only have significance for calculating fan electricity consumption. By default, the user gives directly the increase in air temperature by the fan and the system. As an option, the temperature rise may be computed automatically with a given percentage of motor and drive losses being deposited in the air.

For modeling of CAV systems, the fan pressure rise and efficiency at the intended operating point should be entered (pressure can also be given in terms of specific fan power, SFP). For VAV systems, on the other hand, the performance should be adapted for flows below the design point. ASHRAE Standard 90.1 prescribes a way to do this that has been implemented in the fan model. This part load efficiency reduction is activated selecting something else than <unlimited> in the drop box. A rated flow must also be provided for this option.

The fans operational schedule is connected to both the supply and exhaust fans. When the control signal is zero, the fans supply a very low pressure head (for numerical reasons, greater than zero). The fan schedule is also connected to all the air terminals in the zones. When the fans switch off, all terminals are closed. This is to avoid a spontaneous flow through the system caused by the chimney effect.

The fan schedule, like other schedules, gives normally values of 0 (off) and 1 (on) as output signals. However, it is meaningful for the fan schedule to sometimes give other values, thereby forcing ventilation flow. For example, if a value of 1.2 is given, all terminals will supply a 20% higher flow than that selected locally in the zone. This applies to both CAV and VAV systems. In the same way, a value of 0.5 results in half the flow.

The local terminal connection to the central schedule has no counterpart in actual systems, but has been introduced partly to avoid unintentional spontaneous flow in the system, and partly to permit forcing the flow in case of CAV.
The heat exchanger is similarly controlled by a schedule. To turn it off, the schedule should give the value 0. A value 1 turns on the heat exchanger. No other values are meaningful, i.e. it is not possible to partially turn on the heat exchanger.

3.3. The zone models

For the HVAC systems, the presentations for the standard and advanced user interface levels are the same (for the distinction between standard and advanced levels, see Section 5). However, in the case of the zone models, the presentations are completely different. This section explains the principal features of the zone models, and also provides a brief overview of the advanced level in this context. Actually, most users will never have to deal with the advanced level, but it is useful to know it exists, and the physics are more easily explained from the point of view of the advanced level.

IDA Indoor Climate and Energy provides two different zone models. One of these, the climate model, is quite detailed - it may for example calculate a vertical temperature gradient. The second model, the energy model, has a more conventional level of precision, and is based on a mean radiant temperature. Both zone models are based on the same description of the building, given in the standard level. All models of components in and around the zone, such as windows, radiators, controllers, leaks, terminals etc., are common to both the energy and climate models. The climate model is currently available only for zones with a rectangular geometry. From version 4, the energy model is default for new zones, but this can easily be changed in the Defaults form. More details about the mathematical models can be found in Models for Building Indoor Climate and Energy Simulation\textsuperscript{1} or by studying the NMF code in the Code tab of the component window at the advanced level.

Figure 3.3 shows a schematic view (advanced level) of a zone with the climate model. To access this window, press Build model in the Simulation tab, after entering all the information required in the standard level. In this case this includes selection of climate model, an ideal heater, a cooling panel and external shading. After the advanced level model has been generated, the user is able to select between General (standard level) and Schematic (advanced level) tabs for zones as well as for the building. The various component groups are numbered in the figure as follows:

1. Supply and exhaust air terminals
2. Ceiling/Floor\textsuperscript{2}
3. Air leak to ambient
4. Solar irradiation and external film coefficient, external wall
5. One external and three internal walls
6. Window and shading calculation components
7. Proportional controller for occupant automatic clothing adaption
8. PI controller for ideal heater
9. Cooling panel with controller and ceiling section behind
10. The actual zone model in which radiation, convection and loads etc. are modeled
11. Post processing components for results capture.

\textsuperscript{1} which can be downloaded from the User’s page: Help menu, IDA on the Web, ICE User Support
\textsuperscript{2} This object is both ceiling and floor, since the model was generated to represent zones above and below with identical conditions as the current zone.
3.4. Solar radiation modeling

A key issue in building simulation is the treatment of direct and diffuse solar radiation. Let us follow the main steps in the treatment of sunlight entering the building. If synthetic weather is used, ICE first computes direct and diffuse sunlight intensities based on the clearness number given in the Location object. At the advanced level, the components used for this computation are found in the Schematic tab of the building form under the heading Climate processor.

In the next model in the chain, the solar position in the sky is computed and all the signals computed so far are sent to a set of Face models, where the climatic conditions outside each main building surface (Façade) are computed. In this model, the distribution of diffuse radiation in the sky is also computed, by default using the Perez model.

In the next step, solar radiation on an individual object such as a window is computed. Connected to each window model (See Figure 3.3) is a shading calculation model (Shade), that computes the shading of both direct and diffuse light on the receiving surface. This model puts all shading surfaces in one ‘bin’, including building self shading, shading by neighboring buildings and shading by (possibly movable) objects directly outside of the window (External shading). Diffuse light from the sky is also shaded, but no reflections other than ground reflection are accounted for. Ground reflection for each face can be set from the Property page if the face name is selected in the Floor plan tab. Diffuse radiation from the ground is not shaded by external objects. All external shades are considered to be opaque.

The shade model is very difficult to interact with directly at the advanced level, since each surface has been subjected to several coordinate transformations. The actual shading factors are precomputed for all (plausible) solar locations and are stored as parameters in the shade model for the simulation.

Once in the window model, diffuse and direct light are reflected and transmitted depending on the window model used. The standard window model uses a fixed curve for the angle
dependence. Integrated window shading (internal or external shades in the plane of the window) will reduce radiation by multiplying the basic window parameters. It may also convert direct light to diffuse.

The detailed window model (Expert edition), makes a layer by layer computation of multiple reflections and each layer temperature is computed.

Once inside the zone, diffuse light is spread diffusely, while the exact target location of the direct light beam is computed. However, the whole surface of the window is considered as the light source, not just the portion of the glass which is actually not shaded by external objects. After the first reflection on a zone surface, the direct beam is spread diffusely in the room. And also here, the whole surface that is hit is regarded to reflect with equal intensity, not just the lit portion of this surface.

Internal windows and open doors transmit light in a similar way as an external window, i.e. the whole opening is regarded as being lit, even if only a small part of the door receives direct sunlight. The light intensity is of course adjusted accordingly. Similarly, light that enters through one window and exits through another external window, for example in a corner room, is treated in a physically reasonable way.

3.5. Airflows

This section covers the models and input which determine the airflows through the building. IDA Indoor Climate and Energy enables the user to take account of natural ventilation, i.e. flows driven by wind pressure and the stack (chimney) effect.

In the simplest case, each zone has three paths for airflows: through the supply and exhaust terminals and via leakage through the envelope. When two zones are placed adjacent to each other and there is an opening in the common wall between them or when windows are open or when additional leaks have been added, additional flow paths are created. However, let us start with the simplest case.

The mechanical ventilation terminals are always of VAV (Variable Air Volume) type. This means that as long as there is sufficient pressure head from the fans, a given flow is maintained as requested by the zone itself. In CAV (Constant Air Volume), the control signal is kept constant and a constant flow will be maintained, irrespective of pressure. In a VAV system, a controller regulates the flow with respect to temperature, carbon dioxide, humidity or pressure levels in the zone.

Since, in the simplest case, flows through two of the three paths are given, the size of the third flow, through the leak, is important only for the pressure in the zone, and not for net flows. Note that if the size of the leak is much too small, an unrealistic pressure may build up in the zone. Such a pressure may become so large as to affect the air psychometric calculation routines and may then be reported as a condensation problem, when, in fact, it is a pressure problem.

It is also possible to define additional given in/exfiltration flows, i.e. balanced flows into and out of a zone. Since these incoming and outgoing (mass)flows are always equal, they will not affect the pressure of a zone. The given in/exfiltration will only act to exchange heat, moisture and CO₂ with the ambient.
3.5.1. Air flow input forms

Figure 3.4 shows the zone form. The input fields in the Ventilation section govern air flows. Also involved are Controller setpoints. Clicking on the link field opens the dialog (see Figure 3.5).

![Zone form](image1)

**Figure 3.4** The zone form.

![Control setpoints](image2)

**Figure 3.5** Control setpoints

In the zone form, the user can select System type (CAV, VAV with temperature control, VAV with CO₂ control or VAV with humidity control, VAV with both temperature and CO₂ control, and VAV with pressure control, schedule controlled VAV etc.). For CAV, the required airflows are given directly in the zone form³. Leak area gives the size of the

³ The link “l/s m²” next to the input field enables input in various units.
combined envelope leak\(^4\). (In the model, the combined envelope leak area is distributed on all external walls, 1 m above floor level. The height is only relevant for natural ventilation situations.) Both Leak area and Given additional in/exfiltration are by default computed automatically based on information for the whole building that is given in the Infiltration form which is reached from the Building form.

In the combo box Controller setpoints (Figure 3.4), the user can select an object with a collection of relevant zone-level control setpoints. The Control setpoints dialog (Figure 3.5) provides input data for zone climate quality requirements. Here, only those parameters, which are of importance for airflows, are discussed. For a VAV system, the given minimum value of Mechanical exhaust airflow provides the lowest allowable airflow, with the maximum value providing the highest one. (In Figure 3.4, an exhaust only VAV system has been specified.) In the case of CAV, as was already pointed out, the desired flow is given directly in the zone form. If the chosen CAV flow falls out of the quality range provided in Control setpoints, a warning is issued when the simulation is started.

The other values in Figure 3.5 may impact on the corresponding VAV control scheme. If the user selects CO\(_2\) control, (see Figure 3.4), the airflow is varied in proportion to the CO\(_2\) content of the air in the zone. For the VAV with CO\(_2\) control scheme, a CO\(_2\) value, which equals or exceeds the given max-value (in Figure 3.5), results in the maximum flow through the exhaust terminal, with a minimum CO\(_2\) value producing the given minimum airflow. The humidity control function is entirely analogous with respect to relative humidity (assuming supply air will dry the zone).

The option ‘VAV with temperature control’ functions somewhat differently. Here, the maximum comfort temperature value is used. Forcing of the VAV flow begins somewhat below (normally 1 °C) the indicated maximum value (P control). Full exhaust flow (see Figure 3.5) is reached at somewhat above (normally 1 °C) the maximum temperature value. The throttling range is normally 2 °C, but can be selected at the building level under System parameters.

This scheme will assume that the supply air is able to cool the zone, i.e. if there is a need for heat and the supply air is warmer than the zone, this will not be recognized by the controller.

The option ‘VAV, temp+CO2’, on the other hand, will be “smart” enough to both heat and cool with the supply air. It relies on PI controllers instead of P ditto, and will therefore not have any offset error. In addition, it will also force air flow if needed to maintain CO\(_2\) level at the maximum limit. (The minimum limit is not used.)

Pressure controlled VAV is normally used for return air flow control where some other VAV method is used to supply air into adjacent zones. It will attempt to maintain zone pressure, within the given range, with respect to ambient pressure using a proportional controller (measured as pressure drop in the local ambient leak). In the example in Figure 3.5, the zone is maintained between 10 and 20 Pa below ambient pressure.

---

\(^4\) Equivalent Leakage Area (ELA) at 4 Pa and \(C_d=1\). ASHRAE Fundamentals provides a number of values regarding leaks according to this definition, as well as conversion methods between various representations of leak sizes.
3.6. **General information regarding zone cooling and heating room units**

Local heating or cooling is supplied to the zone by room units. All room units are listed in the zone form. Some units such as ideal heaters and coolers, do not have a given location in the room. These can be introduced directly into the list in the zone form. Most hydronic units may, on the other hand, be located on a specific zone surface and they are instead inserted by dragging them onto a surface. From version 4.5, most hydronic units can also exist without a specific position in the zone, i.e they can be dragged directly into the zone form. Note, however, that all radiative units still require an explicit surface area. (Given on the Properties page, when the input form of the unit is active.)

The temperature setpoint for cooling devices is normally taken directly from the Control setpoints, max value for Temperature\(^5\) (see Figure 3.5). The corresponding value for heaters is the Temperature min value. However, from version 4.5, it is also possible for the Expert edition user to define any controller for an individual device.

3.7. **Ideal heaters and coolers**

Ideal room units should be used to condition the zone when no detailed information about an actual room unit, such as a fan coil or active chilled beam, is available or this amount of detail is unmotivated. They have no given physical location on any room surface and are not connected to the plant of the building. They do have a maximum capacity parameter, enabling the user to experiment with limited heating/cooling capacity. However, this parameter should normally be set to a large enough value to always cover any foreseen need. However, do *not* set the value to a totally unrealistic number, e.g., 100 times the reasonable heating load. This will result in poor control action.

3.8. **Hydronic heating devices**

Heat emission from hydronic heating devices is calculated using

\[
P = K*l*dT^N,
\]

where \(l\) is device length and \(dT\) is the temperature difference between the water and the zone air. \(K\) and \(n\) are constants characterizing a device of a certain height (or width for ceiling devices).

Figure 3.6 has a radiator inserted on a wall surface. Its main form has been opened and a dialog for alternative input has been opened from the form. Often the values of \(K\), \(n\) and *Height* come from a database (gray colored text in the form). The user must only enter the surface area (given graphically) and the design water flow.

The warm radiator surface that is exposed to the zone is defined by the box that is drawn when the unit is inserted on a wall surface. The size of this box has meaning for the heat transfer. While the total emitted heat is always given by the expression for \(P\), the division

\(^5\) An exception is made when the air system is temperature controlled VAV. Cooling units in this case have their setpoints displaced by usually 2 °C. (Can be given centrally in System parameters). This means that the airflow is first forced to max value, after which the other cooling unit sets to work (assuming that free outside air cooling is often available).
between radiation and convection is calculated based on the surface temperature - which is connected to the water temperature - and the given exposed surface. The zone “sees” a warm surface and calculates the radiation and convection from this surface. The main part of the remaining heat (needed to complete $P$) is emitted convectively directly to the air (corresponding to convection behind a radiator). A small part of the heat goes to increase the temperature on the portion of wall behind the heating device. The heat transfer coefficient between the device surface and the wall behind is considered in the basic case to be completely dominated by radiation and is calculated by the model.

![Image of a radiator and alternative input dialog](image)

**Figure 3.6** A radiator on an external wall, its standard form, and a dialog for alternative input.

To facilitate adding new heating devices without direct knowledge of $K$ and $N$, a possibility for alternative input is given (see Figure 3.6, lower box). The values for design mass flow and $K$ are calculated from the power given by the user at the specified temperature conditions. The user also provides a value for $N$ in this case. Note that $K$ is calculated from the information given in the alternative input. This is thereafter the value for $K$. If the size of the graphical box is later changed, the device is likely to have an unintended maximum power. Note also that the actual maximum heating capacity of the device will vary with actual room and supply water temperatures. The temperature conditions given in Alternative data are only used to calculate $K$ and have no impact on the simulated supply and return water temperatures$^6$.

### 3.9. Cooling units

The Cooling device is used for radiative and convective units. Cooling units operate completely analogous to waterborne radiators, with the exception of a few differences in input, which are discussed here.

---

$^6$ The actual water supply temperature is given by the boiler; the return temperature will vary with the actual massflow through the unit, the current room temperature and the size ($K$ value) of the heating unit. However, if actual temperature conditions are made to coincide with those given in the dialog, exactly the given power will be emitted.
Figure 3.7 A cooling panel on the ceiling surface, its standard form, and a dialog for alternative input.

Here, the height of a radiator corresponds instead to a *Module width*, to which \( K \) and \( N \) refer. The total length is calculated as the given box area divided with *Module width*\(^7\). There is a difference in that the heat transfer coefficient between the back of the device, and the surface behind (often the ceiling) is given directly in the main form. If an (arbitrary) negative figure is entered, the heat transfer coefficient is calculated in the same way as for the heating device, i.e. as if all heat transfer was done by radiation. This is a good approximation for a device that has no insulation at all.

The dialog for alternative input has somewhat different parameters for cooling units. Absorbed power and temperature differences between air and water may be given for two points on the power curve. For max power, the temperature drop of the water is also given.

3.9.1. **Active beams**

Active beams serve both as supply air terminals and as cooling devices with significant convection. Their performance depends on the amount of supply air that is passed through but they normally retain a heat transfer contact with room air also in the case of zero supply air flow. The radiative coupling with the room is neglected in the present model. Beams are mostly used for cooling but may also heat the room air.

Two input data options are available: Simplified and Manufacturer’s. The latter means that the performance parameters \( K \) and \( N \) are given as functions of air flow. This alternative is mostly used when data is automatically imported from an on-line manufacturer’s database or from IDA Room. The Simplified option is based on two user supplied performance points, at design conditions and at zero flow (Figure 3.8). \( N \) is for this case set to 1.5.

\(^7\) The same is done for the radiator.
In the constant flow (CAV) case, the given Design air flow is regarded to pass through the beam whenever fans are running. For VAV, the constant Design air flow will pass through the beam whenever there is sufficient air into the room and surplus air will feed directly to the room without first passing the beam. If the VAV flow is insufficient to serve the beam with the full requested Design flow, the flow through the beam will reduced accordingly.

The total Design air flow through all beams must not exceed the total for the zone. If beam air flow is less than the requested total for the zone, the remaining part is regarded as being supplied through conventional terminals.

When the flow to the room is increased by forcing the central fan (or similarly reduced) the beams will still keep their requested Design flow, as far as possible.

### 3.9.2. Heating/Cooling floor (Expert edition)

If a floor heating/cooling object is inserted on the floor of a zone, the floor construction for this area is divided into two parts, above and below the heated layer. Between the two, a heat exchanger model is inserted corresponding to the piping layer. Quite often a floor heating circuit will heat the room below almost as much as the room it belongs to.

The floor coil model assumes that the active layer can be treated as an infinitely conductive plane in the floor slab, i.e. all 2D effects are disregarded. Heat transfer is calculated with a logarithmic temperature difference between the fluid and this plane of constant temperature. The user supplied total heat transfer coefficient between the fluid and the plane, includes

1. Convection between medium and tube wall
2. Heat conduction through the tube walls
3. “Fin efficiency” corresponding to the distance between immersed tubes or actual fins.

The modeling approach will in steady state correspond to the Resistance method of the standard EN 15377-1.

The floor coil circuit can have its own three-way valve and pump circuit keeping the massflow constant (default). Emitted power is then controlled by varying the supply water temperature. PI, P or on-off control can be selected (PI is default). A further alternative Always on is also available, which will keep both the boiler mass flow and the coil circulation massflow permanently at their design values. Control must then be maintained by the boiler temperature controller.
In the case where no separate coil pump circuit is used, the four control options will instead act by limiting the massflow through the coil, or keeping it constant at design conditions in the Always on case.

Figure 3.9 Floor heating form
4. CAD and image import

In IDA Indoor Climate and Energy it is possible to import CAD objects and image files. These can be used as a base when creating the simulation model, or as shading elements that cast shadows onto the simulation model. There are three categories of CAD objects and image files; building information models (BIM), CAD and vector graphic files, and image files.

BIM files contain 3D geometry as well as properties for walls, windows and materials etc. An IDA ICE model, i.e. building bodies, zones and windows etc., can be automatically created from the geometrical information. Furthermore, the properties of objects in the BIM file can be mapped to the corresponding objects in the simulation model. The 3D geometry of a BIM file can also be selected to shade the simulation model.

CAD and vector graphic files contain 3D or 2D geometry. A section of this geometry is shown as lines in the floor plan tab and these lines can be used to snap building bodies and zones etc. in the floor plan. Building bodies and zones can be automatically created from graphic files if the imported geometry consists of volumes enclosed by polygon surfaces. 3D CAD objects can be selected to shade the simulation model.

Image files contain raster (bitmap) images. These are shown in the floor plan tab when the section is close to the location of the image. The images can be used as a background when drawing building bodies and zones in the floor plan or when inserting windows and shading objects in the 3D view.

4.1. Supported file formats

4.1.1. BIM

Industry Foundation Classes (*.ifc)

4.1.2. CAD and vector graphic files

AutoCAD (*.dwg, *.dxf, *.dwf)
SketchUp (*.skp)
3D Studio (*.3ds)
Wavefront (*.obj)
Computer Graphics Metafile (*.cgm)
Corel Presentation Exchange (*.cmx)
MicroStation DGN (*.dgn)
Micrografx DRW (*.drw)
Gerber File Format (*.gbr)
Scalable Vector Graphics (*.svg)
Printer Command Language (*.pcl, *.prn, *.prt)
Macintosh PICT (*.pct)
HP-GL/HP-GL2 (*.plt)

IDA ICE supports DWG file formats up to AutoCAD 2004. DWG files of unsupported formats can be converted with the free tool Autodesk DWG TrueView. DWG files are assumed to be two-dimensional, i.e. any 3D geometry is flattened to 2D at import.
4.1.3. **Image files**

- Bitmap (*.bmp)
- JPEG Interchange Format (*.jpeg, *.jpg)
- Portable Networks Graphics (*.png)
- ZSoft PC Paint (*.pcx)
- Tagged Image File Format (*.tiff, *.tif)
- Adobe Photoshop (*.psd)
- Truevision (*.tga)
- Windows Meta File (*.emf, *.wmf)

### 4.2. Importing IFC files

In IDA ICE it is possible to import 3D building information models (BIM) via IFC files. Most 3D CAD applications can export architectural data in the IFC format.

The most important information that is transferred is geometrical data, i.e. the shape and position of zones, windows, doors, building faces etc. Zones in IDA ICE are automatically created from so called space objects in the IFC model. It is not sufficient that the CAD model only contains wall objects, spaces that fill the voids between walls must also have been created, a semi-automatic process in most CAD tools.

IDA ICE can also utilize other types of information in the CAD model, such as wall constructions, should they be present. One can find more detailed information about the ICE IFC implementation on the user’s page: Help menu, IDA on the Web, ICE User support. Select Users’ notes on the page and open the document ‘IFC Import’.

### 4.3. Mapping data from IFC

Start with a building without zones and select the Floorplan tab. Press IFC… > Import… to select an IFC file for loading. There are some sample IFC files in the installation, normally located in `C:\Program Files\IDA\samples\ICE\IFC`.

The first task is to map named data objects in the IFC model (if any are present) to corresponding IDA resources. Press IFC… > Mapping… in the Floorplan tab to open the Mapping dialog (Figure 4.1). If wall constructions have not been described in detail in the CAD model, select directly Constructions in the Category combo box. This will present a list of all wall types that have been found in the IFC model. Since IDA ICE needs more detailed information about a wall, IFC wall types need to be manually associated with IDA ICE wall constructions. To bind a certain IFC wall type to an IDA ICE construction, select both the IFC wall type and the corresponding ICE resource and press Map to selected. A right pointing arrow in the IFC Data list indicates that the item has been bound. Usually one first has to load relevant IDA ICE resources from the database by pressing Load from Db. To inspect the selected IDA resource, press View.

Repeat the procedure for window types as well. Here, one usually has to first create relevant windows in the ICE database, including internal shadings etc.
If wall constructions have been described in the IFC model with layer thicknesses and material names, one can automatically create corresponding IDA ICE constructions. In this case, one starts instead with binding IFC material names with IDA ICE material resources. Once the materials have been mapped, IDA ICE wall construction resources are created by pressing Import from IFC when the relevant IFC wall type has been selected.

Any object in the IFC model which is not explicitly mapped to an IDA resource will be set to its default value, which is given by pressing Defaults on the General tab in the building form.

![Image of IFC Mapping dialog](image)

**Figure 4.1 IFC Mapping dialog**

### 4.4. Create zones from IFC spaces

An IFC model may contain more than a single floor. A horizontal section (slice) of the building at a certain level is shown in the Floorplan tab (Figure 4.2). To select a different level, press the button Level: xx m, where xx is the floor height from ground of the current level. In the Level dialog, the building height from ground (Building top) and height coordinate of the floor slab with respect to ground (Building bottom) are also shown, as interpreted from the IFC file. These numbers are not always correct for the user’s purpose.

To define which spaces in the IFC model that should constitute a (thermal) zone in the simulation model, click on (select) the neighboring spaces that should be included. (Click again to unselect a space.) Think about zone economy, i.e. do not create more zones than you think is physically motivated for the current study. To create an IDA ICE zone from the selected IFC spaces, press New zone9. This will create zones using the currently selected zone template. Try to give as many reasonable defaults as possible for new zones using appropriate zone templates; after creation these values must be edited separately for each created zone.

---

9 By default an individual zone is created for each selected IFC space. Optionally, all the selected spaces can be merged (if they have the same floor and ceiling level) into larger zones. This setting is found under the ‘IFC’ button.
Figure 4.2 IFC model with an ICE zone, a selected IFC space and unselected IFC spaces.

The IDA ICE zones are created from the geometry of the corresponding IFC space(es). If for example a space is taller than the typical floor to floor distance of the building, the corresponding ICE zone will also reach over more than a single floor. One can change the horizontal section level during the zone creation process but it is currently not possible to combine several spaces vertically into a single zone. Note that the Floor plan view displays two models simultaneously, the zones of the created ICE model and the spaces of the IFC model. Both categories of “rooms” can be individually selected and ICE zones can also be opened.

If the IFC model is revised during the ICE modeling project, there is some support for retaining previous work. New IFC models can be loaded while modeling, either replacing the existing model or adding to it, e.g. loading several floors that are in separate IFC files. When a new file is loaded, the user is given the option to replace or add to the current IFC model and to replace or keep mapping information and existing ICE zones.

If the IFC information is incomplete or too complex for some part of the building, the user can simply avoid to instantiate these zones based on IFC background and draw them manually on the floor plan.

### 4.5. Importing CAD objects as building bodies or zones

CAD objects can be imported as building bodies or zones if the imported geometry only contains a volume enclosed by polygon surfaces (polyhedron) without holes between the surfaces. The geometry should describe the inner surface of the external walls for a building, and the inner surface of the zone walls for a zone. No other information than the pure geometry of the building body or zone can be included in the CAD object. Click Import… on the floor plan tab and choose Import building body… or Import zone geometry….
Imported building bodies and zones have protected geometry, i.e. their geometry is non-editable. However, an imported building body is fully editable if the imported geometry only has one floor and that floor is horizontal and does not contain any holes, and the geometry does not have any outward leaning walls (surfaces with their exterior normal pointing downwards). This is the same kind of geometry that can be created in the ICE roof editor. Importing geometry as zone will also create a building body of the same shape as the zone.

If a geometry file contains multiple polyhedron geometries, each with a separate color, they are imported as separate building bodies or zones in ICE. If surfaces are placed one wall thickness apart, these are regarded as thermally connected internal walls.

### 4.6. Importing CAD objects and images as background

CAD objects and image files are either imported with respect to the building coordinate system, and are then moved with the building if the building is repositioned or rotated, or they are imported with respect to the site coordinate system, and remain fixed if the building is repositioned or rotated.

Import a CAD object/image file with respect to the building coordinate system by clicking the Import button on the floor plan tab and choosing CAD and vector graphic. Alternatively, select Import CAD on the Insert menu while the 3D tab is shown.

Import a CAD object/image file with respect to the site coordinate system by clicking the Import site CAD button on the Site object dialog opened by clicking Site shading and orientation on the General tab. Alternatively, select Import CAD to site on the Insert menu while the 3D tab is shown.

To place a CAD object/image at the current mouse pointer in the 3D view, use Right mouse button menu > Import CAD or Right mouse button menu > Import CAD to site.

### 4.7. Moving and scaling CAD objects and images

A CAD object is automatically scaled and positioned so that it corresponds to the simulation model. The scale and position of a CAD object can be seen and edited by double-clicking on the object. A section of the CAD object or image is shown in the floor plan tab if the floor plan level is within the bounds of the object. Select this section by clicking on it. Move and change size of the CAD object/image by dragging/resizing the section.

A CAD object can also be moved in the 3D view. Select the CAD object, hold down the ctrl-key and drag the object. The object moves in the x-y plane. To move a CAD object along the z-axis, hold down the ctrl-key and the shift-key while dragging.

### 4.8. Shading by imported 3D objects

3D CAD objects can be selected to shade the simulation model. Check the Calculate shadows checkbox in the dialog shown when the object is double-clicked. Every non-transparent surface of the 3D object is included in the shadow calculation and visualization.

---

10 To select a CAD object, click on the geometry lines. To select an object that is behind another object, press the ctrl-key and click on the object until it is selected.
4.9. **Storage of CAD objects**

By default the geometrical information of CAD objects is saved in the system file (*.idm). The original CAD file is then not needed after the import. However, if a CAD file is big, very large system files can be created and the performance of IDA ICE can be slowed down. Thus, if a CAD file is big, the option of not saving it in the system file is given in the Preferences dialog, which is opened at import. In that case, only a shortcut to the original CAD file is saved in the system file and the original CAD file needs to be saved in the location specified by the shortcut. If the CAD file is placed in the ICE system folder (the folder with the same name as the system), the shortcut is relative and the CAD file is automatically copied with the system to a new location. Otherwise the shortcut is absolute and the CAD file is not copied with the system. The definition of a big CAD file can be changed in the Preferences dialog from the default of 10000 vertices. The Preferences dialog can also be opened from the Options menu.
5. Getting started with the advanced level

The standard level interface covers the most common simulation tasks, but sometimes it is useful to examine other variables than those available here or to replace a component model. To accomplish this one turns to the advanced level interface, where the system is described in a mathematical sense with components containing equations, variables and parameters.

Access to the advanced level is provided for both the Standard and Expert editions of IDA ICE. However, Expert edition users can manually edit (reconnect) component diagrams at the advanced level, while Standard edition users can only inspect, log variables and change parameters. Some of the examples below require the Expert edition, but this will then be mentioned in the introduction.

Work at the advanced level is best presented in terms of demonstration, so the written account here is quite brief. Look also at the User’s web page for more information on work at the advanced level, demonstration movies etc.

In some cases the system structures at the standard and advanced levels match each other quite well. The air handling unit, for instance, has different components: fans, coils etc. The same description can then be used for both the standard and advanced levels. The same is true for the primary system. However, for the actual building description entirely different structures are used for the standard and advanced levels.

Most components at the advanced level are described with equations. Components are interconnected by creating equalities between variables that appear on interfaces. An example is the interconnection between the cooling and heating coils in the air handling unit. Both the outflow interface of the heating coil and the inflow interface (terminal) of the cooling coil contain variables for: pressure, temperature, massflow, moisture and carbon dioxide concentrations.

To work on the advanced level, select Build model in the Simulation tab. This creates the schematic view of the current building. If the model has been built previously, Schematic is already available as a view of the system. Figure 5.1 shows the appearance of the air handling unit in the schematic view (which is also the standard view for the air handling system).
The behavior of a component is described by equations, variables and parameters. The difference between parameters and variables is that the former will never change their value during a simulation, whereas a variable might. A window area is an example of a "natural" parameter and the room air temperature is always a variable.

The description of most components is done using a special language called NMF (Neutral Model Format). Click on the Code tab of any of the AHU components, to see the NMF code. It contains the following main sections:

- **Abstract**: A brief textual description of the model.
- **Equations**: The actual mathematical description (formalized according to a strict syntax but quite readable also for humans).
- **Links/Interfaces**: A description of the ports or terminals of the component. A fan would typically have at least two links for incoming and outgoing air flow and could also have links for power supply and control signals.
- **Variables**: Variables to be calculated by the model.
- **Parameters**: Quantities that characterize the component, e.g. a vector of numbers describing the fan curve.
- **Parameter processing**: Computer code which converts user supplied parameters into those that actually appear in the equations.

From version 4, some models in the ICE library are instead described by the Modelica language (www.modelica.org).\(^{11}\)

---

\(^{11}\) The IDA Modelica development environment is not yet publicly released and focus here will be on NMF. The NMF development environment is shipped on request with the Expert edition of IDA ICE 4.5.
We will now go through a few examples of useful operations at the advanced level of ICE.

### 5.1. Example 1: Presenting more data in an existing diagram

Suppose we are interested in the air temperature after the heat exchanger in the air handling unit and would like to see the graph together with the other temperatures of the AHU. Open the AHU window (Figure 5.1) and double click on the connection between the heat exchanger and the heating coil. A small window is opened showing the connection between the two interfaces; SUPPOUT (SUPply OUT) of the heat exchanger (hx) is connected to the AIRFLOWIN interface of the heating coil (hc). To see the actual variables of the connection, double click on the box hx.SUPPOUT. TSUPPOUT is the variable we are looking for. Double click on it to get the form at the lower right of Figure 5.2.

![Figure 5.2](image)

All relevant information about the variable is displayed in this window. At the bottom of the window, there is a combo box for logging the variable to a diagram. Select “AHU temperatures” in the combo box and give a meaningful name to this variable in the corresponding field. Make a simulation, and inspect the added graph in the diagram.

### 5.2. Example 2: Shade control by zone temperature (Expert edition required)

Normally, window integrated shading is controlled by the amount of radiation that penetrates the glazing. However, in some applications it can be useful to let the zone air temperature determine whether shades should be drawn instead. From version 4, it is possible to define customized controls for shading (and other devices) at the standard level.

We look at a simple case consisting of a single zone with a window in one wall and intend to have an external blind shading the window depending on the zone air temperature and governed by a thermostat. First insert an external blind. Double click on the window to open the window form. Search in database under “Integrated Window Shading” and select “External blind” as Device as shown in Figure 5.3.
Next we define the control system to use. Right below the previous choice in the window form select “New” instead of “Light + Schedule” as Control and give an appropriate name. An empty macro form appears. Drag a thermostat from the Control palette and connect the AirTemp link on the “Zone” box to the measure link on the thermostat as shown in Figure 5.4. Click and hold to draw the connection. Similarly, connect the out signal link of the Thermostat to the macro output “Shading signal”.

To achieve the right performance of the thermostat we have to give a dead band with sign; in this case a negative sign to get out signal 1 for high measure signals and 0 for low. Finally we insert a Constant field from the Utility palette and connect it to the setpoint link of the thermostat. With a given setpoint value (22°C in Figure 5.5) the control system is defined. After the simulation the effect of the shade control can be checked in the diagram “Heat balance of building”.

Figure 5.3

Figure 5.4
Figure 5.5
6. Tips and tricks

6.1. Speeding up computation

IDA Indoor Climate and Energy builds a single large simultaneous system of equations for all processes in the building. This system of equations contains several ordinary differential equations and has therefore different “built in” time constants. The room air will for example react quickly on a convective heat load, while the ground layer below the building can have a time constant several orders of magnitude larger. This system of equations is solved with numerical methods that adapt the timestep to the frequency content of the solution. Short time constants in the model in combination with high frequency content in driving functions (many starts and stops) can lead to long execution times.

Internally generated starts and stops (events) will also lead to short timesteps. Try for example to use a thermostat for radiator control.

The shear number of equations in the system is naturally significant for the execution time, which increases roughly linearly with the problem size. Therefore, it is vital not to model any unnecessary detail, and not for example model a large number of identical objects such as windows or cooling beams, when they could be replaced by a single larger one. Each added zone will contribute about two thousand variables to the system of equations.

The single most important factor for speeding up calculations is to have a reasonable amount of detail in time schedules (driving functions). Describing many sharp transitions will usually only result in increased computation time and not have a significant impact on results. From version 4, automatic smoothing is applied to key schedules to minimize these problems. (Can be turned off under System parameters).

For a model with reasonably simple time schedules, it can often prove effective to loosen the numerical tolerance to make the solver take longer and thereby fewer timesteps. Two important solver parameters are Tolerance and Maximum timestep. These are accessed from the Advanced tab of the Simulation data dialog. Often the tolerance can be relaxed to, say, 0.1-0.3 from the standard value 0.02. For problems with equations that are difficult to solve, it can sometimes be beneficial to instead decrease the tolerance. (The solver spends less time on failed attempts to take long steps.)

Looser tolerance will normally lead to acceptable loss of accuracy for accumulated quantities such as monthly energy consumption. For computing design (extreme values) of quantities such as heating or cooling load, one should be more careful with using loose tolerances and a large max timestep. Too loose a tolerance will on the other hand lead to decreased robustness, forcing the solver to often have to back up and retry with a smaller timestep, ultimately leading again to even longer execution time (if indeed the simulation is successful).

---

12 For more primitive numerical methods, the execution time will typically grow as the cube of the problem size.
To learn about the statistics of a simulation in terms of number of timesteps, variables, restarts etc. view the file `screen.txt` in the IDA temporary directory `idamod45`. At the end of this file some statistics are given.

### 6.2. Numerical instabilities

With a tool like IDA Indoor Climate and Energy it is easy to build large non-linear systems of equations and solve them for thousands of time points. However, it is impossible to, even theoretically, guarantee the success of the solution procedure. Any non-linear system of equations may have more than a single solution or none at all. Numerical computer programs are in this respect different from most other types of software, where it may be, at least theoretically, possible to create a bug-free code. IDA Indoor Climate and Energy also has a more difficult task than most other building simulation software, where less freedom is given to create mathematically complex models.

A major part of the IDA development work is devoted to improving the solver performance on difficult cases. However, this work is altogether dependent on close interaction with users. It is vital that users, which have built reasonable and meaningful models that are difficult to solve, take the trouble of sending the model to the support office. This is most easily done by using the Mail support function on the Help menu.

Some physical processes more often lead to problematic models. Generally speaking, models with significant natural ventilation flows through openings or leaks are the most difficult to solve, especially when the effect of wind pressure is included. If, in addition, vertical temperature gradients are to be simultaneously computed, one obtains a severely stiff and non-linear system of equations.

Avoid to use vertical or horizontal openings unless the bidirectional flow is essential for the study (use large leaks instead). Absolutely do not use large openings for the purpose of recreating the exact geometry of a real building. Normally, precise geometry has a very small impact on results.

A common type of error is when the user has graphically defined a piecewise linear controller and unintentionally entered several points near each other, giving the curve (in micro scale) several sharp corners and jumps. The solver will invariably have problems to negotiate the sharp turns of such a graph. Check the table view of such a curve for unintentional points.

A model that in spite of numerous revisions continues to give some trouble is the radiator and cooling panel model. If the user requests a large (or very small) maximum power in relation to the physical size of the device, the model may lead to failed simulations. The solution is to alter the physical dimensions somewhat.

A general way of dealing with difficult cases is to decrease the tolerance parameter that was discussed in the previous section. This forces the solver to be more careful and take smaller steps, which in most cases improves robustness. A tolerance of 0.001 or even smaller can sometimes be used.

---

13 This directory may occur in different locations depending on Windows version used. The path to the temporary directory can be found under Options > Preferences > Advanced. Solver files can also be viewed from the View menu > Solver files.
A frequent situation is that any change in input data makes a previously failed run go through. This is not as strange as it sounds, since each change will lead to a different sequence of timesteps and in this way the exact combination of values that led to the failed timestep is avoided.

Another often effective trick is to replace sharp steps in schedules with steep ramps, especially for the fan control schedule. This will enable the solver to gradually over a short time period approach the new solution and thereby reach it more securely. If, in addition, the start and endpoints of the ramp are marked as input events (double entries of the same point in the table view), the solver will be even more cautious. Input events are marked by repeating the same time point twice in the profile, something best done in the Data tab view.
7. ICE Reference Manual

7.1. General

IDA Indoor Climate and Energy (ICE) is a simulation application for accurate study of indoor climate of individual thermal zones in a building as well as energy consumption for the entire building. The user interface has been designed to make it easy to build up and simulate simple cases, but also to offer the advanced user the full flexibility of IDA, to facilitate the simulation of complex or unusual cases.

The system to be simulated consists of a building with one or more zones (rooms) and a primary system (the subsystem containing primarily hydronic components such as chillers and boilers) and one or more air handling units. The default plant and AHU have unlimited capacity for providing zones with air and water at given temperatures. For many studies nothing needs to be altered in these central HVAC systems.

With version 4, two additional concepts are added: ideal room units (cooler and heater) and local air handling units. Local AHUs are the same thing as central AHUs, but they serve only a single zone and they are reached only from this zone (under the More… button). Ideal room units provide zones with heating and cooling, but they are not physically connected to the central plant. They can be thought of as self contained boilers and chillers, consuming electricity or fuel and serving the zone with heating or cooling.

Surrounding buildings or other objects might shade the building. The air inside the building contains both humidity and carbon dioxide. Weather data is supplied by weather data files containing information on actual or synthetic weather. The effects of wind on the building may be taken into consideration. Predefined building components can be loaded from a database. This can also be used to store personally defined building components.

The program is built up around forms and dialogs. The Status bar can be found at the bottom of the IDA window. In many cases it explains in brief the significance of the different areas (list boxes, parameter boxes, etc.) that can be found under the cursor in the different forms and dialogs. It is recommended that the user get into the habit of reading the text in the Status bar if anything is unclear.

7.1.1. The Geometry in IDA Indoor Climate and Energy

A building in IDA Indoor Climate and Energy can contain one or several zones (rooms). A zone is either

- a prism with any number of flat vertical walls, a flat horizontal floor and one ceiling;
- a part of such prism limited by the building's roof;
- a custom polyhedral (an arbitrary volume, bounded by polygons) that may be imported but not edited in ICE.

In addition to windows and openings (doors), different types of heating and cooling units can exist within these restricted surfaces.
The geometry of the building is defined by the corners of one or more building body parts (see above figure). The corners’ x and y co-ordinates are indicated in a local coordinate system for the building (called the building system below) that moves and rotates with the building. Before editing, the origin of coordinates for the building system coincides with the lower left corner of the building. The building system is then also at the origin of coordinates for the global coordinate system (which is marked by the origin marker).

The shape of building body part is limited to

- prisms with flat vertical walls
- a part of such prism limited by the roof. The roof may consist of one or more flat polygons with slope from 0° (horizontal, outer side upward) to 90° (vertical).
- a custom polyhedral that may be imported but not edited in ICE.

The zone geometry is described relative to a point in the building system, where the z-coordinate gives the height of the floor above ground level.

The zone is defined by its height plus the corners of the floor. The corners’ x and y co-ordinates are indicated in a local coordinate system for the zone (called the zone system below) that moves and rotates with the zone. The zone system is defined by the origin’s coordinates (in the building system) and the rotation angle around the z-axis.

The shape of the zones is limited to prisms with vertical walls. If the prism is intersecting with the roof, only the part under the roof is included in the zone.

A local coordinate system (called the surface system) is defined on every enclosing surface. For vertical walls, the origin of coordinates is located in the lower left corner of the surface (from inside the zone). For floors and horizontal ceilings, the surface system coincides with the zone system (with z-coordinate omitted). For slanted ceilings (or fragments of ceiling), the x-coordinate is always horizontal passes thru the lowest corner of the ceiling (or fragment).
and the y-coordinates is located in the ceiling's plane, is perpendicular to the x-axis and passes thru the leftmost corner of the ceiling (or fragment).
The surface system is used to indicate the position for features (such as openings) on the surface:

![Diagram of surface system](image)

The geometry for objects like windows and heating devices is defined by a rectangle. The insertion point of the rectangle (lower left corner) is given in the surface system. If the surface (wall, floor, or ceiling) is not rectangular, the position of an object is the intersection of the rectangle with surface.

See also Building and zone geometry import.

### 7.1.2. Objects in IDA Indoor Climate and Energy (in alphabetical order)

IDA Indoor Climate and Energy contains a number of objects of interest to the user. See also Objects in hierarchical order.

- Active beam
- Air handling unit
- Balcony, screen and marquee
- Building
- Building body
- Chimney
- Choice of output
- Climate definition
- Climate file
- Control of integrated shading
- Controller setpoints
- Convective interior mass
- Cooling coil
- Cooling device
- Double-glass Façade
- Electric radiator
- Equipment
- External window shading
- Extra energy and losses
- Fan coil
- Face
- Floor heating
- Ground conditions
- Heat exchanger
7.1.3. Objects in IDA Indoor Climate and Energy (in hierarchical order)

The hierarchical structure for the objects in IDA Indoor Climate and Energy are shown in the formation below. Objects are edited either in forms or dialogs. See also Objects in alphabetical order.

Building
  Location
Wind profile
Climate data
Holidays
Zone defaults
Site object
Simulation data
System parameters
Choice of output
Project data
Climate file
Ground conditions
Thermal bridges
Infiltration
Extra energy and losses
Results objects
Air handling unit
Primary system
Building body
Faces
Roof
   Faces
Zone
   Controller setpoints
   Thermal bridges
Results objects
Surfaces
   Construction
   Inner surface
   Outer surface
Wall part
Window
   Glass construction
   Integrated shading
   Schedule for integrated shading
   Control of integrated shading
   External shading
      Balcony, screen and marquee
   Opening schedule
   Opening control
Window (detailed)
   Detailed Glazing System
   Double-glass Façade
   Schedule for integrated shading
   Control of integrated shading
   External shading
      Balcony, screen and marquee
   Opening schedule
   Opening control
Opening
   Opening schedule
Leak
Chimney
Skylight
Active beam
Heating device
Electric radiator
Cooling device
Floor heating
Heated/cooled floor
Heated/cooled panel

Fan coil
Local AHU
Ideal cooling device
Ideal heating device
Heating device with unspecified position
Electric radiator with unspecified position
Cooling device with unspecified position
Heated/cooled panel with unspecified position
Active beam with unspecified position

Lights
  Schedule

Occupant
  Schedule

Equipment
  Schedule
  Convective internal mass
  Thermal mass

Energy meter
  Energy cost
7.2. Building simulation

7.2.1. General tab

7.2.1.1. The building’s form

An object of the Building type is presented in a form on the screen. This contains all the objects connected to the building. The building’s form is automatically displayed each time the user selects to open an already existing, or a new, document (please see Working with IDA systems). The form above shows a sample appearance of the building form. It contains standard versions of the air handling unit, the primary system and energy meters in the HVAC-system and Energy meter list boxes.

Field descriptions, etc:
Location
Location of the building. The chosen location does not have to correspond exactly to the location of the climate file.

Climate
Choice of climate object. The object contains a reference to a climate file and information about this file or indicates that synthetic climate is to be used (design day data for summer or winter in the Location object).

Wind profile
Choice of wind profile object. Wind profile is only important for studies where pressure coefficients are given.

Holidays
Optional choice of list of holidays. The holidays are treated either as Sundays or using special rules – for time schedules that define such rules.

Project data
Object for documentation of the simulation object and the current choice of parameters. Project data are written on reports etc.

Defaults
Default settings for all zones and HVAC systems.

**Site shading and orientation**
- Building orientation (compass arrow) and definition of separate shading objects, e.g. trees, hills and neighboring buildings.

**Thermal bridges**
- Coefficients for calculation of loss factors for thermal bridges in zones.

**Ground properties**
- Model and parameters for temperature conditions below the building.

**Infiltration**
- Method and parameters for building air leakage

**Pressure coefficients**
- Coefficients for calculation of wind pressure on external surfaces of the building.

**Extra energy and losses**
- Losses from HVAC distribution systems, hot water and other energy use items

**HVAC System**
- List of central hydronic and air handling units.

**New AHU ...**
- Add an extra AHU (If the existing one is not needed: Do 'Replace' instead)

**Replace AHU ...**
- Replace the selected AHU with a new one.

**Supervisory control**
- A controller that collects signals from the environment (utility signals etc.) and from building sensors and computes supervisory control signals that are relevant to the whole building.

**Energy meters**
- List of energy account items, with info on cost, CO2, and primary energy factor
- Click “Usage” to list all references to energy meters

**Details**
- This table shows the main parameters of zones and other objects. The row of radio buttons allows selecting the category of objects to be shown in the table. In the table, you may:
  - edit parameters (except in grey fields)
  - select cells and copy/paste their contents to and from other applications
  - open objects (double click the object in the left column)
  - sort the contents by clicking a column header
  - show a parameter on the 3D plan (click "box" image in the column header)
  - export all tables to Excel
  - reorder the zones (in the Zones table only). The selected zone may be moved up and down by clicking Alt+Up and Alt+Down. This order will be used when combining the results into a single document (see Results tab, Make report).
7.2.1.2. Dialog for location

This dialog describes an object of the Location type. It contains the geographical position and design weather data for the place where the calculation object, i.e. simulated building, is assumed to lie.

The given weather data for winter and summer design conditions are used when synthetic weather has been selected in Heating or Cooling load calculations. This data is also used for Custom simulations when the Synthetic (winter or summer) option has been selected in the Climate field in the building form.

Field descriptions, etc:
- **Location**: Choice of location. The rest of the dialog shows the details of the selected location.
- **Position: Country**: country or geographical area for calculation
- **Position: City**: place for calculation
- **Position: Latitude**: calculation object’s latitude (Deg). To avoid sign confusion, the directions from equator are denoted by N (north) and S (south)
**Position: Longitude** calculations object’s longitude (Deg). To avoid sign confusion, the directions from Greenwich are denoted by E (east) and W (west).

**Position: Elevation** calculation object’s height over sea level (m).

**Position: Time zone** calculation object’s time zone (h). To avoid sign confusion, the directions from Greenwich are denoted by E (east) and W (west), e.g. 1 E for Central Europe.

**Design days: Dry-bulb min** Lowest dry bulb temperature during the day (°C)

**Design days: Dry-bulb max** Highest dry bulb temperature during the day is considered to occur at 15:00. (°C)

**Design days: Wet-bulb max** Highest wet bulb temperature during the day is considered to occur at 15:00. (°C)

**Design days: Wind direction** The wind is only relevant to the airflow through the building if pressure coefficients are given and more than one leak or opening has been defined. (Deg) The wind from North has direction 0°, from East 90°, etc.

**Design days: Wind speed** Wind direction and speed is kept constant during the day (m/s)

**Design days: Clearness number** Reduction factor for direct and diffuse sunlight. 0 = dark, 1 = clear, dry and cloudless atmosphere, 1.15 = extremely clear conditions. (-)

**Climate description** Default climate file for given location

**Object:** name and description

The Dialog for a location is opened when the Right button is pressed with the cursor over an object of the Location type (e.g. Malmö) in the Location field in the building form or in the form for IDA-resources.

For synthetic climate, the outdoor air temperature varies sinusoidally between the given min and max values. The warmest time of day is assumed to be at 15:00, for dry as well as for wet bulb temperature.

A clearness number indicates the presence of clouds or unclear atmospheric conditions. For a clear, dry and cloudless sky, 1 is given. A normal daily average for a clear day summer day can be 0.8. Under extremely clear conditions, particularly in northern countries, 1.15 may occur. Further information about clearness number and additional references can be found in ASHRAE Fundamentals.
7.2.1.3. Form for climate definition

This form describes a Climate object, which provides information about an actual climate data file on disk. Indicated here is the path to the file (.prn) which contains the data, geographical position of the station, height of the wind measurement, etc.

The description gives qualitative information about the data, its selection, extreme weather periods etc.

Field descriptions, etc:
Filename the name and place for the data file, which must have a special IDA-format, is given here.
Wind measurement height wind speed data in the file corresponds to measurements at this height over the ground (m)
Position: Station name of measuring station
Position: Country country or geographical area of measuring station
Position: Latitude measuring station’s latitude (Deg) To avoid sign confusion, the directions from equator are denoted by N (north) and S (south)
Position: Longitude measuring station’s longitude (Deg). To avoid sign confusion, the directions from Greenwich are denoted by E (east) and W (west)
Position: Elevation measuring station’s height over the sea level (m)
Position: Time zone measuring station’s time zone (h). To avoid sign confusion, the directions from Greenwich are denoted by E (east) and W (west), e.g., 1 E for Central Europe.
Object: Name and description

Note that the descriptive weather station data given here is not in any way tied to the data given in the Location object. It is the data in the Location object that describes the physical location of the simulated building and is used to calculate, e.g., the sun’s position wrt. the simulated building.
The form for Climate definition is accessed when the Right button is pressed with the cursor over an object of the Climate data type (e.g. Helsinki) in the Climate field in the building form or in the form for IDA-resources.

7.2.1.4. Dialog for wind profile

This dialog describes an object of the Wind profile type. A description of the wind’s profile can be found uppermost in the box.

**Field descriptions, etc:**
*Name* Choice of wind profile. The rest of the dialog shows the details of the selected profile.
*Description* A0_COEFF coefficient in power law expression for wind speed
A_EXP exponent in power law expression for wind speed

The wind is only relevant to the airflow through the building if pressure coefficients are given for the building facades.

The wind speed is considered to vary vertically. It is zero on the ground and reaches a speed corresponding to that given in the weather data at the Href height. This height is normally 10 meters and this value applies if synthetic weather is used. When a weather file with measured data is used, the height is taken from the wind measurement height field in the form for Climate definition.
Wind speed at different heights is given by the following power law expression:

\[ U = U_{\text{measured}} \times A_0\text{COEFF}(H/H_{\text{ref}})^{A_{\text{EXP}}}, \]

where \( U \) is the wind speed in (m/s) at height \( H \) in m. \( U_{\text{measured}} \) is wind speed for the actual time in the weather file.

The wind profile’s form is accessed when the Right button is pressed with the cursor over an object of the Wind profile type (e.g. Default urban) in the Wind profile field in the building form or in the form for IDA-resources.

### 7.2.1.5. Dialog for project data

![Project Data: object in building3](image)

The dialog for an object of the Project data type is displayed by clicking in the box with the same name in the building form. A project can be documented here by entering information regarding customer and responsible engineer, etc.

**Field description:**
- **Customer** text
- **Responsible engineer** text
- **Description** This gives a short description of the simulated system.

The text is printed on generated reports.
7.2.1.6. Default settings

Input given here will be used unless other data has been given in the zone or subsystem.

Elements of Construction

External walls
Construction for external walls lacking descriptions in the zone.
Internal walls
Construction for internal walls lacking descriptions in the zone.

Internal floors
Construction for internal floors lacking descriptions in the zone.

Roof
Construction for roofs lacking descriptions in the zone.

External floor
Construction for floor slabs lacking descriptions in the zone. A ground insulation layer is normally described as part of the ground structure.

Glazing
Glazing for windows lacking descriptions in the zone (only for simplified window model).

Door construction
The default construction for doors. The default setting for this parameter is "[use wall construction]" that means where be no special treatment of wall material (this setting is compatible with ICE 3.0 version)

Integrated window shadings
The default shading device for simplified window model.

Generator Efficiencies and Default Carriers
Default efficiencies for fixed efficiency plant components and ideal room units are given here. Radio buttons are used to select the default type of energy for each purpose.

Energy Meters
From version 4.5, default Energy meters can be defined for each general type of usage and energy carrier. It is of course still possible to override defaults by local choice of meter at each point of usage.

Other
Zone model fidelity
Selects the degree of accuracy for the mathematical models of the zones. If the Climate model is selected, a very detailed physical model of the building and its components with, for example, the possibility for a vertical temperature gradient will be simulated. If instead the Energy model is selected, a simpler physical model is used. It has a more conventional degree of accuracy based on a mean radiant temperature. Consequently, the calculation time will be somewhat shorter, all else being equal.

The energy model does not calculate directed operative temperature. The climate model is currently restricted to zones with rectangular geometry.

Both zone models use the same description of the building. All the component models in and around the zone such as windows, radiators, controllers, leaks, terminals, etc. are common for the simplified and detailed zone models.

Choice of model can also be made for every zone locally in the zone’s form in the Model fidelity combo box on the Advanced tab. Choice for the whole building in the dialog above does not apply to those zones in which local choices have been made.

Coil temperature of ideal coolers
Ideal coolers in zones need a temperature to account for possible condensation.

Links
IDA resources, i.e. used input data objects.
Database
7.2.1.7. Edit the position, orientation and surrounding of the building

In the form Site shading and orientation, the building orientation is specified together with possible shading objects that are not attached to the building. The easiest way to change the building orientation is by turning the compass needle in the upper left-hand corner of the window. Select the compass needle and drag the small square close to the compass’s North point (N) to the required position. The desired compass direction can also be given numerically in the Property page when the compass has been selected. Position and height of shading objects can be defined. This is done with the aid of a polyline along the object’s defining surface. To create a shading object such as a building, drag Shading building from the Palette. Now create a polyline by clicking at its starting point, break points, and end point within the form. Click once with the right button and select OK to end. The desired height is introduced into the blue box in connection to the shading object. The figure below illustrates a polyline with four points and a height of 4.5 meters. The shading objects can be moved and changed. An object can be selected with the left button, making the surrounding rectangle visible and movable. Use the right button menu to select Edit and edit the polyline, as previously described. Similarly, horizontal shading surfaces can be defined as polygons. Note that shading objects alternatively can be inserted into the 3D view.
The building can also be moved and rotated in the same way as a card on a table. Do this by holding down the Alt-key and drag at a point within the building’s boundary. The building is then drawn along and follows the same movement pattern as a playing card being pulled by a finger on a table. Friction between the card and the table controls the card’s movement. It is advisable to avoid editing a rotated building, due to limitations in screen resolution.

The position of the building can be edited on the Properties page (tab on side bar). The coordinates of the origin are given in the site plan coordinate system. Orientation indicates how the building has been rotated in relation to its original position.

The objects on the site may be also moved using Shift dialog;
The site view supports also import drawings (using Import CAD button), either in popular CAD and vector formats (.dwg, .dxf, .dwf and other) or converted to the common Windows’ graphical formats (.bmp, .jpeg, .tiff, .wmf, .emf). The position and the size of the drawings may be edited in the same way as that of a shading building. Alternatively, their parameters may be edited on the property page. Imported 3D objects may be used as shading objects (if the parameter “Calculate the shadow” is checked on the property page). The drawings are also displayed in the 3D view.

7.2.1.8. Thermal bridges
These coefficients are used to calculate the loss factors in thermal bridges in zones. The total loss factor for a zone is calculated as sum of loss factors in bridges created by different construction elements. The coefficients are given per unit of element size (in most cases per meter). The sizes of elements are by default calculated from zone geometry, but may be also given by the user. The user may also specify extra loss in thermal bridges. Local changes in geometrical or bridge coefficients are done in the zone form. See also Calculation of thermal bridge coefficient.
<table>
<thead>
<tr>
<th>Thermal bridges</th>
<th>None</th>
<th>Good</th>
<th>Typical</th>
<th>Poor</th>
<th>Very Poor</th>
</tr>
</thead>
<tbody>
<tr>
<td>External wall / internal slab</td>
<td></td>
<td></td>
<td></td>
<td>0.05</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>(total for both adjacent zones)</td>
</tr>
<tr>
<td>External wall / internal wall</td>
<td></td>
<td></td>
<td></td>
<td>0.03</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>(total for both adjacent zones)</td>
</tr>
<tr>
<td>External wall / external wall</td>
<td></td>
<td></td>
<td></td>
<td>0.08</td>
<td></td>
</tr>
<tr>
<td>Exterior windows perimeter</td>
<td></td>
<td></td>
<td></td>
<td>0.03</td>
<td>W/K/(m perim)</td>
</tr>
<tr>
<td>Exterior doors perimeter</td>
<td></td>
<td></td>
<td></td>
<td>0.03</td>
<td>W/K/(m perim)</td>
</tr>
<tr>
<td>Roof / external walls</td>
<td></td>
<td></td>
<td></td>
<td>0.09</td>
<td>W/K/(m joint)</td>
</tr>
<tr>
<td>External slab / external walls</td>
<td></td>
<td></td>
<td></td>
<td>0.14</td>
<td>W/K/(m joint)</td>
</tr>
<tr>
<td>Balcony floor / external walls</td>
<td></td>
<td></td>
<td></td>
<td>0.2</td>
<td>W/K/(m joint)</td>
</tr>
<tr>
<td>External slab / internal walls</td>
<td></td>
<td></td>
<td></td>
<td>0.03</td>
<td>W/K/(m joint) (total for both adjacent zones)</td>
</tr>
<tr>
<td>Roof / Internal walls</td>
<td></td>
<td></td>
<td></td>
<td>0.03</td>
<td>W/K/(m joint) (total for both adjacent zones)</td>
</tr>
<tr>
<td>External walls, inner corner</td>
<td></td>
<td></td>
<td></td>
<td>-0.08</td>
<td>W/K/(m2 envelope)</td>
</tr>
<tr>
<td>Total envelope area</td>
<td></td>
<td></td>
<td></td>
<td>0</td>
<td>W/K/(m2 envelope)</td>
</tr>
</tbody>
</table>
7.2.1.9. Ground properties

The dialog for an object of the type Ground conditions, is displayed by clicking on the button with the same name in the building form. Here the calculation model, ground layers and temperature conditions under and around the building can be described.

Field description:

**Ground model**
- Use ISO 13370 (default) or method from IDA ICE 3

**Ground layers under basement slab**
- Ground layers under slab down to virtual (ISO 13370) or constant (ICE 3) temperature.

**Ground layer outside basement walls**
- Ground layers outside wall to virtual (ISO 13370) or ambient (ICE 3) temperature.

**Ground temperature when no whole-year climate file has been selected**
- Temperature used in situations when no climate file is known, e.g. when synthetic design day is selected.

**ISO 13370 model**
When multiple ground layers have been specified in the Ground properties dialog, only the outermost layer is regarded as “ground” in the ISO sense. Only the material properties of this layer are used, not the specified thickness. Other described layers are regarded as part of the building (in the ISO sense) and are added to layers that have been described elsewhere for building walls and floors.

The ISO model has been implemented for slab on ground and for heated basement (slab below ground) situations. ISO methods for suspended floors (ventilated crawl spaces) and edge insulation are not supported.

The virtual temperature that is defined by the standard 0.5 m below the building, is currently not time-shifted, since this is not required by the standard.

**ICE 3 model**
The ground layer under the basement floor is connected to a constant temperature, which is computed as the mean air temperature of the selected climate file. The layers around the basement walls are coupled to a facade object for crawl space, which is kept at ground surface temperature. Note that no 2D or 3D effects are modeled for either of these couplings.

7.2.1.10. Infiltration

Data in the infiltration form is used to specify unintentional air flows over the building envelope without having to visit each zone. The Leak area and Given additional in/exfiltration parameters of each zone are by default linked with the global Infiltration data.

Two basic methods of infiltration modeling are supported by IDA ICE: given (equal) in- and exfiltration flows and, alternatively, flows based on leak sizes, fan pressure, wind pressure and thermal buoyancy effects. The latter is default. When wind driven flow (the latter) has been selected, leaks are automatically introduced in each external wall of each zone (not in floors or roofs). The combined sizes of all these leaks is given here as a single flow/pressure point. This data is then distributed to each zone according the Zone Distribution method (by default according to total wetted external area.) However, note that the unit for leakage is different in the zone form, where leakage is instead specified in terms of Equivalent Leakage Area at 4 Pa.

It is possible to break the link to the global infiltration data from a zone and give another leakage area locally (just type in the input field). It is also possible to set the Leak area of the zone to a very small number and instead introduce “manual” leaks in specific places on the walls of the zone. Note, however, that it is not permitted to set leakage to zero. Completely air tight zones will yield a singular system matrix and the problem cannot be solved.
When instead fixed flows are specified, constant envelope air flows to and from each zone are introduced. However, small envelope “natural ventilation” leaks are also introduced to absorb pressure differences because of for example imbalances in mechanical supply and return flows.

A common problem when fixed flows are used in combination with unbalanced mechanical ventilation is that pressure difference over the envelope becomes unrealistically large. A warning for this is then issued during the simulation and the remedy is to specify larger leak areas in zones with unbalanced mechanical ventilation.

7.2.1.11. Pressure Coefficients

Pressure Coefficients are used to calculate wind pressure on the different external surfaces of a building in relation to the speed of wind at roof height. See ASHRAE Fundamentals. The wind only influences airflow through the building if non-zero pressure coefficients are given.

Pressure coefficients are dependent on the building’s shape as well as on surrounding aerodynamic conditions. CFD calculations or wind tunnel measurements are required for good precision. In simple cases, handbook data can give acceptable results (at least much better than using fixed infiltration flows). A common handbook data set (from the Air Infiltration and Ventilation Centre) can be accessed by selecting a face or faces and pressing Auto fill.

The wind contribution to pressure is assumed to be constant over the whole surface and is given by the following expression:

\[ P_{OUT} = \frac{(PRESSURE-COEFF \times RHO \times ON-SITE-WIND^2)}{2} \]

where the applicable PRESSURE-COEFF depends on facade and wind direction (linear interpolation between given directions), RHO is the air density and ON-SITE-WIND is the speed of wind at the roof height of the building.
7.2.1.12. Extra energy and losses

In this form, losses from HVAC distribution systems, hot water use and other energy use items (external lighting etc.) are specified.

**Domestic Hot Water Use** may be specified here using different units. Note that when a unit that includes the number of building occupants is used, the relevant number of occupants should be set here as well. The Number of occupants field is by default bound to the sum of all defined occupant thermal gains. However, in many situations, this number is quite different from a relevant “water consuming occupant”, for example a conference room will hold a lot of occupant loads that have their normal “base” in some other room.

The domestic hot water use may, additionally or alternatively, also be given for individual zones (on the zone advanced tab).

**Distribution of hot water use** as a function of time is given by a schedule. The signal is automatically rescaled to yield correct totals on a yearly basis (as specified by the Average hot water use parameter), i.e. only the shape of the given curve is used. A good convention is to set maximum use in the schedule = 1.
Distribution System Losses are specified to account for leakage from pipes and ducts that pass through the building without having to describe their exact path and insulation properties. For water circuits, the sign is positive when heating the zone for DHW and heat, and positive when cooling for cold water circuits. The loss from air ducts is defined as positive when the duct is cooler than the zone.

Duct losses include both thermal conduction and air leakage losses, although the actual loss of mass through the duct wall is not modeled. Duct losses take account of actual temperature difference between the duct system and zones, while water circuit losses are independent of actual temperatures.

Units for heat and cold distribution may be changed for convenience.

NB! That the distribution losses also include heat and cold delivered by local ideal units. This is in order to be able to use ideal units as proxies for real room units that are connected to central systems via a distribution system (which has losses).

Rough estimates of possible loss levels are provided for convenience via sliders, but these levels vary greatly between countries.

A given percentage of the heat (or cold) from each distribution system is deposited to the zone heat balance. Remaining heat is simply lost to ambient.

Plant losses can be set to account for permanent conductive losses from chillers and boilers. They are defined in terms of extra electricity or fuel (heating value) use. This energy is lost.

Plant pumping power calculation method is selected for plant pumps. Depending on the plant type selected, this information may be possible to refine further in the Plant object.

Ideal unit pumping power calculation method is selected. This allows association of pumping power with ideal units, should they be used as proxies for real room units.

Any number of Additional Energy Use items may be specified (right click to rename them). This is energy which should be accounted for in total delivered energy (from the utility), but does not enter the building heat balance. Ice melting equipment or external lights are examples.

For each item, both an absolute and a per-floor-area contribution may be given. The total of both is displayed for convenience. Each item must also refer to a schema and an energy meter.

Note that defined energy meters can be renamed and new ones can be added in the building form.

### 7.2.1.13. Energy meters

![Energy meter interface](image)
Energy meters represent items in the Delivered energy report. Sometimes they are also referred to as energy accounts. Equipment that use or convert energy will always report to a specific meter. The user may specify default energy meters for different energy carriers (electric, fuel, district heat/cold) and typical usage (heating, cooling, lighting, etc.) on the page Defaults. If a non-default meter is required for a particular device, the default can be overridden by a local choice in the device. Energy meters can be renamed by right clicking. New energy meters can also be dragged from the Palette on the Side bar.

Field descriptions, etc:

Energy meter type Shows meter type (corresponding to energy carrier). Fuel is measured in terms of its heating (calorific) value. To change the meter type, replace it with another meter of appropriate type.

Energy rate plan Select object with time dependent energy price information.

Primary energy factor Used energy is multiplied by this factor to compute primary energy use.

CO2 emission per kWh Used to compute CO2 emissions from used energy.

Role This choice influences how the used energy is reported.

Color for presentation Used for graphical result presentation of energy use.

Total energy consumption and costs are presented in the Delivered energy report. Click on Requested output in the simulation form.

The form for energy meter is opened by double clicking on an object of the Energy meter type (e.g. Electric meter) in the Energy meters box in the building form.

7.2.1.14. System parameters

System parameters are global settings that affect the simulation but that should not normally be changed by the user. In the Outline view (Expert edition only), additional parameters and tolerances may be found that may be relevant to expert users.
7.2.1.15. Dialog for energy price

In this dialog a description of the objects of the Energy price type can be given.

Field descriptions, etc:
- **Currency** Currency name.
- **Fixed cost, Kr/year** Fixed yearly cost.
- **Energy rate, Kr/kWh**
- **Schedule for rate** Choose a schedule that selects rate at different times. Output signal should be 1, 2, 3 or 4 at all times.
- **Object**: Name and description

The dialog for an energy price is opened from the Energy meter form by opening the object in the Energy rate plan field.
7.2.2. Forms for IDA-resources

This form contains the IDA-resources currently or previously used in a project. If, for example, an Internal wall with insulation is chosen somewhere in the building, the IDA resources Internal wall with insulation, Gypsum, Air in 30 mm vertical gap and Lightweight insulation will appear in the list. (The Internal wall with insulation contains references to a set of material resources).

A change made in an IDA resource at the building level applies to all the instances in the building where it has been used. If, for example, the density is changed for the IDA resource concrete from 2300 kg/m³ to 2400 kg/m³ at the building level, this change will influence all walls and floors in the building that contain concrete.

Resources that have no references to them (aren’t used) can be deleted. Right click to check where a resource is used.

Resource objects can also be stored in separate resource documents that are accessed by pressing the Import... button.

Resource objects are frequently created from database objects. A list of all available objects can be found in the Database objects in IDA Indoor Climate and Energy.
7.2.3. **Floor plan tab**

7.2.3.1. **Floor Plan**
The **Floor Plan** view shows the building body, zones, and imported CAD data at the given height.
All objects are shown in building coordinates. A compass shows the orientation of the building. To change the orientation, go to Site view.

Supported operations on Floor Plan:
Add, move, resize, edit, rename, and remove parts of building body and zones;
Move the selected object using Shift dialog;
Building and zone geometry import;
CAD import

See also
Edit the zone position and size in the floor plan
The building geometry

7.2.3.2. **Building shape**
The building shape is given as one or more parts of **Building Body**.
The shape of a body part a prism with vertical walls or a part of such a prism limited by the roof. The roof may consist of one or more flat polygons that cover the whole roof.
The body parts may be arranged both vertically and horizontally. The parts should not intersect. Zones may traverse several body parts.
See also Building and zone geometry import.

To edit a body part
To replace the rectangular shape of a part of the building body by an arbitrary polygon,
right click somewhere within the building and select Edit. The perimeter of the building is changed to a so-called polyline. A polyline consists of line segments and break points, the latter marked by small rectangles. The polyline can be edited in five ways:
- Its breakpoints can be dragged to the desired positions for the building’s corners.
- Its line segments can be dragged to the desired positions for the building’s walls.
- A new breakpoint can be introduced by clicking on or close to the line.
- An existing breakpoint can be deleted by clicking on it.
- Breakpoints for non right-angled corners can be introduced by holding the Control key down and simultaneously clicking on a segment of the line.
- If you hold a point or a segment while dragging it near to some other figure shown on the drawing, the point (or the segment) is snapped to that figure.
Click once with the Right button and select OK to end editing, or alternatively press Enter (to accept) or Esc (to cancel). As an example, the figure below has had a new breakpoint introduced directly to the right of the middle on the building’s south wall. The wall to the right of this breakpoint has then been dragged down and an angle-shaped building has been created.
See Edit lines and polygons for more details.
Note also that the program automatically allocates names to all the facades created by the introduction of new breakpoints. This allocation has not yet taken place in the figure above, but can be seen in the last figure in this part.

The building can also be assigned geometry in the form of coordinates. This is done on the Properties page for building body part. This page is shown on the Side bar when the body part is selected.

To add a new body part

Add object of type "Building body". It is also possible to copy a body part from another (or the same) building.

To move a body part

Drag the body part with mouse.
To rotate the body part, keep the Alt button pressed.
To align (or stick) a side of the body part to another object (zone, another body part, a line in CAD drawing), place this side near to that object and keep it for a while with left mouse button pressed.
It is also possible to move a body part by editing the coordinates on the Properties view of the Side Bar. This is the way to move the body part in z-direction.

Notes. 1. To avoid confusions, do not move building body far away from the origin of the coordinate system.
2. If you want to move the whole building (relative to the surrounding building) or rotate it, it is better to do it on the site view. In that case the building will be moved together with the building's coordinate system.

To resize a body part

When a body part is selected, the selection mark contains 8 active points at the corner and the center of the sides of the body part (of the bounding rectangle if the part is not rectangular).
To resize the body part, drag an active point with mouse.
To align (or stick) a side of the body part to another object (zone, another body part, a line in CAD drawing), drag this side near to that object and keep it for a while with left mouse button pressed.
It is possible to resize several objects (body parts and zones) together. It is also possible to resize the body part by editing the sizes on the Properties page of the Side Bar. This is the way to change the height of body part.

To rename a body part
See Object name.

To remove a body part
See Removing components. Note that the building should have at least one body part.

To edit the roof
Click the body part with right mouse button and select Edit roof from shortcut menu. See Editing roof for details.
There is also a link on the Properties view of the Side Bar.

7.2.3.3. Editing Roof

The Roof Editor view shows the roof of a building body part. The numerical details are shown on the Properties page of the Side Bar. Initially the roof is flat and horizontal.

The user can make the roof slanted (by editing the heights of the roof's corner) and/or divide the roof in parts. Each part should be a flat polygon and the parts should completely cover the roof. The roof may have vertical parts (slope=90), but parts with slope>90 are not supported.

When the user leaves the Roof Editor view, the program calculates the shape of the body part's sides and of the walls and the ceiling of the zones that are [partially] inside the body part. The user may also press "Apply" button to do the same calculations before leaving the view.

To divide the roof
The roof is divided in two steps

1. Define the vertices (corners) of the roof parts. To do this, press "Edit vertices" button and then click with mouse the positions of the vertices. A new vertex is inserted at every click. Press "Done" button to finish this step. It is also possible to move and delete vertices in "Edit vertices" mode. See Editing lines for details.
The coordinates of the vertices may be also edited on the Properties page of the Side Bar.

2. Define the roof parts. To define a part, press "Add part" button, than mark all vertices of this part with mouse and press "Make part" button. Repeat this operation until the roof is completely covered by the parts.

To edit the height of the roof

Until the user has changed the heights of roof vertices, the height of a [simple horizontal] roof is specified on the building body part's Properties page on the Side Bar (the field labeled "z max").

To define non-horizontal roof (or parts of the roof), the user may edit the z-coordinates of the roof corners on the roof's Properties page. But often this is not convenient because some of heights might be calculated from other ones (the roof parts are flat, so it is enough to specify the height of 3 points on each part). For this reason IDA ICE provides a special tool to set the roof height.

To set the heights of [some of] roof corners, do the following:

1. Press "Set height" button (on the bottom of the Editing Roof view). IDA ICE will display a Mode dialog that indicates that you are now in "Setting roof height" mode.

2. Select (by clicking with mouse) the vertices those height you would like to change or
to use for calculating other heights. Every time you click a vertex, its height becomes available for editing (just above the vertex in the drawing) and you can change it if desired.

At every step, all heights that a selected or may be calculated from the selected ones are shown on the drawing. The changed (either by the user or by the program) are written in red, the unchanged are written in blue. The selected vertices are marked with green circles around them, the calculated ones are marked with red circle. The roof parts are filled in yellow (if flat) or cyan (if non-flat).

3. If you select a vertex that is already selected, you will be prompted to choose either to unselect it or to edit its height.

4. To accept the changes, click "Ok" button in the Mode dialog. You can also withdraw all changes by pressing "Cancel" button.

Notes:

1. If you change the height of the body part (field "z max" on the body part's Properties page) for a body part where the heights of the roof corners is explicitly defined, the whole roof (i.e., all vertices) will be moved up or down by the value of the change of "z max".

2. It is allowed to define roof parts outside of the part of the building body. They will shade the building, but will be ignored in calculation of zone shape and adjacency. The roof parts should not intersect the boundary of the part of the building body.

7.2.3.4. **Edit the zone position and size in the floor plan**

Clicking on the **Floor plan** button in the zone’s form opens a form for the floor plan. (Can also be reached from the building level, by the Floor plan tab.) The position and size of a zone can be changed here. The active zone is indicated by a red border. Any other existing zones in the building, both on the same floor and on other floors, (paler gray lines), are also visible. All zones in the same floor, plus the building shape, can be edited.
To change the position of a zone select it, put the cursor somewhere within the zone’s boundary lines and drag it with the mouse to the desired position in the building. The coordinates for the cursor position can be found in the lower right corner of the IDA-window. Hold the zone for a few seconds in a position close to an exterior or interior wall (even on another level), and it will automatically snap into position. This can include a smaller rotation if necessary.

The size of the zone can be changed by first selecting it and then dragging one of the small rectangles either in the corners or in the middle of the sides.

It is also possible to give numerical values for the zone’s corners in the form for the Properties page.

The property page shows also the floor area and the zone volume.

The floor area is used for presentation of different parameters "per 1 m² of floor area". By default, the floor area is calculated by the program as the area inside walls. The user may change the default value (for example, to exclude unused parts of zone). In this case it will be displayed with yellow background. To restore the default, remove the value.

The zone volume is calculated by the program as the volume inside the walls, floor, and ceiling.

See Geometry in IDA Indoor Climate and Energy for a description of how the geometry and coordinate systems in IDA Indoor Climate and Energy are defined.

The shape of the zone can be edited after right clicking in the zone and selecting Edit. The editing is handled in the same way as for the building (see Building shape).

The zone can also be rotated by holding down the Alt-key, while dragging a point within the zone’s boundary lines. The zone is dragged along and follows the same movement pattern as a playing card being pulled by a finger on a table. Friction between the card and the table controls the card’s movement.

Note that if a zone is moved so that, e.g., an external wall becomes an internal wall, the wall construction corresponding to the new position will be selected automatically. This also holds for parts of walls.

Walls are automatically coupled to zones and exterior walls that they adjoin. The couplings should not be created by the user.

Along the bottom of the form, there are the following buttons:

**New zone**
Add one or more zones, either by drawing on the floor plan, or by selecting spaces imported from IFC model.

**Template for new zone**
Click the template name to choose the template used when creating new zones. The menu also provides options to edit the current zone template and to reset the selected zone to the current template. The latter will only affect non-geometric information of the zone.

**Import…**
Opens Import menu:

**IFC (3D BIM)**
Import of an IFC model, of building.

**CAD and vector graphic**
Import of a CAD drawing as background.

**Bitmap**
Import of Windows graphics as background.
**Import building body**
Import building body from CAD drawing.

**Import zone geometry**
Import one or more zones and building body from CAD drawing

**IFC…**
Opens IFC menu:

**Import…**
Import of an IFC model, or CAD drawing, or Windows graphics as background.

**Mapping…**
The transfer of data objects from the IFC model to IDA is described here.

**Remove**
Remove the imported IFC model

**Make a single zone from all marked IFC spaces**
When adding zone, create a single zone from all marked IFC spaces.

**Make a separate zone from every marked IFC space**
When adding zone, create a zone from each marked IFC spaces

**Lock**
Disable moving and resizing of objects of given types.

**Show**
Menu with different options that control the appearance of the floor plan.

**Visual filter / Remove filter**
Shadow or hide objects of some types on both floor plan and 3D view.

**Plan size**
Presents the relation of the drawing pad to the coordinate system. The view size may be also changed by dragging the page's edges.

**Level: xxx m**
Press here to view the floor plan at some other height in the building.
7.2.3.5. Zone defaults

In this dialog, templates for new zones can be created and modified. A new template is created by modifying parameters and then saving under a new name (Save as ...). A library of typical zones can be created in this way.

Field descriptions, etc:
Use template
Choice from the list of alternative settings for new zones
Save as
Create a new template
Ok
Accept changes

General page
Controller setpoints
Choice of control values for temperature, air quality, and light.
Room units
Check to add ideal heating or cooling units to zones
Furniture
Covered part of the floor
Fraction of floor area which is covered by furniture. (0-1)
Weight / area with furniture
Total weight of furniture divided by the covered area. (kg/m2)
Room height
The distance between floor and ceiling (m). This parameter is only used for creation of new zones. If a zone is reset to match data in a template, zone geometry, including this parameter, is not touched.

**Air**

**Select central air handling unit**
Choice of air handling unit from the types available at the building level.

**System type**
Type of ventilation system. Constant or variable flow, with different controls.

**Supply air for CAV**
Mechanical supply airflow for CAV systems (l/s m² floor area). VAV flows are given in Controller setpoints.

**Return air for CAV**
Mechanical return airflow for CAV systems (l/s m² floor area). VAV flows are given in Controller setpoints.

**Displacement degree for gradient calculation**
From 0 (well-mixed) to 1 (displacement ventilation), or a negative value for temperature gradient given by the user.

**Internal gains page**
For automatic addition of occupant and equipment loads. These will be added to a new zone in proportion to the initial zone floor area. If the zone size is later on changed, the internal gains will not be changed accordingly.

**Select type and schedule**
- Occupants
- Equipment
- Lights

**Advanced page**
Element of construction

**External walls**
Construction for external walls not described in the zone.

**Internal walls**
Construction for internal walls not described in the zone.

**Internal floors**
Construction for internal floors not described in the zone.

**Roof**
Construction for roofs not described in the zone.

**External floor**
Construction for ground floor slabs not described in the zone. A ground insulation layer is normally described as part of the ground structure.

**Room unit power**
Specify the power of ideal heater and cooler per 1 m² of initial size of floor area.

See Geometry in IDA Indoor Climate and Energy for a description of how the geometry and coordinate systems in IDA Indoor Climate and Energy are defined. The form for building geometry is reached by selecting Properties in the Options menu. See Edit the shape, orientation and surrounding of the building.
7.2.3.6. Floor level dialog

Show floor plan at level
Select from the list of floor levels or type a new one

Slice height
Show all zones that overlap with layer from "level" to "level"+"slice height"

Building top
The height of the building top above ground

Building bottom
Height of ground floor slab above ground (negative if below ground)

7.2.3.7. IFC and CAD import

ICE can import CAD IFC files of IFC release 2.0, 2x, 2x2 and 2x3 generated by, e.g., ArchiCAD, Revit, Architectural Desktop, MagiCAD Room etc. ICE imports information about wall, window and door positions. ICE relies on the existence of ifcSpaces for creation of simulated zones. ICE imports also styles for walls, windows and materials that can be used to provide an appropriate property set to a group of imported objects in ICE. Using IFC, it is possible to build the geometry of a building without manual editing.

See the manual and special ICE topic document IFC Import.pdf for details.

IDA can import drawings, either in popular CAD and vector formats (.dwg, .dxf, .dwf and other) or converted to the common Windows’ graphical formats (.bmp, .jpeg, .tif, .wmf, .emf). Such drawings may be displayed in the background of the floor plan view or of the site view. They are also displayed in the 3D view. CAD drawings is normally used as background for drawing zone and building geometry in the Floor plan editor. It is not possible to automatically generate models based on 2D drawings.

From version 4.5, it is also possible to create zone and building objects in IDA ICE based on geometry that has been defined in a separate 3D editor. See further Building and zone geometry import.

7.2.3.8. Building and zone geometry import

Building and zone geometry can be imported into IDA ICE if the imported geometry only contains a volume enclosed by polygon surfaces (polyhedron) without holes between the surfaces. The geometry should describe the inner surface of the external walls for a building, and the inner surface of the zone walls for a zone. Many popular file formats (.skp, .3ds, .obj, .dxf, .dwg and other) are supported.
Imported building bodies and zones have protected geometry, i.e. their geometry is non-editable, only resizable. However, an imported building body is fully editable if the imported geometry only has one floor and that floor is horizontal and does not contain any holes, and the geometry does not have any outward leaning walls (surfaces with their exterior normal pointing downwards). This is the same kind of geometry that can be created in the IDA ICE roof editor. Importing geometry as zone will also create a building body of the same shape as the zone.

If a geometry file contains multiple polyhedron geometries, each with a separate color, they are imported as separate building bodies or zones in IDA ICE. If surfaces are placed one wall thickness apart, these are regarded as thermally connected internal walls.

### 7.2.3.9. IFC mapping

- **Category**
  Select an IFC category for mapping (begin with materials)
- **IFC data**
  Available IFC data of the selected category
- **ICE resources**
  Available IDA resources of the selected category
- **Map to selected**
  Map the selected IFC objects to the selected IDA resource
  First select one or more IFC objects and one IDA resource
- **Unmap selected**
  Disconnect selected IFC objects from their IDA resources
- **Import from IFC**
Make a new IDA resource from IFC object. Only import of walls is implemented. Import not possible if the materials used in the wall are not already mapped to ICE

**View**
- Show the selected IDA resource

**Load from Db**
- Load resource from ICE database

**Create new**
- Create a new IDA resource

See also Mapping data from IFC in the manual for further instructions.

### 3D tab

### 3D View

**Appearance**

**Zone wall coloring scheme**

- Walls or floors that are connected to an external façade have a grey textured surface (looking like a rendered wall).
- Ceilings that are connected to an external façade have a dark grey striped surface (looking like a standing seam metal roof).
- Walls or floors that are connected to ground have a dark grey textured surface.
- Walls, floors and ceilings that are internal or unconnected have a white surface.

**Navigation**

**Rotate**
- Left mouse button: Press down and move mouse.

**Pan**
- Middle mouse button (or both the left and the right mouse buttons on a two button mouse): Press down and move the mouse.

**Zoom**
- Right mouse button: Press down and move the mouse. Move the mouse upwards to zoom in and downwards to zoom out.

**Set center of rotation**
- Press F. Sets the point around which the model is rotated and towards which it is zoomed. Alternatively use Right mouse button menu -> Set focus.

**Tip:** Use this function frequently to make navigation as easy as possible.

**Fit the model in the 3D view**
- Press R. Zooms and pans the model so that the entire model is visible. Alternatively use Right mouse button menu -> Zoom extents or Show button -> Zoom extents.

**Object interaction**

**Select object**
- Left mouse button: Click. Selected object is shown in red. The properties of the object are shown in the sidebar.
- To select a zone: Click on a zone wall or zone feature twice (not as fast as double-click).

**Open object**
- Left mouse button: Double-click. Opens form for selected object. Alternatively use Right mouse button menu -> Open.
**Insert object**

The following objects can be inserted in the 3D view:

- windows
- openings
- balconies

To insert an object: Choose Palette in the side bar. Drag the object from the palette and drop onto a building façade.

**Tip:** A grid of façade objects can be created by selecting one or two identical façade object and choosing Grid from the Right mouse button menu.

**Assign property to object**

The following properties can be assigned to objects in the 3D view:

- constructions of walls, floors and roof

To assign a property to objects: Choose Palette in the side bar. Double-click on the property in the palette and select the objects in the 3D view. Click Ok to accept.

**Move object**

The following objects can be moved in the 3D view:

- building bodies
- zones
- windows, openings and shading objects inserted into building façades
- grid lines in a grid of façade windows, openings or shading objects
- shading buildings
- imported 3d objects and bitmaps

To move an object in the x-y plane: Select object, hold down Ctrl-key and drag object. To move an object along the z-axis: Select object, hold down Ctrl-key and Shift-key and drag object. A move operation can be aborted by pressing Esc-key and undone with the Undo button. Moving of objects of given types can be disabled from the Lock button on the bottom of the 3D tab.

**Controlling visibility**

**Create section of model**

- x+, x-, y+, y-, z+, z- buttons: Creates a section through the building. When the section is activated, press Ctrl-key, click and move the mouse pointer within the red frame, to move the section.

**Set visibilities of object categories**

Right mouse button menu -> Visual filter… Opens the Show objects of type dialog where the visibilities of object categories are set. Use Right mouse button menu -> Remove filter to make all objects visible. Alternatively use Show button -> Visual filter… and Show button -> Remove filter.

**X-ray**

Show button -> X-ray: Objects are shown semi-transparent.

**Changing appearance**
Wall thickness
Show button -> Wall thickness: Shows all zone walls with thickness according to their wall constructions.

Background color
Right mouse button menu -> Background color -> Custom… Opens the Color dialog where the background color is set. Use Right mouse button menu -> Background color -> Default to set the background color back to the default. Alternatively use Show button -> Background color -> Custom… and Show button -> Background color -> Default.

Wire frame
Right mouse button menu -> Wire frame: Shows the 3D model with lines and without any surfaces. Alternatively use Show button -> Wire frame.

Stereo image
Show button -> Stereo image: Shows the 3D view in stereo for viewing with red/cyan glasses.

Printing high resolution images
Print
File -> Print… Prints the 3D view as a high resolution image. Alternatively use ctrl-P
Tip: To change the resolution of the printed image, hold down the shift key while selecting print. Enter the magnification in the dialog that is opened.

Export
File -> Export image… Captures the 3D view to an image file of format *.jpeg, *.jpg, *.png, *.tiff, or *.bmp.
Tip: To change the resolution of the exported image, hold down the shift key while selecting export image. Enter the magnification in the dialog that is opened.

Export high resolution image
Right mouse button menu -> Export high res. image… Captures the 3D view to an image file of format *.jpeg, *.jpg, *.png, *.tiff, or *.bmp. First, set the magnification in the dialog that is opened.

Redraw 3D view
View menu -> Refresh: Redraws the 3D view.

See also:
Visualizing input data and simulation results
Incorporating CAD objects and images

7.2.4.2. Visualizing input data and simulation results

Visualizing input parameter values
Details table at General tab: Click box icon of one parameter Shows a graphical overview of the parameter in the 3D view.

☐ Numerical values of parameters are shown with colors on the surfaces of the objects. A scale bar is displayed to correlate a specific color to a parameter value.

☐ Some parameter values, e.g. the amount of supply air for each zone, are shown with colored arrows. A scale bar is displayed to correlate a specific color to a parameter value.

☐ Parameters with a finite number of options, e.g. the occupant schedule for each zone,
are shown with colors on the surfaces of the objects. Color coded legends are displayed to correlate a specific color to a parameter value.

- Names of objects are shown as text.

**Tip:** If a section is activated with one of the x+, x-, y+, y-, z+, z- buttons, only names of the objects in the section are shown.

- Close the parameter visualization: Press H or Right mouse button menu -> Hide parameter.

### Visualizing simulation results summary

**Summary table at Results tab:** Click box icon of one variable. Shows a graphical overview of the variable in the 3D view.

- The values of the variable are shown with colors on the surfaces of the objects. A scale bar is displayed to correlate a specific color to a variable value.

- Close the results visualization: Press H or Right mouse button menu -> Hide parameter.

### Visualizing simulation results over time

**Click Animation button.** Opens the Show animated results dialog. In the Show animated results dialog, select variables to animate and click Show. Any number of overlay variables (check box), but only one scale bar variable (radio button), can be selected at a time. An animation starts.

- The values of the variable are shown with colors on the surfaces of the objects. A scale bar is displayed to correlate a specific color to a variable value.

- Some variable values, e.g. the ventilation air flows, are shown with colored arrows. A scale bar is displayed to correlate a specific color to a variable value.

- Overlay variable values are shown in a table in the top right corner of the 3D view.

- Pause the animation: Click the Play/Pause button. 

- Start the animation: Click the Play/Pause button a second time.

- Speed up/slow down the animation: Change the Tplay value (the time it takes to animate 24 hours of simulation).

- Jump forward/backward in the animation: Use the scroll bar, or change the simulation time value.

- Close the animation: Use the Close button. Alternatively Press H or Right mouse button menu -> Hide animation.

**Tip:** To highlight difference between close variable values, narrow the visualized range by entering min and max range of values in the Show animated results dialog. Check Auto to reset to full variable range. Check Absolute value to visualize the absolute value of the variable.

**Tip:** To change the size of the animated arrows, enter a maximum arrow length in the Show animated results dialog.

### Threshold value on scale bar

When visualizing a parameter or a result in the 3D view so that the scale bar is shown, press down the Ctrl-key and click somewhere on the scale bar. A horizontal line and a
threshold value are shown and the scale bar is red above and blue below the threshold value. The threshold value can be dragged while holding down the Ctrl-key. Ctrl-click somewhere outside of the scale bar to show the regular scale bar. When visualizing a parameter with a finite number of options you can Ctrl-click on the different categories in the same way.

**Visualizing sun path and shading over time**

Click Animation button: Opens the Show animated results dialog. In the Show animated results dialog, check Show shadows and click Show.

- An animation starts with shadows, following the sun path of the day, displayed on the 3D model.
- Pause the animation: Click the Play/Pause button.
- Start the animation: Click the Play/Pause button a second time.
- Speed up/slow down the animation: Change the Tplay value (the time it takes to animate 24 hours of simulation).
- Jump forward/backward in the animation: Use the scroll bar, or change the simulation time value.
- Close the animation: Use the Close button. Alternatively Press H or Right mouse button menu -> Hide animation.

7.2.4.3. **Incorporating CAD objects and images**

**Inserting CAD objects and images**

Insert -> Import CAD: Opens the Import CAD dialog. In the Import CAD dialog, select file and click Open. Alternatively click Import… button -> CAD and vector graphic/Bitmap or IFC… button -> Import… on the Floor plan tab.

- The CAD object/image is shown in the 3D view and a section of it is shown on the floor plan tab.
- The CAD object/image is inserted with respect to the building coordinate system, i.e. it will move with the building when the building is repositioned.
- Move and change size of the CAD object/image by dragging it/resizing it in floor plan or editing the parameters in the dialog shown when object is double-clicked.
- Include the object (not image files) in the shadow calculation and visualization: Check the Calculate shadows checkbox in the dialog shown when object is double-clicked.
- By default CAD objects are save in the system file (*.idm) so that the original CAD file does not need to be saved. If the CAD file is big, the option of not saving it in the system file will be given. This will speed up the performance of IDA ICE, but the original CAD file needs to be saved.

**Tip:** To place a CAD object/image at the current mouse pointer, use Right mouse button menu -> Import CAD

**Inserting CAD objects and images to site**
Insert -> Import CAD to site: Opens the Import CAD dialog. In the Import CAD dialog, select file and click Open. Alternatively click Import site CAD button on the Site object dialog open by clicking Site shading and orientation on the General tab.

- The CAD object/image is shown in the 3D view and in the Site object dialog.
- The CAD object/image is inserted with respect to the site coordinate system, i.e. it will not move with the building when the building is repositioned.
- Move and change size of the CAD object/image by dragging it/resizing it in the Site object dialog or editing the parameters in the dialog shown when object is double-clicked.
- Include the object (not image files) in the shadow calculation and visualization. Check the Calculate shadows checkbox in the dialog shown when object is double-clicked.
- By default CAD objects are save in the system file (*.idm) so that the original CAD file does not need to be saved. If the CAD file is big, the option of not saving it in the system file will be given. This will speed up the performance of IDA ICE, but the original CAD file needs to be saved.

Tip: To place a CAD object/image at the current mouse pointer, use Right mouse button menu -> Import CAD to site

**Supported file formats**

**BIM**
IFC (*.ifc)

**CAD and vector graphic files**
AutoCAD (*.dwg, *.dxf, *.dwf)
IDA ICE supports DWG file formats up to AutoCAD 2004. DWG files of unsupported formats can be converted with the free tool Autodesk DWG TrueView.
DWG files are assumed to be two-dimensional, i.e. any 3D geometry is flattened to 2D at import.

SketchUp (*.skp)
3D Studio (*.3ds)
Wavefront (*.obj)
Computer Graphics Metafile (*.cgm)
Corel Presentation Exchange (*.cmx)
MicroStation DGN (*.dgn)
Micrografx DRW (*.drw)
Gerber File Format (*.gbr)
Scalable Vector Graphics (*.svg)
Printer Command Language (*.pcl, *.prn, *.prt)
Macintosh PICT (*.pct)
HP-GL/HP-GL2 (*.plt)
WordPerfect Graphics (*.wpg, *.vwpg)

**Image files**
Bitmap (*.bmp)
7.2.5. Simulation tab

7.2.5.1. Simulation tab

Requested output
Click Select to see and/or specify what diagrams and reports that will be created during the simulation.

Heating load
See Heat Load Calculation and Results in ICE Getting Started manual

Cooling load
See Cooling Load Calculation and Results in ICE Getting Started manual

Energy
See Energy Calculation in ICE Getting Started manual

Custom
Open Simulation data dialog to select simulation times and tolerances, etc.

Advanced level
Click Build Model to (re)build the mathematical model of the system.
Click Edit to switch to the schematic view of the system.

After a simulation, the result diagrams and reports chosen can be found under the Results tab (see Dialog for choice of output).
7.2.6. Dialog for choice of output

Output from a simulation is presented as diagrams and reports. There are several different diagrams to choose from. The selection is made from the Choice of output dialog that is accessed by clicking on the Requested output button in the building form or if Choose output is selected in the Tools menu. The following diagram and reports exist (those marked with # are pre-selected but can be deleted):

**Diagrams**

**Building level:**
- AHU temperatures(#{}) Air temperatures in central AHU
- AHU airflows Air flows through central AHU
- Plant temperatures Plant temperatures: Boiler & chiller, in & out
- Total heating and cooling (#) Heat and cooling supplied by plant and ideal room units
- **Plant details** Detailed measures from an ESBO plant model.

**Zone level:**
- Main temperatures(#{}) Air and operative temperatures
Heat balance Detailed heat balance for zone
Air temperatures at floor and ceiling Air temperatures at floor and ceiling in case of
displacement ventilation.
Fanger’s comfort indices Fanger's comfort indices, PPD, PMV
Indoor Air Quality Indoor air quality measures: Ac/h, CO2 level, humidity
Daylighting Daylight level at desktop (1st person)
Directed operative temperatures
Air flow in zone Air flows in zone, in/out through internal/external walls or
mechanical ventilation
Airborne heat flow into zone Airborne net heat flows into zone, through internal walls,
envelope and mechanical ventilation
Surface temperatures Temperatures of zone surfaces
Surface heat fluxes Convective and long wave radiative heat flux of zone surfaces

Reports

Building level:
Delivered energy Totals of energy, purchased or locally generated, including cost,
CO2 and primary energy
Time series of underlying measurements can be logged by logging sources
Systems energy Overview of energy transferred by HVAC systems
Lost work Account of work hours lost due to over or under heating
AHU energy Energy transferred by individual Air Handling Units
Time series of underlying measurements can be logged by logging sources

Zone level:
Energy Zone sensible energy balance
Time series of underlying measurements can be logged by logging sources
Thermal comfort according to standard EN-15251

7.2.6.1. Heat Load Calculation
See Heat Load Calculation and Results in ICE Getting Started manual.

7.2.6.2. Cooling Load Calculation
See Cooling Load Calculation and Results in ICE Getting Started manual.

7.2.6.3. Energy Calculation
See Energy Calculation in ICE Getting Started manual.

7.2.6.4. Choice of Simulation data
The simulation data object is used to define Custom simulations and to change solver parameters for all types of simulations. Custom simulations should be defined when any of the pre defined standard simulations Heating, Cooling or Energy are inappropriate, for example when only a month should be simulated.

In the Calculation tab, select between a periodic and a dynamic simulation. A periodic simulation means a certain period is simulated a number of times until the system has stabilized and no longer changes from simulation to simulation (a periodic state). A dynamic simulation means that the simulation starts at a particular time and ends at another time. Both these times are indicated in the same way as the date for periodic simulation. How the simulation is to be initialized must also be indicated for a dynamic simulation. For this reason, another tab, named Startup, is added to the Simulation data dialog.

The startup phase can also be periodic or dynamic. Make the selection in the same way as above. A periodic startup phase means that the selected period is simulated a number of times until the system has stabilized. A dynamic startup phase means that a selected number of days are simulated before the proper simulation starts.
How long the startup phase should be depends on how heavy the building is and on its contact with the ground. The heavier the building, the longer startup phase is required. Approximately two weeks should however always be enough for most buildings. In both cases, no intermediate results are saved from the startup phase.

Integration parameters can be selected under the Advanced Tab in the dialog. See also the manual for description of these parameters.

Field descriptions, etc:
- **Tolerance** This number determines how accurately equations are to be solved (-)
- **Maximal timestep** The largest timestep to be taken (h)
- **Maximum number of periods** Maximum number of periods in a periodic simulation.
- **Tolerance for periodicity** Tolerance for periodicity in a periodic simulation (-)

The tolerance given is the degree of accuracy reached in the calculated variables. It is absolute for small quantities (normally < 1) and relative for larger quantities (normally >1). The precise definition of Tolerance is given in the documentation for IDA Solver, which can be obtained from EQUA. Relaxing the tolerance should normally result in a faster simulation. However, if the tolerance is relaxed too much, the solver will have greater trouble to find a solution at all and this in turn costs execution time and causes poorer stability.

- **Output step** If greater than zero, recorded times in output files will have this time step (h). If a Time step for output has been given, result files will be interpolated to have a fixed time step, enabling for example Excel comparison of results between different runs. Simulation time step is still variable.
  If a Time step for output is zero (or left blank), the time step of output will be same as solver timesteps, i.e. not equidistant in time.

  Note that result files will contain instantaneous values of measured variables, i.e. not integrated values over the given step. In order to obtain average, e.g. hourly, results use Table tab of result diagrams instead.

For a dynamic simulation, the solver will select the time step up to the Maximal timestep specified. Allowing very long timesteps may create stability problems for the solver that in turn cost time to resolve.
In the case of a periodic simulation, the number of periods can be limited and a tolerance chosen for the relative changes required from day to day, for the simulation to be considered periodic.

See also Topic note on timesteps at the ICE User Support web page (Help menu).

7.2.7. Results tab

7.2.7.1. Simulation Results

The Results tab is shown automatically, after a completed simulation.

Field description:

Summary of scalar results

Three tables: Summary, Heating design and Cooling design, that present key scalar results on a zone-by-zone basis. Heating and cooling design will always present information from the corresponding special simulation done. The Summary table will always show results from the last simulation done, i.e. this could have been a heating, cooling, energy or custom simulation. Heating and cooling results will be retained until that particular simulation is repeated, i.e. they will not be overwritten by, e.g., an energy simulation.

Scalar results often represent maximum values of various sensor readings. Note that by default signals are filtered by a 15 minute sliding average (time can be changed in System parameters). This is because very sharp peak values, spikes, often convey insignificant information that depends on approximations made rather than on underlying physics.

This also means that presented results may not always correspond with a manual reading from a diagram.

Study the tooltip texts (also presented in the status bar) of each signal for more precise information.

Modified

The time when the model was last changed. Only shown if the model was changed after the latest simulation.

Saved
The time when the case was last saved on disk.

**Simulated**
The time when the latest simulations were run.

**Sim. type**
The type of the last simulation.

**Make report**
When pressed, the results are combined into a single Word document. Implemented for Word 2000 or later.

**Detailed result**
A list of all result objects requested before the simulation.

**More…**
Access to further reports, e.g. Multizone report – the equivalent of the zone Energy report – but applied to an arbitrary collection of zones – or Compare results – a way of comparing multiple separate cases in the same report.

### 7.3. HVAC Systems

#### 7.3.1. The Primary system

For documentation, see the section on Primary system in the manual.
7.3.2. Air handling unit

Read about the Air handling unit in the manual.

7.3.3. Form for Heating Coil

The figure illustrates the form used for an object of the Heating Coil type. A heating coil is one of the parts in the air handling unit. The form is most easily opened by double clicking on the symbol for heating coil (hc) in the air handling unit’s Schema.

Field description, etc:

ETAAIR Air side effectiveness at capacity (-)
DTLIQ Liquid side temperature drop (°C)
The heating coil has two important parameters, ETAAIR, the air side temperature efficiency and DTLIQ, the desired waterside temperature reduction. Capacity control is achieved by adapting the actual efficiency up to the given maximum efficiency level. The necessary water flow is calculated and the water temperature is reduced, if possible, by the desired number of degrees. There is no bypass on the liquid side; control is achieved by simply restricting the water flow.

In the default configuration, the temperature efficiency is set at 1.0. There are two situations when it may be desirable to change this to a more realistic value: for coil sizing by means of simulation experiments, and when making energy calculations in cases where the boiler efficiency is dependent on temperature conditions. In addition, the simplest and quickest way of removing the entire coil is to set the efficiency to zero.

7.3.4. Form for cooling coil

The figure illustrates the form used for an object of the Cooling coil type. A cooling coil is one of the parts of the air handling unit, which is included in every building created. The form is most easily opened by double clicking on the symbol for the cooling coil (cc) in the air handling unit’s Schema.

Field description, etc:
ETA Air side effectiveness at capacity (-)
DTLIQ Liquid side temperature rise (°C)

The cooling coil works in the same way as the heating coil but is mathematically more complicated because air dehumidification is calculated. The given efficiency is defined as (1 - "bypass factor") according to ASHRAE’s nomenclature. Physically, this means that the state of the cooled air in the psychometric chart is on a straight line between the state for the incoming air and the apparatus dew point temperature on the saturation curve.

In the model, the average temperature of the liquid side defines the apparatus dew point. On this line, the given efficiency indicates the status: 0 is no cooling whatsoever, and 1 indicates maximum cooling, which also means that the air temperature may be chilled to (the arithmetical) mean value of the coolant’s incoming and outgoing temperatures.
7.3.5. Form for Heat Exchanger

The figure illustrates the form used for an object of the Heat Exchanger type. A heat exchanger is one of the parts in the air handling unit. The form is most easily opened by double clicking on the symbol for heat exchanger in the air handling unit’s Schema.

Field description, etc:
ETA Effectiveness at full capacity (-)
TEXHOUTMIN Minimum allowable temperature of exhaust air stream (°C)

The heat exchanger is controlled by the actual efficiency selected by the model (up to the maximum limit set by the user), so that the setpoint for the supply air temperature is reached, if enough heat is available. The temperature of the (often chilled) exhaust air, which may not fall below a certain level (TEXHOUTMIN parameter in the form), sets another limit. This is to avoid freezing for non-rotating heat exchangers.
The heat exchanger takes into consideration condensation on both the supply and exhaust sides. During wet processes, the given efficiency is interpreted as \((1 - \text{"bypass factor"})\) in the same way as for the cooling coil, but the apparatus dew point for the heat exchanger is defined as the incoming temperature for the opposite medium.

7.3.6. Form for choice of schedule

The form is used for algorithmic objects that describe a time schedule. Follow the Schedule link to set data.
7.3.7. Edit temperature depending input

Certain input in IDA Indoor Climate and Energy depends on outdoor air temperature. Under the Data Tab in the piecewise proportional controller dialog, a number of points can be given to define such dependency. As an example, the Dialog box is opened in the form for primary system and air handling unit by double clicking on the symbol with the following appearance:

Field descriptions, etc.:
**Description** Object description.
**Points**
**Add**
**Delete**
**Selected point: Ambient temperature**
**Selected point: Supply heating water temp**
Under the Diagram Tab, the temperature dependency is presented in the form of a curve. This can be edited, which is done as a polyline. When the curve is edited, the points under the Data Tab are then corrected.

Field descriptions, etc:

Edit
Properties

A polyline consists of line segments and break points, the latter marked by small rectangles. In this case, it can be edited in three ways after double clicking on it or clicking on the Edit button:

1. Its break points can be dragged to the desired position.
2. A new break point can be inserted by clicking on or close to the line.
3. An existing break point can be deleted by clicking on it.

To end editing, click once with the Right button and select OK. The curve can then be examined before leaving the dialog. Alternatively, the curve can be edited by defining points under the Data Tab.

Important: do not insert any unnecessary breakpoints. The solver can have severe problems with curves that contain small (even microscopic) irregularities.
7.4. Zone

7.4.1. Zone form

This form presents an object of the Zone type. It is most easily opened by double clicking on the name of a zone in the Zones list box in the building form or by double clicking on a zone in the Floor plan.

Field descriptions, etc:
- **Number of zones of this type** Number of rooms with these conditions. Central consumption of air, water and electricity is increased by this factor.
- **Loss factor for thermal bridges** Direct heat transfer between room air and outside air, Watts per degree (C) temperature difference. (W/°C). This parameter is normally given by values entered under Thermal bridges in the building form.
- **Controller setpoints** Choice of target values for temperature, air quality, light and pressure.
- **Air**
  - **Select air handling unit** Choice of air handling unit for this zone. First define systems to select from at the building level.
  - **More...** Click here to add multiple central or local air-handling units that serve this zone.
  - If the zone already contains multiple AHU's, this link is marked with red asterisk. The fields described below are marked in the same way if the field's value is different in additional AHU’s.
  - **System type** Type of ventilation system. Constant or variable flow, with different controls. To create an exhaust only or supply only system - or no mechanical system at all – select CAV and set appropriate flows below to zero.
  - The list of ventilation control strategies contains also
    - all user-defined custom control strategies;
"New custom control" to define a new custom ventilation control strategy (Expert edition);

ventilation control targets defined in the zone central controller, if such a control is defined in the zone (on advanced tab);

"VAV signal from..." to use ventilation control signal from different zone.

If a custom controller is selected, the label system type works as a link to the control macro.

**Supply air for CAV** Mechanical supply air flow for CAV systems (l/s m² floor area). VAV flow is given under Controller setpoints. Clicking on the link "l/s m²", opens a dialog where the flow can be specified in alternative ways (l/s or m³/h for entire zone, m³/h/m², or air changes per hour).

**Return air for CAV** Mechanical return air flow for CAV systems (l/s m² floor area). VAV flow is given under Controller setpoints. Clicking on the link "l/s m²", opens a dialog where the flow can be specified in alternative ways (l/s or m³/h for entire zone, m³/h/m², or air changes per hour).

**Displacement degree for gradient calculation** From 0 (well-mixed) to 1 (full displacement ventilation), or a negative value for a fixed temperature gradient given by the user.

**Leak area** ELA Equivalent leakage area in the envelope, defined at 4 Pa, Cd=1 and, 1 m above floor. Of importance only when other leaks, e.g., internal openings, also exist. (m²). This parameter is normally given by values entered under Infiltration in the building form.

**Given additional in/exfiltration** Fixed flow, independent of pressure. Leak area should be small (but nonzero) when this option is used. This parameter is normally given by values entered under Infiltration in the building form. Read more about infiltration modeling in that form.

**Geometry**

**Room height: to ceiling** Distance between the floor surface and the ceiling (m). The ceiling or some parts of the ceiling may be below this level if the building's roof is too low to fit requested zone height. If "to roof" is selected, the field "to ceiling" shows the height level where the lights and active beams are located.

**Room height: to roof** Select this to extend the room's ceiling to the building's roof.

**Floor height above ground** Distance between the floor surface and the ground (m).

**3D zone view** By default the zone is rectangular with six surrounding surfaces, called main surfaces. When an alternative geometry is defined, the main surface names will be extended with a letter suffix (e.g. wall 1 can be split into wall 1a and wall 1b). Windows, doors, and radiators, etc are introduced as objects on the corresponding zone surfaces.

**Open Floor Plan** Click to see this zone from the Floor plan view.

**Room units** Shows the list of cooling and heating units in zone. The ideal cooling and heating devices may be added here; other devices may be added to zone surfaces.

**Internal gains** Full list of zone internal gains. Add equipment, light, and occupant loads here.

**Details** Shows selected parameters in a table view for different sub objects in the zone:

- Surfaces
- Windows
- Openings
- Air handling units
- Leaks
- Room units
- Internal gains
**Internal masses** Extra thermal mass, i.e. mass in addition to that of zone partitions and floors.
To understand the precise meaning of each parameter, double click anywhere on the row of an object to open. Then press F1 to open context help for that object.

Read more about the zone models and these parameters in the IDA ICE Manual.

### 7.4.2. Calculation of thermal bridge coefficients

The total loss factor in a zone's thermal bridges is calculated as sum of loss factors in bridges created by different construction elements listed in the form.
The coefficients per unit of element size (in most cases per meter) are by default given at building level.
The sizes of elements are by default calculated from zone geometry, but may be also given by the user.
The values specified explicitly by the user are marked with yellow background. To restore the default setting, click the yellow field with right mouse button and select **Mapping | Restore link** from the context menu.
The user may also specify an extra loss for this zone, independent of given geometry.

See also
Thermal bridge coefficient
### 7.4.3. Dialog for controller setpoints

![Diagram of setpoint collection interface]

The dialog for objects of the Controller setpoints type defines all the quality requirements for the zone’s climate.

**Field descriptions, etc:**

**Temperature**
- **Min** Setpoint for heating controller. (°C)
- **Max** Setpoint for cooling controller. (°C)

**Mech. supply air flow**
- **Min** Minimum flow at VAV. Recommended minimum airflow. (l/s/m²). When left blank, balanced ventilation is assumed (value is taken from field below)
- **Max** Maximum flow at VAV. Recommended maximum airflow. (l/s/m²) When left blank, balanced ventilation is assumed (value is taken from field below)

**Mech. return air flow**
- **Min** Minimum flow at VAV. Recommended minimum airflow. (l/s/m²)
- **Max** Maximum flow at VAV. Recommended maximum airflow. (l/s/m²)

**Relative humidity**
**Min** Level of humidity below which minimum VAV flow is kept. Only for VAV with humidity control. (%)

**Max** Level of humidity above which maximum VAV flow is kept. Only for VAV with humidity control. (%)

**Level of carbon dioxide**

**Min** Level of carbon dioxide below which maximum VAV flow is kept. Only for VAV with CO2 controlling. (ppm (vol))

**Max** Level of carbon dioxide above which maximum VAV flow is kept. Only for VAV with CO2 controlling. (ppm (vol))

**Light at workplace**

**Min** Light intensity at the working surface below which a maximum of electric light is turned on. (Lux)

**Max** Light intensity at the working surface above which the electric light is fully off. (Lux)

**Pressure diff. envelope**

Used for VAV with pressure control (normally return air only). Used to extract air in VAV systems when air is supplied in other zones by VAV with other type of control.

**Min** Pressure difference over zone envelope, when minimum amount of air should be extracted. (Pa)

**Max** Pressure difference over zone envelope, when maximum amount of air should be extracted. (Pa)

**Object:** name and description

The dialog for controller setpoints is opened by the Right button menu with the cursor over an object of the Controller setpoints type, (e.g. Office, normal standard) in the Controller setpoints field in the zone form or in the form for IDA-resources.

The setpoints specified in the dialog are used by controllers of the zone climate.

See also the IDA ICE manual

**7.4.4. Operative temperatures**

The operative temperature is the average of the air temperature and a radiation temperature at a certain point. This is the temperature which is felt by a person in a room. It is calculated for each occupant load taking account of its position in the room. When an occupant load is first inserted it is given a default position in the middle of the room, with a center of gravity (sitting) at 0.6 m above the floor. This position can be changed by opening the surface editor for the floor.

To learn about the operative temperature at a point without introducing an additional thermal gain, the number 0 is given in the field for Number of people in the form for the Occupant load.

Directed operative temperatures, in six directions, are available in a zone using the Climate model fidelity.
7.4.5. Form for occupant load

Field description, etc:

**Number of people** Number of people in the group.
**Schedule** Schedule for the presence of the group. Smoothing applied by default. The output signal must be within [0, 1].
**Activity level** Activity level according to Fanger (met)
**Clothing** Degree of clothing according to Fanger. (clo)
**Object:** Name and description

See below for a more detailed description of met and clo:

The occupant load’s position on the floor in the zone can be changed in the Surface editor (for the floor). An occupant load is indicated by a chair icon. Several occupant loads can occur in the same zone. When the Climate zone model has been selected, operative temperature will depend on the position.

Measuring points for operative temperature coincide with occupant loads. To follow the operative temperature at a certain point without loading the zone, select 0 for the number of people or the ”always off” schedule.

**Selecting activity level (met)**

The activity levels and the amount of clothing, defines how much heat (sensible and latent) and carbon dioxide a person emits. 1 met corresponds to 58.2 W per m² body surface, which is the amount one sitting, inactive person is assumed to emit. In IDA Indoor Climate and Energy, body surface has been selected to be 1.8 m², corresponding to an average adult. The
examples below give the emitted total power and activity levels during different activities, which are assumed to be continuous. (Source: ASHRAE Fundamentals).

<table>
<thead>
<tr>
<th>Activity</th>
<th>met</th>
<th>Power [W]</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sleep</td>
<td>0.7</td>
<td>72</td>
</tr>
<tr>
<td>Reclining rest</td>
<td>0.8</td>
<td>81</td>
</tr>
<tr>
<td>Seated quiet resting</td>
<td>1.0</td>
<td>108</td>
</tr>
<tr>
<td>Standing, relaxed, rest</td>
<td>1.2</td>
<td>126</td>
</tr>
<tr>
<td>Walking (3.2 km/h)</td>
<td>2.0</td>
<td>207</td>
</tr>
<tr>
<td>Walking (4.3 km/h)</td>
<td>2.6</td>
<td>270</td>
</tr>
<tr>
<td>Walking (6.4 km/h)</td>
<td>3.8</td>
<td>396</td>
</tr>
<tr>
<td>Reading, seated</td>
<td>1.0</td>
<td>108</td>
</tr>
<tr>
<td>Typing</td>
<td>1.1</td>
<td>117</td>
</tr>
<tr>
<td>Office walking</td>
<td>1.7</td>
<td>180</td>
</tr>
<tr>
<td>Office lifting/packing</td>
<td>2.1</td>
<td>216</td>
</tr>
<tr>
<td>Cooking</td>
<td>1.6-2.0</td>
<td>171-207</td>
</tr>
<tr>
<td>Housecleaning</td>
<td>2.0-3.4</td>
<td>207-360</td>
</tr>
<tr>
<td>Light machine work</td>
<td>1.8-2.4</td>
<td>189-252</td>
</tr>
<tr>
<td>Heavy machine work</td>
<td>4.0</td>
<td>423</td>
</tr>
<tr>
<td>Pick and shovel work</td>
<td>4.0-4.8</td>
<td>423-504</td>
</tr>
<tr>
<td>Dancing, social</td>
<td>2.4-4.4</td>
<td>252-504</td>
</tr>
<tr>
<td>Aerobics/work out</td>
<td>3.0-4.0</td>
<td>315-423</td>
</tr>
<tr>
<td>Tennis</td>
<td>3.6-4.0</td>
<td>378-486</td>
</tr>
<tr>
<td>Basketball</td>
<td>5.0-7.6</td>
<td>522-792</td>
</tr>
<tr>
<td>Competitive wrestling</td>
<td>7.0-8.7</td>
<td>738-909</td>
</tr>
</tbody>
</table>

How to select clothing (clo)

The amount of clothing has a large influence on the comfort experienced, which is measured with PPD (percentage of people dissatisfied) and PMV (predicted mean vote). It also has some influence on the power emitted by a person. It 1 clo equals a heating resistance of 0.155 m²K/W. The examples below give the clo-values for different types of clothing (source: ASHRAE Fundamentals).

Comfort measures such as PMV and PPD are only meaningful if people are appropriately dressed, otherwise they will nearly always feel too hot or cold (just like in real life). In practice, it is quite time consuming and difficult to construct schedules that provide a clothing for a whole-year simulation. Therefore, IDA ICE has from version 4 been equipped with a simple method for adapting clothing to sensed PMV.

Upper and lower bounds on clo are given by the user, by providing a clo tolerance in the occupant load form. The lower bound should represent the socially acceptable lower clothing limit in the given environment (perhaps in a casual office, 0.6) and the upper, the culturally accepted winter attire, say 1.1. The algorithm simply treats the occupant as a proportional controller, when PMV is at the lower bound (by default -1), the person will wear maximum clothing and similarly on the hot side, minimum clothing will be worn at the upper PMV bound (default +1). PMV limits can be selected in System parameters on the building form.
In reality, studies show that people in an office environment will decide how to dress in the morning, mostly based on outdoor conditions, and will not continuously adapt their clothing during the day. It is therefore not realistic to set the PMV bounds too close to zero (approaching ideal control).

<table>
<thead>
<tr>
<th>Clothing</th>
<th>Clo</th>
</tr>
</thead>
<tbody>
<tr>
<td>Shorts, short-sleeve shirt</td>
<td>0.36</td>
</tr>
<tr>
<td>Trousers, short-sleeve shirt</td>
<td>0.57</td>
</tr>
<tr>
<td>Trousers, long-sleeve shirt</td>
<td>0.61</td>
</tr>
<tr>
<td>Same as above, plus suit jacket</td>
<td>0.96</td>
</tr>
<tr>
<td>Same as above, plus vest and T-shirt</td>
<td>1.14</td>
</tr>
<tr>
<td>Trousers, long-sleeve shirt, long-sleeve sweater, T-shirt</td>
<td>1.01</td>
</tr>
<tr>
<td>Same as above, plus suit jacket and long underwear bottoms</td>
<td>1.30</td>
</tr>
<tr>
<td>Sweat pants, sweat shirt</td>
<td>0.74</td>
</tr>
<tr>
<td>Knee-length skirt, short-sleeve shirt, panty hose, sandals</td>
<td>0.54</td>
</tr>
<tr>
<td>Knee-length skirt, long-sleeve shirt, full slip, panty hose</td>
<td>0.67</td>
</tr>
<tr>
<td>Knee-length skirt, long-sleeve shirt, half slip, panty hose, long-sleeve sweater</td>
<td>1.10</td>
</tr>
<tr>
<td>Same as above, replace sweater with suit jacket</td>
<td>1.04</td>
</tr>
<tr>
<td>Ankle-length skirt, long-sleeve shirt, suit jacket, panty hose</td>
<td>1.10</td>
</tr>
<tr>
<td>Long-sleeve coveralls, T-shirt</td>
<td>0.72</td>
</tr>
<tr>
<td>Overalls, long-sleeve shirt, T-shirt</td>
<td>0.89</td>
</tr>
<tr>
<td>Insulated coveralls, long-sleeve thermal underwear, long underwear bottoms</td>
<td>1.37</td>
</tr>
</tbody>
</table>
7.4.6. Form for Lights

Field description, etc:
Number of units Number of lighting units. Total power emitted is the rated input times this number.
Control strategy Operation method for lighting. The options are
- 'Schedule' (as default);
- 'Setpoints+Schedule', the light is on then is enabled by the schedule and the daylight level is below the given level, see the details below;
- all user-defined custom light control strategies;
- "New custom control" to define a new custom light control strategy;
- the light control targets defined in the zone central controller, if such a controller is defined in the zone (on advanced tab).
Schedule Operation schedule for lights. Smoothing applied by default. The output signal must be in the interval [0, 1]
Rated input per unit Consumption of electrical power when lights are on. (W)
Luminous eff. Number of lumen emitted per watt supplied electrical power. (lm/W)
Convective fraction Fraction of rated input emitted as convective heat. (0-1)
Energy meter Choice of Energy meter that reports the energy consumption of the lighting units
Object: Name and description
The form for a light is opened e.g. by double clicking on an object of the Lights type in the Internal gains box in the zone form. The light’s extension and position on the zone’s ceiling can be changed in the Surface editor (for the ceiling), where a light is marked with a specific symbol. At the moment, only one light source is allowed in a zone. Typically, the size and location of the light has but a small influence on the room climate, except when a large output is emitted from a small surface. To avoid this, the light can be extended over a major part of the ceiling.

If the Control strategy is set to Setpoints+Schedules, the light output is varied depending on available daylight, during the periods when the selected schedule is on (> 0). If the daylight falls below a min level, set in the Controller setpoints dialog, the light output is set at nominal power. If the daylight exceeds the max level, the lights are off. Between these limits, the control is proportional.

7.4.7. Light Control Macro

**Light Control macro** is used to describe a custom lighting control strategy. See Custom control for general information about control macros. The output signal should be connected to the pre-defined interface reference OUTSIGNALLINK on the border of the macro. An output signal=1, means the lighting power given as “Rated input”, 0 means zero power. The schedule given for the Light object may be used only inside the control macro (it is NOT combined with OUTSIGNALLINK).
7.4.8. Form for equipment load

Field description, etc:
- **Number of units**: Number of equipment units with these data.
- **Control strategy**: Control method.
- **Schedule**: Operation schedule. Smoothing applied by default. The output signal must be in the interval [0, 1].
- **Emitted heat per unit**: Total emitted sensible heat. (W)
- **Energy carrier**: Choice of energy type consumed by the equipment units
- **Energy meter**: Choice of Energy meter that reports the energy consumption of the equipment units.
- **Advanced**
  - **Long wave radiation fraction**: Share of sensible heat that is emitted as long wave radiation. Radiation is distributed according to wall surface areas. (0-1)
  - **Liquid water emission per unit**: Emitted as water droplets, i.e, the evaporation heat is removed from the air (kg/s)
  - **Dry steam emission per unit**: Emitted as water the evaporation heat is not removed from the air. (kg/s)
  - **CO2 per unit**: Carbondioxide emitted by the device. Note the unit! (mg/s)
  - **Utilization factor**: Share of heat and other emissions that are deposited in zone (0-1)
**Object:** Name and description

The form for an equipment load is opened e.g. by double clicking on an object of the Equipment type in the Internal gains box in the zone form. Several objects of the Equipment load type can be in one zone. Their placing in the zone is not considered to influence the results.

### 7.4.9. Convective internal mass

Objects of this type, inserted in a zone (see Insert object), are always edited in this form.

![Convective internal mass form](image)

**Field description, etc:**

**Area**
- Area per side (object is described as two-sided wall) [m²].

**Construction**
- Approximate the object by wall-type construction.

**Heat transfer coefficient**
- Convective heat transfer coefficient (no long-wave exchange is calculated) [W/(m² K)].

This type of object is used to model internal masses that primarily interact with the zone air, and that are "seen" by the walls only to a minor extent. Examples could be store room shelves, furniture, plants, etc. These masses can have a relatively large influence on fast temperature variations but can normally be neglected in energy calculations. The area should give an estimate of the total area exposed to the zone air. Note that all objects are treated as double sided, e.g. for a desk the top side area should be given. The construction specified should correspond to a section through the object and several material layers can be specified in the same way as for a wall.

### 7.4.10. Thermal mass

Objects of the type Thermal mass, inserted in a zone (see Insert object), are always edited in this form.
Field description, etc:

**Area**
Area per side of two-sided wall [m²].

**Construction**
Construction (order between sides is immaterial)

**Heat transfer coefficient**
Convective heat transfer coefficient (long-wave heat transfer is calculated by ICE) [W/(m² K)].

This type of object is used to model masses like internal walls and floor slabs that are contained inside the zone, are "seen" by the zone walls, and thus partake in the radiation balance.

The given area should provide a figure for the area exposed towards the zone surfaces. Note that all objects are treated as double sided; the area of one side is given. The construction specified should correspond to a section through the object.

**7.4.11. Custom ventilation control**

A **ventilation control macro** is used to describe a custom ventilation control strategy for a zone.

See Custom control for general information about control macros.

The final output signal should be connected to the pre-defined interface reference OUTSIGNALLINK on the border of the macro. An output signal=1, means VAV air flow is at its maximum setting according to given parameters in Controller setpoints (provided the fan is running); output signal=0, means VAV flow is kept to min setting (NB! not normally zero). Supply and return flows are always controlled in parallel (but may have different min/max settings).

Note that the setpoints may be redefined in the central zone control.
7.4.12. Zone Advanced tab

Model fidelity 'Default' = choice is done in the Default form at the building level. 'Climate' = better result, gradients included. 'Energy' = faster, no gradients. Selecting 'Climate' or 'Energy' here has priority.

Zone group The group name used for creating group based reports and scripts.

Air velocity in the occupied zone Air velocity for the calculation of comfort index (m/s).

Zone controller Choice of zone control: by setpoints (default) or by a user-defined zone central control.

Domestic Hot Water Use Hot water consumption in the zone (in addition to the consumption given at the building level). The time distribution of the consumption may be either uniform (this is the default) or given by a schedule. The schedule is automatically scaled to get the correct yearly total.

7.4.13. Zone central control

A zone central control macro (ZCCM) is used to describe a coordinated custom control strategy for zone devices. An example of this is when the heating is switched off as soon as a window is opened. By default, devices have local control loops that independently strive to keep a requested setpoint, i.e. the heater will try to heat even if the room is chilled by an open window.

To define a custom zone control strategy, select "New" in "Controller" field (in the zone’s advanced form). This will open a new ZCCM.

To edit an existing ZCCM, select it in the "Controller" field and click the "Controller" link. A new ZCCM does not contain any control system. It contains only proxy objects that denote signal sources and control targets. The user must define a control algorithm by inserting appropriate models and connecting them (see Modeling about editing macro objects).

A ZCCM is able to send two types of signals to controlled devices: setpoints and direct actuator signals. Setpoints are used by a local device controller to know what to strive for; a direct actuator signal governs a device directly, e.g. an opening ratio. If the signal is 0.5, the window will be 50% open, independent of conditions in the zone.

The default control target in the template macro, named ‘Central zone control’, transmits direct actuator signals. If for example a signal is connected to the Heating interface of the control target, the name ‘Central zone control’ appears on the list of selectable controllers of any heating device, e.g. a water based radiator.
It is also possible to receive the transmitted actuator signal in a custom made local device controller. In this case, a proxy (receiver) of the Central zone controller must be manually inserted into the local device control macro. Drag the appropriate object from the palette page Links.

If, on the other hand, a target for setpoint signals is dragged from the Links palette to the ZCCM and a signal is connected to one of its interfaces, e.g. THERMOSTAT_MIN, all heating device controllers will be striving to reach this target (unless they have custom built controllers with a different agenda). This way, it is for example possible to implement more complex night setback methods than the time scheduled setpoint that is available by default (in the Controller setpoints object).

The ZCCMs are shared between zones (i.e. a control defined in one zone is available in all zones. They are included in the list of IDA Resources. Use this list to manage the controls (e.g., copy to other systems).

A user-defined control macro is never simulated in its original form. Instead, a copy of this macro is created for every zone that uses it and all these individual copies are simulated, with setpoints and input signals local to each zone. Therefore the user-defined macro will never contain results of simulations (such as values of variables in models and time series in output files). To see the actual result, look at the instances of the control macros at advanced level.
7.4.14. Walls, Floor and Ceiling

7.4.14.1. Form for wall, floor and ceiling

Open the form for walls, floor and ceiling by double clicking on the corresponding object of type Wall, Floor or Ceiling in the zone form, and selecting the Advanced tab.

Field descriptions, etc:

**Construction** Choice of material and thickness of layers.

- **For external walls** Choice of materials and thickness of layers for the part of the wall that is external.
- **For internal walls** Choice of materials and thickness of layers for the part of the wall that is internal.
- **Flipped** If checked, the wall layers of the internal wall are counted in the opposite order.
- **Inner surface** Description of the optical properties of the inner surface. These are of minor importance in normal cases.
- **Outer surface** Description of the optical properties of the outer surface. Only for building elements facing ambient.
If [Default] is left in the construction fields, the corresponding construction is fetched from the Defaults tab in the building form.

**Thermal connection**
The wall is thermally connected with adjacent zone or building face. If there are multiple adjacent objects, the wall is divided in parts

**Ignore adjacency to faces**
If the building shape is too complicated to be fully described in ICE, it may be desirable to explicitly describe the thermal connections between zones and building external surfaces (faces). By checking this box, the automatic detection of adjacent face is suppressed (but the adjacency between zones is still detected).

The parts having no adjacent zone (or face, if not suppressed) are connected as below described in following fields:

**Ignore net heat transmission**
Normally select this alternative for internal walls. An adiabatic surface is placed in the geometric middle of the wall.

**Constant surface temp on other side**
Select this only when no adjacent zone is simulated, but heat transmission is significant. A surface temperature is specified on the opposite side of the wall (note: not air temperature). **NB Use with caution! Could introduce significant energy transports and will ruin the building energy balance.**

**Similar + offset**
When an offset of zero is given, this alternative is roughly equivalent to the Ignore net… option. However, here, adjacency to a similar zone with a constantly different temperature can be specified. **NB Use with caution! Could introduce significant energy transports and will ruin the building energy balance.**

**Connect to face:**
Manual connection to given face (façade); specify face in adjacent field. The facade itself does not have to adjoin the wall. This allows modeling of buildings with complex shape.

**Connect to ground**
Use for 'slab on grade' or basement floor; under-slab-construction and ground temperature are given in the Ground properties dialog in available from the main building form

Walls are automatically coupled to geometrically adjoining zones or facades. The user should not create these couplings manually.

If the wall is not adjoining a facade or another zone, one has a free choice of thermal boundary conditions. The choice **Ignore net heat transmission** will give a wall with thermal mass exposed but no heat transmission over extended periods. Other choices are explained above.

Note that when a zone is moved in a way that, e.g. changes an external wall to an internal one, the choice of wall construction will be automatically adapted to the new role. This also applies to parts of walls.
7.4.14.2. Editing objects on a surface

Double clicking in the box Drawing describing objects on the surface, in the form for objects of type Floor, Wall and Ceiling, opens a so-called surface editor which shows a drawing of the respective surface.

To insert an object on the surface, drag it from the palette page on the Side bar. Alternatively, you can double click an object on palette and then place the cursor somewhere within the drawing, hold down the left button and drag the object to the desired size. Now release the button.

The size and position of the object can be changed. Change the size by first selecting the object and dragging one of the small rectangles in the object’s corners or in the middle of its sides. Change the position by placing the cursor within the object’s boundary lines, holding down the left button, and dragging the object to the desired position.

The features may be also moved using Shift dialog;

Numerical values for the object’s size and position can also be given on the **Properties page** (situated on the Side bar), while the object is selected.
7.4.14.3. Dialog for wall definition

Objects of the Wall definition type are used to define the construction of walls and floors. A wall definition has a name, a description and a number of layers.

Field descriptions, etc:
- **Category** Select the category of construction (internal floor, external wall etc). When editing the construction of some object, only the compatible categories are available. Select "Generic" to allow using the construction in any case.
- **Wall definition** Choice of Wall definition object. The rest of the dialog shows the details of the selected object.
- **Description** Object description.
- **U-value** Overall U-value, including film coefficients (W/(m² * °K))
- **Layers**: Floor top/Wall inside A list of layers in the wall. NB! Also Roof constructions are described from top to bottom.
  - **Add** Button to add additional layer.
  - **Delete** Button to delete an existing layer.
  - **Promote** Button to move a layer up one step.
  - **Demote** Button to move a layer down one step.
- **Layer data**
  - **Material** The button with the right arrow gives a menu of possible operations:
    - **Open** Open the Material dialog.
    - **New resource** Create a new material.
    - **Load from database...** Load object of the Material type from database.
**Write to database** Save the user-defined material to the database.

**Thickness** Layer thickness. (m)

The dialog for a wall definition is opened by the menu option Open, after pressing the Right button with the cursor over an object of the wall definition type (e.g. Internal wall with insulation) in the Construction field in the form for a wall or in the form for IDA-resources. The layers the wall consists of are displayed in the list box in the Layers box. Floor layers are given in order of floor surface to floor bottom (usually ceiling below). Wall layers are given in order of inside to outside. The Add button is used to add new layers in a wall definition. The layers selected in the list box can be deleted with the Delete button and moved up or down respectively with the Promote and Demote buttons.

Layer data for the selected layer is displayed in the Layer data box to the right in the dialog. Every layer has a name, a description and a thickness given in meters, and consists of a material that can be selected under the Material heading. If the desired material isn’t on the list, additional material definitions can be loaded from the database by clicking right arrow symbol and selecting Load from database. Use the Open choice in the same menu to open the selected material definition. Similarly, a new material can be created by selecting New Resource and the selected material can be stored in the database by selecting Write to database.

**Dialog for material data**

Field descriptions, etc:

**Name** Choice of Material object. The rest of the dialog shows the details of the selected object.
**Heat conductivity** Heat conductivity. (W/m*K)  
**Density** Density. (kg/m³)  
**Specific heat** Specific heat. (J/kg*K)  
**Category** The type of material (used to systematize the database)  
**Description** Material description.

The Dialog for a material is opened from Wall definition dialog by clicking on the Open button. Access a resource from the Right button menu with the cursor over an object of the Material type (e.g., Concrete), in the form for IDA-resources.

7.4.14.4. **Dialog for surface**

![Surface Dialog](image)

This dialog is used to edit objects of the Surface type. A surface object has a name (Default surface in the figure), a description and two parameters.

Field descriptions, etc:  
**Name** Choice of Surface object. The rest of the dialog shows the details of the selected object.  
**Description**  
**Longwave emissivity** (0–1)  
**Shortwave reflectance** (0–1)

The dialog for a surface is opened by the menu option Open, after pressing the Right button with the cursor over an object of the Surface type, (e.g. Light surface) in one of the Interior surface or Exterior surface fields in the form for wall, ceiling and floor or in the form for IDA-resources.
7.4.14.5. Wall part

**Object**: building à zone à enclosing surface à wall part

**Available from**: Wall editor

**Description**: Describes a part of wall, floor or ceiling with different construction or adjacency conditions, or with different surface temperature.

**Views**: General (identical to enclosing element's advanced view)

A wall part is an object that can be inserted into another wall and which can be given other properties than the rest of the wall. All parameters that can be specified for a wall, under the Advanced tab, can be specified independently for a wall part.

When a wall adjoins more than one zone or building face, each separate contact will automatically be modeled as an implicit wall part. The user should not specify these partitions explicitly.

Each wall part (both explicit and implicit) is modeled with its own (time dependent) surface temperature. Wall partitions can be used to model non-homogeneous temperature distributions over a wall.

Wall features (windows, radiators, etc) can be placed inside wall parts, but must not intersect the part’s borders (on either side of the wall).

**See also**:

Enclosing element, advanced view.

7.4.14.6. Leak

**Object**: building à zone à enclosing surface à leak

**Available from**: Wall editor

**Description**: Describes a leak between two zones or between a zone and the environment.

Field description, etc:

- **x, y** The position of the leak on the wall. Only the y coordinate will affect the result. (m)
- **Leak area** ELA Equivalent leakage area in the envelope, defined at 4 Pa, Cd=1. [m²].
- **Powerlaw coeff.** [kg/(s*Pa^n)]

The leakage through the envelope may be also described in ICE as infiltration. See the Infiltration form and the field “Leak area” in the Zone form.
The infiltration is implemented in ICE by inserting up to 4 leak models to the external walls of different orientation (positioned 1 m above the floor level) or in the ceiling if no external wall exists, or in the floor towards crawl space if no external surfaces exists. Thus also completely internal zones have some connection with the ambient.

7.4.15. Windows and openings

7.4.15.1. Form for window

A form for editing the properties of a window is opened (e.g., by double clicking on the window) in Drawing describing objects on the surface. (The surface editor is displayed by double clicking in the drawing box in the form for wall, floor and ceiling where the window is).
Field descriptions, etc:

**Glazing** Choice of glass configuration, includes SHGC-, T- and U-value for the glass.

**Opening (Expert edition only)**

- **Control** Selection of control strategy for window opening. Supported strategies
  - **Schedule** The opening is controlled by time schedule (or not controlled at all)
  - **On-off control + schedule, PI-control + schedule** The opening is controlled by air temperatures (both internal and external) in the range from 0 (fully closed) to the value given by the schedule
  - **New** Define a new (custom) opening control strategy
- **User-defined control strategies** The already defined custom control strategies are listed together with any target objects from the zone central controller.
- **Schedule** Schedule for degree of window opening. 0 = fully closed, 1 = fully open.
  Schedule smoothing applied by default

**Integrated window shading**

- **Device** Choice of curtains or blinds.
- **Control** Selection of control strategy for integrated shading device.
- **Schedule** Schedule for integrated window shading. Schedule smoothing applied by default

Selecting 'Light intensity + Schedule' draws the shading when the schedule is 'on' and the incident light exceeds 100 W/m² on the inside of the glass. This level can be changed at the building level in outline view, System parameters, internal_shading_control_level.

Selecting 'Schedule', makes only the schedule's values apply, 1=completely drawn, 0=completely open

Select "New" to define a new shading control strategy.

The list of control strategies contains also all user-defined shading control strategies, including those defined in the zone central controller, if such a controller has been defined in the zone (on the Advanced tab).

**External window shading**

- **Device** Choice of external window shading. Object for near-window shading, e.g., awnings, side fins, recess depth etc.

**Drawing view from the side to describe the external window shading** External window shading. Quick way to open shading editor.

**Frame properties**

- **Fraction of the total window area** The unglazed area of the window divided by the whole window area, defined by the outer frame measures. (0-1)
- **U-value** Heat transfer coefficient for the unglazed part of the window, including interior and exterior film coefficients. (W/°C)

**More...** Opens a dialog with detailed frame construction.

**Skew** [Deg]

- Specifies the orientation of the glass surface relative to the wall surface in horizontal (Twist) and vertical (Tilt) direction. The values of Twist and Tilt are added to the azimuth and slope of the wall's external surface in order to get the azimuth and the slope of the external glass surface.

**Object:** Name and description
The form contains a box named Drawing view from the side, to describe the external shading. Double clicking on this opens a form, which is used for editing any shading objects outside the window. This form has two tabs; under the Control tab, the type of control can be specified (no control, wind and/or sun control).

The form for a window can also be opened by clicking the right button over an object of the window type in the surface editor.
7.4.15.2. Detailed window (Expert edition only)
A form for editing the properties of a detailed window is opened (e.g., by double clicking on the window) in Drawing describing objects on the surface. (The surface editor is displayed by double clicking in the drawing box in the form for wall, floor and ceiling where the window is).

Field descriptions, etc:

**Glazing/shading** Choice of glazing system (glass and shading panes, gaps).

**Ventilated construction**

In the combo box, "None", "Wall" or "Window" can be selected. In the "Wall" alternative, a ventilated and glazed air-space is modeled outside the wall in which the window is placed. The air-space will have the same height and width as the wall. N.B. (1) the wall should be completely external and belong to one face; (2) only a single window should exist in an external wall acting as double-sheet façade.

If the “Window” alternative has been selected, the externally ventilated air-space only occupies the area of the window itself. For this option, several ventilated constructions may exist in the same external wall object.

Clicking on the link will open the input form of the ventilated construction:

**Integrated window shading**

- **Draw control** Selection of control strategy for integrated shading device.
- **Draw schedule** Schedule for integrated window shading. Schedule smoothing applied by default.

Selecting 'Light intensity + Schedule' draws the shading when the schedule is 'on' and the incident light exceeds 100 W/m² on the inside of the glass. This level can be changed at the building level in outline view, System parameters, internal_shading_control_level.

Selecting 'Schedule', makes only the schedule's values apply, 1=completely drawn, 0=completely open.

Select "New" to define a new shading control strategy.

The list of control strategies contains also all user-defined shading control strategies, including those defined in the zone central controller, if such a controller is defined in the zone (on advanced tab).

- **Level** Solar radiation level inside glass at which integrated shading is drawn. By default is mapped to a globally defined value.
- **Gaps and holes** Specify the size of gaps on the sides of the shading and holes inside the shading. Used to estimate the convection around the shade layer.
- **Slat angle** The orientation of slats. Is significant only for glass construction containing Venetian blinds. The angle is zero when the slats are horizontal and positive when the upper sides of slats are facing outside. This parameter may be overridden by a variable slat angle defined in the custom shading control.

**External window shading**

Choice of external window shading. Object for near-window shading, e.g., awnings, side fins, recess depth etc.

Click the link to open shading editor.

**Opening**

- **Control** Selection of control strategy for window opening. Supported strategies
  - **Schedule** The opening is controlled by time schedule
  - **On-off control + schedule, PI-control + schedule** The opening is controlled by air temperatures (both internal and external) in the range from 0 (fully closed) to the value given by the schedule
New
Define a new (custom) opening control strategy.

**User-defined control strategies**
The already defined custom control strategies are listed together with any target objects from the zone central controller.

**Schedule** Schedule for degree of window opening. 0 = fully closed, 1 = fully open. Schedule smoothing applied by default.

**Frame properties**
- **Fraction of the total window area** The unglazed area of the window divided by the whole window area, defined by the outer frame measures. (0-1)
- **U-value** Heat transfer coefficient for the unglazed part of the window, including interior and exterior film coefficients. (W/°C)
- **More...** Opens a dialog with detailed frame construction.

**Skew** [Deg]
Specifies the orientation of the glass surface relative to the wall surface in horizontal (Twist) and vertical (Tilt) direction. The values of Twist and Tilt are added to the azimuth and slope of the wall's external surface in order to get the azimuth and the slope of the external glass surface.

**Object:** Name and description

The form contains a box named Drawing view from the side, to describe the external shading. Double clicking on this opens a form, which is used for editing any shading objects outside the window. This form has two tabs; under the Control tab, the type of control can be specified (no control, wind and/or sun control). The form for a window can also be opened by clicking the right button over an object of the window type in the surface editor.

**7.4.15.3. Double-glass façade (Expert edition only)**
This form together with the parameters given in detailed window form specify a double-sheet construction with a ventilated cavity.
The glazing and other properties that are specified in the detailed window form apply to the glazing in the plane of the external wall (the innermost pane of the DoF.) This is valid also for specified Internal window shadings (i.e. any shade near the plane of the innermost pane including external blinds).
Shades within the double sheet air-space should normally not be specified external to the innermost pane but rather as being internal shades of the outermost pane.
If External window shading has been specified in the detailed window form, the shading elements are applied outside of the outermost pane of the double-sheet construction.
If an Opening schedule is specified, the innermost window will open towards the air space.
External window
Selection of the glazing and frame data for the outermost pane combination. Definitions of these inputs are the same as for a detailed window.

Shading.
Selection of shading properties of the outermost pane. Definitions of these inputs are also the same as for a detailed window.

Depth.
The distance between the outermost and innermost pane combinations of the air-space, i.e. the actual ventilated layer.

Air paths.
Four possible air paths are possible (in the order they appear in the form):

1. Grille at the floor level of the air space, connecting the air space with ambient air.

2. Ditto at the ceiling level. These openings are permanently open when the double sheet façade is specified at the standard level. No connections to neighboring air spaces are automatically defined.

3. A leakage between the room and the air space at a given height. This leak is defined in addition to the default external leak of the zone (specified in the zone form). The default leak of the zone is still interpreted as a direct air path between the zone and ambient, i.e. passing “untouched” by the double-sheet façade.

4. A given CAV flow from the air space to the return air duct. This flow will be controlled by the AHU fan schedule in the same way as the CAV ventilation of a zone, i.e. with possibilities of forcing, reduced speed etc.

The three first air paths are defined in terms of Equivalent leakage area as interpreted by default in IDA ICE, i.e. at a discharge coefficient, Cd = 1 and with flow depending on pressure difference to the power 0.5.
7.4.15.4. Form for Skylight

The skylight is a roof lantern. It can be used to study solar radiation and climate effects for different forms of glazed openings in roofs, e.g. glazed saddle roofs. The skylight object is shaped as a pyramid with rectangular base and with the top removed by a horizontal cut. Thus, it has five sides, which can be glazed to different extents. A detailed ray tracing calculation is performed, and e.g. direct light entering through one surface and leaving through another is handled correctly. Light reaching the base of the pyramid is transmitted to the zone as diffuse light. Each skylight object inserted in a zone (see Insert object) is edited in this form.

Field description, etc:

**Geometry:**
- **X** Coordinate of the lower left corner, can be entered in Applet (m)
- **Y** Coordinate of the lower left corner, can be entered in Applet (m)
- **DX** Extension of base rectangle in x-direction (m)
- **DY** Extension of base rectangle in y-direction (m)
- **DZ** The height of the skylight above the roof (m)
L1, ... L4 Distance in the roof plane between the borders of the base and top rectangles; four values for the four sides of the rectangle, numbered by the closest zone Walls 1-4 (m)

Construction:
Glass area: Wall 1 ... 4 Glazed areas on side towards Wall 1… 4 [m²]
Glass area: Roof Glazed area in top surface of pyramid [m²]
Walls Construction selected for unglazed parts of all five sides [Data base selection of wall construction]
Glazing Selection of glazing construction, optical and thermal properties [Data base selection of glazing construction]

In the zone model, the skylight has the thermal properties of a wall subsurface. The temperature of this surface is set to a weighted average of the temperatures of the glazed and unglazed parts of the five surfaces of the skylight. This model should rather well represent the long-wave and convective properties of a heated skylight. Downdraughts from cold vertical surfaces in the skylight will not be as well reproduced.

7.4.15.5. Form for opening (door)

![Door: an opening in building:3.Reception.Wall 4](image)

NB! Doors can only be opened in the Expert edition of IDA ICE. However, also Standard edition users should add internal doors in relevant places, since they provide a leakage path between zones also when closed. They may also have a different construction.

Field description, etc:
Construction Choice of door construction.
Two special values:
[use wall construction] means that wall has the same construction as the surrounding wall.

**Opening without door.** In this case all other parameters are irrelevant

**Opening schedule** Schedule for degree of window opening. 0 = fully closed, 1 = fully open.

**Leak area** ELA Equivalent leakage area when the door is closed, defined at 4 Pa, Cd=1 and, at the door vertical midpoint.

**Inner surface** Optical properties of the inner surface

**Outer surface** Optical properties of the outer surface (relevant for inner doors only)

**Object:** Name and description

An opening between two zones (or in an external wall) gives rise to a (sometimes bi-directional) air flow, that will reduce the differences in temperature, humidity and carbon dioxide content between the air masses. The radiation through the opening is also considered.

The opening is defined by inserting an opening component in a wall. For internal walls, this is only done in one of the zones. The other zone then displays a gray surface on its corresponding section of wall.

The form for an opening is opened by double clicking on an object of the Opening (door) type in the Surface editor (The surface editor is reached by double clicking in the drawing box in the form for wall, floor and ceiling, ceiling or floor that contains the opening).

### 7.4.15.6. Opening Control Macro

**Opening Control macro** is used to describe a custom opening control strategy for windows. See Custom control for general information about control macros.

The output signal should be connected to the pre-defined Opening interface reference on the border of the macro. An output signal=1, means the window is fully open, 0 means fully closed.

The window opening schedule may be used only inside the control macro (it is NOT combined with the output signal).

### 7.4.15.7. Integrated Shading Control Macro

An integrated shading control macro is used to describe a custom control strategy for integrated shading devices in windows. See Custom control for general information about control macros.

The output signal should be connected to the pre-defined Shading interface reference on the border of the macro (from 0 to 1, 1=fully shaded). For Venetian blinds (for detailed window models only), the controller may provide an additional output connected to the SlatAngle (in degrees [°]) interface reference on the border of the macro. The angle is zero when the slats are horizontal and positive when the upper sides of slats are facing outside.

The control macro has a parameter, Light Control. If the value of this parameter is True, the control algorithm is combined with standard light control, as described in documentation for the window and detailed window.

The window shading schedule may be used only inside the control macro (it is NOT combined with the output signal).
7.4.15.8. Dialog for Glass construction

The Glass construction dialog is used to describe optical and thermal properties of the window glazing for the standard (simplified) window model.

Field descriptions, etc:
**Name** Choice of Glass construction object. The rest of the dialog shows the details of the selected object.

**Shading coefficients: Absolute value** Select to specify window data without reference glazing

**Shading coefficients: Single pane reference** Select to specify data with single glass reference

**Shading coefficients: Double pane reference** Select to specify data with double pane reference

**Shading coefficients: g, Solar Heat Gain Coefficient (SHGC)** Displayed when Absolute value has been selected above. Fraction of the radiation, incident on the window, that heats the room. SHGC includes both the radiation that passes through the window directly and the radiation that is first absorbed in the panes and thereafter reaches the zone as convection and long-wave radiation.

SHGC is short for Solar Heat Gain Coefficient and is sometimes also called: TST, total transmission, SF, etc.

**Shading coefficients: T, Solar transmittance** Displayed when absolute value has been selected above. Fraction of incident radiation that passes the glazing as direct radiation, NB! It must always be smaller than g.

T is sometimes also called Tsol, ST, DET, etc.

**See below for parameters for single and double pane reference**

**Glazing U-value** Heat transfer coefficient for the glazing (without frame), including internal and external film coefficients (W/m² °C) The window models calculate actual internal and external (wind dependent) film coefficients. From the given U-value the program subtracts
0.17 (m² K)/W and the remaining U-value is considered to equal the heat transfer coefficient of the glass.

**Internal emissivity** Innermost glass emissivity (inwards) for longwave radiation.

**External emissivity** Outermost glass emissivity (outwards) for longwave radiation. Has, in normal cases, limited influence on the result.

The total entering heat in the case when the window is perpendicular to the entering radiation is given by the following expression:

\[ P_{\text{total}} = g \times A \times I_{\text{shortwave}} \]

where \( A \) [m²] is glass surface area and \( I_{\text{shortwave}} \) [W/m²] is the total incoming radiation.

This calculation takes into consideration both the direct and the diffuse radiation on the facade. The model will also compensate for different incidence angles using a predefined curve, see the NMF code at the advanced level for details.

The \( T \) and \( T_{vis} \) parameters, determine the degree at which solar radiation passes through the window without first being absorbed:

\[ P_{\text{shortwave}} = T \times A \times I_{\text{shortwave}} \]
\[ P_{\text{visual shortwave}} = T_{vis} \times A \times I_{\text{visual shortwave}} \]

\( P_{\text{total}} - P_{\text{shortwave}} \) determines the part of the radiation that reaches the zone via absorption in the window.

See further information about solar radiation computation in the manual.

For combinations of glazing and integrated shadings, e.g., curtains or blinds, data is given for the integrated shading object that modifies the given parameters for the glazing. See Dialog for integrated shading.

**Parameters for single and double pane reference**

**Shading coefficients: F1, total shading coefficient** Displayed when Double pane reference has been selected above. Fraction incoming radiation (in relation to a 2-pane window) that heats the zone. F1 includes both the radiation that passes through the window directly and the radiation that is first absorbed in the panes and thereafter reaches the zone as convection and long-wave radiation.

**Shading coefficients: F2, shortwave shading coefficient** Displayed when Double pane reference has been selected above. Fraction of incoming radiation (in relation to a 2-pane window) which passes through the pane. This is radiation that passes the window in the form of shortwave radiation.

**Shading coefficients: Sc, total shading coefficient** Displayed when single pane reference has been selected above.

**Shading coefficients: Ssc, shortwave shading coefficient** Displayed when single pane reference has been selected above.

The dialog for a glass constructions is opened from the Right button menu with the cursor over an object of the Glass construction type (e.g. 3-glass, clear, 4-12-4-12-4) in the Glazing field in the form for a window or in the form for IDA-resources.
This dialog is used for giving parameters belonging to the objects of the integrated shading type, for example, a curtain or blind. The multipliers modify the corresponding parameters for the window when the shading is "on". This object is only used for the standard window model; integrated shading is handled differently in the detailed window model.

Field descriptions, etc:

**Integrated shading** Choice of integrated shading object. The rest of dialog displays the details of the shading object

**Multiplier for g**, Solar Gain Factor

**Multiplier for T**, Solar transmittance

**Multiplier for U-value**

**Object**: Name and description

Integrated shading (blinds, curtains, etc.) concerns all types of shading in the window’s plane, even external blinds. (External shading concerns permanent shading objects, on the facade, near the window, e.g. side fins etc.).

Three parameters are given for integrated shading. These provide multipliers, which indicate the effects of the shading in combination with the glazing. See Dialog for glass construction for definitions of SHGC, T and U for the glazing.

When the inner shading is on (drawn) the effective parameters become

\[
g_{\text{effective}} = g \times \text{multiplier for } g \\
T_{\text{effective}} = T \times \text{multiplier for } T \\
U_{\text{effective}} = U \times \text{multiplier for } U
\]
The dialog for an integrated shading is opened from the Right button menu with the cursor over an object of the integrated shading type (e.g. Light dense curtain between the panes) in the Integrated shading field in the form for one window or in the form for IDA-resources.

## 7.4.15.10. Editing an external shading

This form is used to edit an object of the External shading type. The window and the external wall are shown in a side view. External shading is a combination of the shading elements Balcony with sides, Simple screen, Side fins and Marquee with sides. The window’s external recess depth is also included in its external shading.

The Shading editor form is opened by double clicking on the Drawing view from the side to describe external shading button, in the window form. A new shading object is inserted by dragging from palette or by selecting New object… in the Insert menu with the Shading editor being the active window. In the Insert object dialog then opened there are four alternatives: Simple screen
Side fins
Marquee with sides

When the selection is made the editor is redisplayed. Place the cursor beside the wall to the right of the window, hold down the left button and drag the shading to the desired size. For the Simple screen alternative, draw a polyline by clicking a start point, break points, and end point in the form. End by clicking once with the Right button and selecting OK. The small
number field is for the width of the shading (for side fins, the distance between them), i.e. the extension perpendicular to the editor plane. Repeat this procedure to insert further shading objects.

The shading elements may be moved using Shift dialog;

The window’s position in the wall, the so-called recess depth, is changed by dragging the window line to the desired position. The cursor changes appearance when it is placed over the window line.

The faint horizontal line in the wall over the window indicates ceiling height in the zone where the window is located.

In the Shading editor there is a tab Control. Via this, one can specify limits when Marquees (awnings) and/or Simple screens should be withdrawn due to strong wind or low solar radiation.

### 7.4.15.11. Form for marquee, side fins and screens

This form describes one of the objects Balcony with sides, Simple screen, Side fins and Marquee with sides.

**Field description:**

**Width** The extension of the shading device perpendicular to the editor plane (m)

**Shading type** Fixed or controllable device; select parameters for all controllable devices under the tab Control.

**Vertices** (m)

The form for a shading object is opened from the Right button menu with the cursor over an object of this type (e.g., Balcony with sides) in the Shading editor.

Shading objects cannot be changed to independent IDA-resources, but will be saved, as resources or data base objects, combined with the window’s size and positioning in the wall (see Edit an external shading).
7.4.15.12. Shading control

No control
   No automatic control

Wind
   The shading is withdrawn at high local wind speed

Radiation
   The shading is drawn (extended) at high solar radiation

Radiation and wind
   Control by wind and sun; wind has priority

Wind speed, above which shading is withdrawn
   If the wind speed for this facade exceeds this level, the shades are withdrawn.

Radiation, incident on window, above which shading is used
   If the radiation in the plane of the window, with shades withdrawn, exceeds this level, the shades are extended.

The form also contains the list of shading elements. In this list the user may select (by marking the check box) which elements are controlled by the shading control. It is also possible to modify the width of elements and to remove elements.
7.4.15.13. Detailed Glazing System (Expert edition only)

The **Detailed Glazing System** dialog is used to describe optical and thermal properties of the window glazing for the detailed window model. The dialog shows the list of layers (panes, shading devices, and gaps), the parameters of the currently selected layer and the buttons used to add, remove, and reorder the layers. A detailed glazing system should consist of one or more glass panes, optional shading layers, and cavity layers between pane/shading layers. Two types of shadings are currently supported: plain shading and Venetian blind.

**Layer parameters:**
- **Pane layer**
  - **Pane** A reference to a pane description. The button with the right arrow gives a menu of possible operations: Open the Pane dialog; create a new pane description; load a pane from database; save the pane to database.

- **Cavity layer**
  - **Material** A reference to a gas description. The button with the right arrow gives a menu of possible operations: Open the Gas dialog; create a new gas description; load a gas from database; save the gas to database.
  - **Thickness** The thickness of the cavity
Material

A reference to a shade material description. The button with the right arrow gives a menu of possible operations: Open the Shade material dialog; create a new shade material description; load a shade material from database; save the shade material to database.

Venetian blind layer

Device

A reference to a Venetian blind description. The button with the right arrow gives a menu of possible operations: Open the Venetian blind dialog; create a new Venetian blind description; load a Venetian blind type from database; save a Venetian blind to database.

7.4.15.14. Glass pane

The Glass pane dialog is used to describe the properties of a glass pane (for use in a Detailed Glazing System for the Detailed window model).

Glass panes are resource objects, i.e. the same pane object may be referenced from multiple glazing systems (or multiple layers of the same glazing system).

Pane parameters:

Glass pane Choice of Glass pane object. The rest of the dialog shows the details of the selected object.
The optical parameters are grouped in three columns: transmittance (same for both directions), and two columns for reflectance, from the front side and from the back side.
Total shortwave
The coefficients of transmittance and reflectance represent average values over the full solar wavelength spectrum. The coefficients should be valid for radiation that is perpendicular to the pane. Coefficients for other incidence angles and for diffuse radiation are calculated by the model.

**Visible**
Ditto for the visible range.

**Diffusion**
The coefficients of diffusion (dissipance), i.e., the fraction or the transmitted/reflected direct radiation that becomes diffuse after transmission or reflection. These coefficients do not depend on the incidence angle.

NB! Diffusion coefficients are not stored in the database.

**Thermal and other properties**

**Longwave**
The table contains emissivity and transmittance. The transmittance is not stored in the database.

**Thickness [mm]**
**Thermal conductivity [W/(K.m)]**

### 7.4.15.15. Venetian blind
The **Venetian blind** dialog is used to describe the properties of a Venetian blind (for using as shading layer in Detailed Glazing System for detailed window model). The Venetian blinds are resource objects; that means that the same Venetian blind description may be referenced from multiple glazing systems.
7.4.15.16. Shade material

The Shade material dialog is used to describe the properties of the material used in Shading layers and in Venetian blinds in a Detailed Glazing System for the Detailed window model. Shade materials are resource objects, i.e. Shading layers and Venetian blinds in multiple glazing systems may reference the same Shade material description.

Shade material parameters:

Shade materials Choice of Shade material object. The rest of the dialog shows the details of the selected object.

The optical parameters are grouped in three columns: transmittance (same for both directions), and two columns for reflectance, from the front side and from the back side.

Total shortwave
The coefficients for transmittance and reflectance represent average values over the full solar wavelength spectrum. The coefficients are applied both to direct and diffuse radiation and do not depend on incidence angles. The transmitted/reflected radiation is assumed to become fully diffuse.

Visible
Ditto for the visible range.

Thermal and other properties

Longwave
The table contains emissivity and transmittance.

Thickness [mm]
Thermal conductivity [W/(K.m)]
7.4.15.17. Gas properties

The Gas properties dialog is used to describe the properties of a cavity (for use in a Detailed Glazing System for the Detailed window model). Gases are resource objects, i.e. the same gas may be referenced from multiple glazing systems (or from multiple cavities of the same glazing system).

7.4.16. Heating, cooling, ventilation

7.4.16.1. Zone equipment for cooling and heating

Local heating or cooling is supplied in the zone by defining room units either directly in the zone (ideal heater and cooler, fan coil, local AHU) or on the walls, in the ceiling, or on the floor. There is general equipment for waterborne cooling (for both radiative and convective equipment), a water radiator (or convector), floor heating, and an electric radiator. The Expert edition supports also heated and cooled floor/ceiling.

See further the IDA ICE Manual.

7.4.16.2. Ideal cooler

The ideal cooler is a room unit that cools the zone when no detailed information about an actual room unit, such as a fan coil or active chilled beam, is available or this amount of detail is unmotivated. It has no given physical location on any room surface and is not connected to the plant of the building. Physically, think of it as a standalone air conditioner with fixed performance parameters.

An ideal cooler is inserted by default when a new zone is created (unless it has been removed from the zone template). The default capacity of the ideal cooler is given per m² floor area in the zone template and should normally be selected to be large enough to safely be able to cool the zone under all conditions. A PI controller will then be used to keep the room air (or operative) temperature at the cooling setpoint (as specified in the Setpoint collection.)

In order to study the performance of a specific type of room unit, or a room unit which is hydronically connected to the plant, remove the ideal room unit from the zone form, and insert instead a physical room unit to a zone surface or, alternatively, drag in a fan coil or similar device from the palette to the zone form.

7.4.16.3. Ideal heater

The ideal heater is a room unit that heats the zone when no detailed information about an actual room unit, such as a radiator or convector, is available or this amount of detail is unmotivated. It has no given physical location on any room surface and is not connected to the plant of the building. Physically, think of it as a standalone fuel or electric heater with fixed performance parameters and no flue gas emissions.

An ideal heater is inserted by default when a new zone is created (unless it has been removed from the zone template). The default capacity of the ideal heater is given per m² floor area in the zone template and should normally be selected to be large enough to safely be able to heat
the zone under all conditions. A PI controller will then be used to keep the room air (or operative) temperature at the heating setpoint (as specified in the Setpoint collection.)

In order to study the performance of a specific type of room unit, or a room unit which is hydronically connected to the plant, remove the ideal room unit from the zone form, and insert instead a physical room unit to a zone surface or, alternatively, drag in a fan coil or similar device from the palette to the zone form.

7.4.16.4. Fan coil
A fan coil takes a stream of air from a zone, conditions it, and then returns it to the same zone. The heat from the coil is recorded under room units in the zone Energy report. If the physical unit also exchanges air (or heat) directly with outdoor conditions, it should be modeled as a local air handling unit.

ICE provides three models of fan coils: VAV heating fan coil, VAV cooling fan coil, and air-to-air conditioner. There are also available an “undefined” fan coil that may be used (in the Expert edition only) to build a custom model out of available components.

7.4.16.5. Local AHU
A local air handling unit works in just the same way as a central air handling unit, except it serves only a single zone and can only be reached from that zone. The heat and air from the unit in the zone is recorded as coming from mechanical ventilation. A local air handling unit is introduced in a zone by following the More… link in the Ventilation section of the zone form. Then press Add AHU, and select among available local air handling units. Local AHUs may only operate in CAV, with flows given in the table.
7.4.16.6. Active Beam

Use manufacturer's data Automatically selected when product data has been imported from manufacturer’s database
Simplified model Select in order to give parameters manually
Power at design air flow, Cooling Waterborne cooling power at design air flow and given temperatures (°C)
Power at design air flow, Heating Waterborne heating power at design air flow and given temperatures (°C)
Power at zero air flow, Cooling Waterborne cooling power at zero air flow and given temperatures (°C)
Power at zero air flow, Heating Waterborne heating power at zero air flow and given temperatures (°C)
Design air flow Air flow through device at design conditions (l/s)
Design conditions
dT(coolant - zone air) at max power, Cooling Average temperature difference between coolant and room air at design power (°C)
dT(coolant - zone air) at max power, Heating Average temperature difference between hot water and room air at design conditions (°C)
dT(coolant) at max power, Cooling Temperature rise of coolant at design power (°C)
dT(coolant) at max power, Heating Temperature drop of hot water at design power (°C)
Controller Method of control of device output. Choose between built-in (proportional and PI) and user-defined controllers. The temperature setpoint is fetched from Controller setpoints.
Sensor Choice of the target of the control (air temperature or operative temperature)
Active beams are air supply terminals combined with coils for cooling and sometimes also for heating. In addition to providing natural convection, which is active also without any
mechanical supply air, the heat transfer is significantly improved by forced convection via the supply air stream. The radiation component from active beams is normally quite small and it is neglected by the model, hence the actual position in the ceiling of the beam has no impact on calculation results. Read more about active beams in the manual.

7.4.16.7. Floor Heating

Field descriptions, etc:
**Floor heat (temperature control)**
- **Design power output** Power output at design conditions. (W/m²)
- **Maximum temperature into coil** Highest permitted temp sent into floor. (°C)
- **Temperature drop across coil** Temperature drop at design conditions. (°C)
- **Controller** Method of control of device output. The temperature setpoint is fetched from Controller setpoints.
Sensor Choice of the target of the control (air temperature, operative temperature, surface temperature)

Location in floor slab
- Depth under floor surface Depth of the water circuit plane below floor surface; check with floor construction

Heat transfer coefficient
- H-water-pipe-fin For aluminium fins in a wood joist construction, 6 is a reasonable value; 30 for tubes in concrete. The total heat resistance is normally dominated by the resistance in the floor slab, and thus this parameter is not very critical.

Read about the model for floor heating in Chapter 6 in the manual.

See also Room units for cooling and heating.

7.4.16.8. Electric Floor Heat (Expert Edition only)
<not written yet>

7.4.16.9. Heating/Cooling Floor (Expert Edition only)
See manual for documentation.

7.4.16.10. Heating/Cooling Panel (Expert edition only)
See manual for documentation.

7.4.16.11. Edit Cooling devices
A form for editing an object of the Cooling devices type is displayed by double clicking on a cooling device in the Drawing for describing an object on the surface, the so-called surface editor (Surface editor is displayed by double clicking in the drawing box in the form for the ceiling on which the cooling device is located). The figure also has a dialog for alternative input opened from the form.

Cooling devices operates completely analogous with heating device, with the exception of a few differences in input, which are described here.

Field descriptions, etc:

**Massflow at full power** Water flow through the equipment at design conditions. (kg/s)

**K-value** Removed heat per unit of equipment length and degree (raised to N). (W/m*°C^N)

**N-value** Exponent in the expression for removed heat. (-)

**Module width** Width of an equipment module for which given K and N are valid. (m)

**Heat transfer coefficient to the room surface behind** U-value for the insulation between the equipment and the wall/ceiling. (W/m²*°C)

**Longwave emissivity** The longwave emissivity of the front surface of the cooling device. If not given, the emissivity of the wall surface is used instead.

**Controller** Method of control of device output. Choose between built-in (proportional and PI) and user-defined controllers. The temperature setpoint is fetched from Controller setpoints.

**Sensor** Choice of the target of the control (air temperature or operative temperature)

**Maximum power, P1** Removed heat at full capacity. (W)

**dT(coolant-air) at max. power, dT1** Mean temperature difference between the air and the coolant at full capacity, P1. (°C)

**dT(coolant) at max. power, dTliq** Temperature increase of water at full capacity. (°C)

**Lower power, P2** Removed heat at any partial load, e.g., half capacity. (W)

**dT(coolant-air) at lower power, dT2** Mean temperature difference between the air and the coolant at the partial load, P2. (°C)

The form for a cooling device can also be opened from the Right button menu with the cursor over an object of the Cooling device type (e.g. Cooling device 1) in the form for surface editor or, for a resource (different form, includes alternative input, in the form for IDA-resources.

Here, the height of a radiator corresponds instead to a Module width, to which K and N refer. Just as for the radiator, the total length is calculated as the given box’s area divided with Module width. There is a difference in that the heat transfer coefficient between the back of the equipment, and the surface behind (often the ceiling) is given directly in the main form. If an (arbitrary) negative figure is entered, the heat transfer coefficient is calculated in the same way as for the heating devices, i.e., as if all heat transfer was done by radiation. This is a good approximation for a device that has no insulation at all.

The dialog for alternative input has somewhat different parameters for cooling units. Absorbed power and temperature differences between air and water are given for two points on the power curve. For max power, the temperature drop of the water is also given. To accurately model zone thermal conditions, the surface areas of heating and cooling devices must be realistic in relation to emitted power.

See also Room units for Cooling and Heating.

7.4.16.12. Edit waterborne heating devices
Heat emission from waterborne heating devices is calculated using

\[ P = K \cdot l \cdot dT^N \]

where \( l \) is equipment length and \( dT \) is the temperature difference between the water and the zone air. \( K \) and \( N \) are constants characterizing a piece of equipment of a certain height. In the case of a radiator, \( N \) is often set at 1.28, which is why \( K \) gets the unit \( \text{W/(m}^2\text{C}^{1.28}) \). The logarithmic mean temperature difference is used to calculate \( dT \).

The values of \( K, N \), and the height of equipment of different makes are stored in the database. A database object should be defined for every principal configuration and occurring height, but the length of the equipment is first defined when it is inserted in the model.

A form to edit an object of the Heating device type is displayed by double clicking on a heating device in the Drawing for describing objects on the surface, the so-called surface editor. (Surface editor is displayed by double clicking in the drawing box in the form for wall, floor and ceiling on which the heating device is located) In the figure, a dialog for alternative input has also been opened from the form.
Field descriptions, etc:

**Massflow at full power** Water flow through equipment at design conditions. (kg/s)

**K-value** Emitted power per unit of equipment length and degree-C (raised to N). \(W/(m*°C^{1.28})\)

**N-value** Exponent in the expression for emitted power. Frequently set to 1.28 for ordinary radiators. (-)

**Height** Equipment height at which given K and N are valid. (m)

**Longwave emissivity** The longwave emissivity of the front surface of the cooling device. If not given, the emissivity of the wall surface is used instead.

**Controller** Method of control of heater output. Choose between built-in (proportional and PI) and user-defined controllers. The temperature setpoint is fetched from Controller setpoints.

**Sensor** Choice of the target of the control (air temperature or operative temperature)

**Maximum power, Pmax** Emitted power at full capacity. (W)

**Air temperature at maximum power, Tair** Room temperature at the measuring point at full capacity. (°C)

**Supply temp. at maximum power, TliqIn** Incoming water temperature at full capacity. (°C)

**Return temperature at max. power, TliqOut** Outgoing water temperature at full capacity. (°C)

**N-value, exponent of power curve, N** See the base form for explanation of N-value. (-)

The form for heating device can also be opened from the Right button menu with the cursor over an object of the Heating device type (e.g. Water radiator 1) in the form for surface editor or, for a resource (different form, includes alternative input), in the form for IDA-resources.

Read about the radiator in Chapter 6 in the manual.

A detailed modeling of the room climate, especially operative temperatures, requires a reasonable agreement between heater or cooler surface size and specified power output.

See also Room units for cooling and heating.

### 7.4.16.13. Electric radiator

![Electric Radiator](image.png)

**Rated power** Maximum output (and input) power [W].

**Distance between radiator and wall** Gap behind radiator (m).

**Longwave emissivity** The longwave emissivity of the front surface of the cooling device. If not given, the emissivity of the wall surface is used instead.
Controller Method of control of heater output. Choose between built-in (proportional, PI, thermostat) and user-defined controllers. The temperature setpoint is fetched from Controller setpoints.

Sensor Choice of the target of the control (air temperature or operative temperature)

Energy meter Choice of Energy meter that reports the energy consumption of radiator

### 7.4.16.14. Heating/Cooling Control Macro

An **HC Control macro** is used to describe a custom control strategy for heating, cooling, and combined heating/cooling devices.

See Custom control for general information about control macros.

The output signals should be connected to the pre-defined interfaces references heatCtrlOut and coolCtrlOut on the border of the macro. An output signal=1 means the design power, 0 means zero power.

Only the required output signals should be connected (i.e., no need to connect the heating signal if the macro will control only the cooling devices)

### 7.4.16.15. Chimney

![Chimney Interface](image)

**Field description, etc:**

- **Inlet loss coeff.** Total pressure loss in the inlet air terminal [-]
- **Outlet loss coeff.** Total pressure loss in the outlet air terminal [-]
- **Diameter** Hydraulic diameter (m)
- **Total rise from inlet to outlet** Height difference between inlet and outlet (governs the stack effect) (m)
- **Total duct length** Total hydraulic length for the duct (provides flow resistance in addition to loss coeff.) (m)
- **Object** Name and description

The chimney can be inserted in ceiling or wall to describe a natural ventilation system. The model can calculate flow in both directions, i.e. if the zone pressure is low enough, air will enter the zone through the chimney. The rise of the duct and the vertical position of the input will determine the stack effects.
7.5. **IDA Resources and Database**

7.5.1. **Database objects in IDA Indoor Climate and Energy**

The following types of database objects, which can be found in the IDA database, are used in IDA Indoor Climate and Energy:

- Wall definition
- Material
- Glazing System (detailed)
- Glass pane
- Shading material
- Venetian blind
- Gas properties
- Glass definition (simplified)
- Integrated shading
- Location
- Wind profile
- Schedule
- Profile
- External shading
- Climate data
- Occupant load
- Equipment load
- Lights
- Controller setpoints
- Surface
- Cooling device
- Heating device
- Window
- Energy price
- Settings for new zones

7.5.2. **Dialog for Schedule**

Schedules are used to define how something varies with time. Examples of this are the presence of occupants or operation time of fans.

The dialog for editing the schedule has two appearances, one simple and one advanced, which correspond to a simple and an advanced definition of a specific schedule. The program automatically controls which one of these is displayed, depending on the character of the schedule. A simple schedule can always be changed to an advanced schedule (by clicking on the Advanced key… in the simple schedule).

*Simple schedule dialog*

The simple schedule dialog graphically shows the profiles for workdays and weekends. They are edited by drawing horizontal segments. More complex schedules, for example taking account of holidays, are edited in the advanced dialog.
Field descriptions, etc:

**Name** Choice of Schedule object. The rest of the dialog shows the details of the selected schedule.

**Monday-Friday** The profile for workdays.

**Saturday** The profile for Saturday

**Same as Mon-Fri** Checked if no special schedule should be applied for Saturday

**Sunday and Holidays** The profile for Sunday and holidays

**Same as Saturday** Checked if no special schedule should be applied for Sundays and holidays

**Advanced** Show the schedule in Advanced dialog

*Advanced schedule dialog*

If the simple definition is not enough to define the variation with time, an advanced definition can be given. A schedule has a name, a description and a number of rules. One of these is always in effect. The schedule value at any given point in time is the value of the rule in effect at that time.
Field descriptions, etc:

**Name** Choice of Schedule object. The rest of the dialog shows the details of the selected schedule.

**Description** Object description.

**Rules** The list of schedule rules.

**Add** Add a new rule to the Schedule.

**Delete** Delete the selected rule from the Schedule.

**Promote** Promote the selected rule in the Schedule.

**Demote** Demote the selected rule in the Schedule.

**Daily schedule:** Graphically show the daily profile of the selected rule. If the profile is simple enough, it may be edited directly by drawing its horizontal segments by the mouse cursor.

**Daily schedule: Diagram settings** Click this button to change the appearance of the profile diagram

**Daily schedule: Edit profile** Click this button for more editing options

**Valid days:** Select the weekday or/and holidays for selected rule

**Valid days: Start date**

**Valid days: End date**

**Calendar:** Click these buttons to select date from calendar

**Rule description** Additional annotation to the selected rule.
Schedule description

Object description.

Simple: Switch to the Simple schedule dialog

In the Rules list box, new rules can be added with the Add button, and existing rules deleted with the Delete button. The rule furthest up applies in the first hand, and the one furthest down applies last. The rule selected in the list box can be moved up and down with the Move up and Move down buttons, respectively.

The last rule in the list has a special meaning; it is the default rule. The rule output can be changed, but not its time of validity. The default rule is always valid (the Valid days box is inactive when this rule is selected), and the rule also always remains as the last rule. This guarantees that the schedule’s value is always defined.

The Validity time for the selected rule is shown under the profile diagram. In the Start date and End date fields the validity time for the rule can be limited to a portion of the year. If no start date is indicated the rule applies from the beginning of the year. If no end date is indicated the rule applies until the end of the year. The Calendar button is used to open the Calendar dialog, which aids selection of an existing date. In the Valid days box, the rule can be limited to apply only to certain days of the week (by crossing those days the rule is applicable).

When a new schedule has been defined it is useful to test that it actually delivers the intended values. This can be done by right clicking the field where the schedule is selected and choosing Open with Diagram. This will “play” the schedule for the time period selected in Time slice on the Options menu.

7.5.3. Editing a Profile
Objects of the Profile type are used to define how a value varies during the day. Examples of these are the presence of people or operation time of fans. A profile has a name, a description and a number of diagram points with time and value. A profile can be edited by indicating time and value points in text form (Data tab, figure above), or by drawing a diagram (Diagram tab, figure below).

By default the profiles are unnamed and stored as parts of Schedule objects. To create a named profile, select `Save as…` and give a name to a profile. To copy a named profile to an unnamed one, select `Save as…`, remove the profile name and click OK in "Save as…” dialog.

**Field descriptions, etc:**
- **Points**
- **Add**
- **Delete**
- **Selected point: Hour** Hour.
- **Selected point: Minute** Minute.
- **Selected point: Value** Value.

The Dialog box for a profile is opened from the advanced schedule dialog. In the Points list box, time and value points can be added with the Add button. The Delete button is used to delete a selected point. The times 0:00 and 24:00 can never be deleted. The data values for the selected point can be changed in the Selected point box. Note that the point’s value in the list box is not changed until the cursor is moved from the field that has been changed. (Hour, Minute or Value). When times are changed or added, the points are automatically rearranged into time order in the list box.

To edit the profile in diagram form instead, select the Diagram Tab.
Field descriptions, etc.:  
**Edit**  
**Properties**

Click on the Edit button and the profile breakpoints are marked with small squares in the figure. These can be moved with the mouse. However, the breakpoints can never be moved in such a way that the profile no longer is a pure function of time. When editing is complete, click on the Done button. To cancel editing and return to the original state, click instead on the Abort button. The Properties button is used to change the properties of the diagram, the scale of the axes among other things.

### 7.6. Mathematical Model

#### 7.6.1. Schema for zone (advanced level)

See the IDA ICE manual.

#### 7.6.2. Custom control

In ICE Expert edition, the users may implement custom control strategies for different devices in the building.

The following **control macros** are currently supported:

<table>
<thead>
<tr>
<th>Control macro</th>
<th>Available in</th>
<th>Field label</th>
</tr>
</thead>
<tbody>
<tr>
<td>Supervisory control macro (for whole building)</td>
<td>Building, general view</td>
<td>Supervisory control</td>
</tr>
<tr>
<td>Central zone control (for multiple devices in one or more zones)</td>
<td>Zone, advanced view</td>
<td>Zone controller</td>
</tr>
</tbody>
</table>
Device controls for a single unit:

<table>
<thead>
<tr>
<th>Heating and cooling</th>
<th>Controller</th>
</tr>
</thead>
<tbody>
<tr>
<td>Waterborne cooling, water radiator, electric radiator, heating/cooling panel, heating/cooling floor, electric heating floor, active beam, reheating coil</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Ventilation</th>
<th>Ventilation/System type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Zone, general view</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Opening</th>
<th>Opening/Control</th>
</tr>
</thead>
<tbody>
<tr>
<td>Window, detailed window</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Integrated shading</th>
<th>Shading/Draw control</th>
</tr>
</thead>
<tbody>
<tr>
<td>Window, detailed window, double glass facade</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Lighting</th>
<th>Control strategy</th>
</tr>
</thead>
<tbody>
<tr>
<td>Light</td>
<td></td>
</tr>
</tbody>
</table>

Note that control macros are shared (e.g., an opening control defined in one window is available in all windows (both simplified and detailed). They are included in the list of IDA Resources. Use this list to manage the custom controls (e.g., copy to other systems). A user-defined control macro is never simulated in its original form. Instead, a copy of this macro is created for every use and all these individual copies are simulated being connected to the appropriate signal sources and targets. Therefore the user-defined macro will never contain results of simulations (such as values of variables in models and time series in output files).

If an output file is inserted into a control macro (or into a sub-macro of a control macro), a copy of this output file will be created in every simulated instance of this control macro.

When running from standard level, these output files are copied the zone or to the building before the simulated instances of control macros are destroyed.

The control macros are designed to work in the standard level of building models. When switching to advanced level, the copies of the control macros are created and connected as before simulation. These copies are treated as ordinary macro objects in the advanced system.

**Operations available in the device form**

The following operations are supported by the controller field in the device form (see the table above for list of devices and controller fields):

<table>
<thead>
<tr>
<th>What to do</th>
<th>How to do</th>
</tr>
</thead>
<tbody>
<tr>
<td>To select a control strategy</td>
<td>Click the field and select the desired strategy from the list</td>
</tr>
<tr>
<td>To define a new control strategy</td>
<td>Click the field and select &quot;New control type&quot;. The new macro does not contain any control system. The user must build the control algorithm by inserting appropriate models and connecting them (see Editing custom controls below).</td>
</tr>
<tr>
<td>To open the currently selected control macro</td>
<td>Click the field label</td>
</tr>
<tr>
<td>To save the current control macro</td>
<td>Right click the field and select “Save to palette”</td>
</tr>
<tr>
<td>To load a saved control macro</td>
<td>Drag the control from palette to the view of the device</td>
</tr>
</tbody>
</table>
Editing custom controls

See Modeling in the documentation to IDA Modeler for general information about editing macro objects.

The rest of the topic describes how the control macros should be connected with other model.

Signal sources

The signals from the sources listed on the left may be used as input to the control algorithm. More sources may be added by dragging from palette page Links. The signal sources may be also inserted in sub-macros of control macros, in AHU and plant macros, fan coils and their sub-macros.

Here is the list of supported sources:

<table>
<thead>
<tr>
<th>Signal source</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>AHU</td>
<td>Properties of the supply and return air; control signals defined in the AHU macro (ventilation control, free cooling, free heating, night ventilation). Available only in zones connected with central AHU.</td>
</tr>
<tr>
<td>Ambient</td>
<td>Climate data, Sun position</td>
</tr>
<tr>
<td>Central zone control</td>
<td>The actuator signals defined in the central zone control. Available in device control macros. The users may add custom actuator signals.</td>
</tr>
<tr>
<td>Façade</td>
<td>Ambient data measured at the face. Only available for the opening and shading controls.</td>
</tr>
<tr>
<td>Functional mode</td>
<td>Custom signals from the central zone control to device control macros.</td>
</tr>
<tr>
<td>Plant</td>
<td>Properties of the supply and return water; control signals defined in the plant macro (free cooling, free heating).</td>
</tr>
<tr>
<td>Setpoints</td>
<td>The set points defined in the zone. Not available in the Supervisory control macro. If the set points are redefined in the central zone control, the device control macro will get the redefined setpoints.</td>
</tr>
<tr>
<td>Supervisor</td>
<td>The signals coming from the supervisor control macro. The users may define custom signals.</td>
</tr>
<tr>
<td>Zone</td>
<td>Various signals measured in the zone. Not available in the Supervisory control macro.</td>
</tr>
<tr>
<td>Zone sensor</td>
<td>Various signals from one or more zone</td>
</tr>
<tr>
<td>Controlled device</td>
<td>The signals measured in the controlled device are available on the left border of the macro.</td>
</tr>
</tbody>
</table>

Control targets

The output from control macros should be connected Control target object. The central zone macro may generate 3 types of control signals:

<table>
<thead>
<tr>
<th>Signal type</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Actuator signals</td>
<td>Directly control the devices in the zone</td>
</tr>
<tr>
<td>Setpoint signals</td>
<td>Override the zone setpoints</td>
</tr>
<tr>
<td>Functional mode</td>
<td>Send information to the device control macros</td>
</tr>
</tbody>
</table>

The supervisor macro may also send signals to zones, to air handling units, and to the plant. All Control target objects are available from the palette (page Links).

Connecting the output from controllers to devices

To connect a control macro with a device,
- In the control macro, connect the output of the control algorithm with the required interface of the actuator control target (e.g., to the heating interface). Some devices may require multiple signals (e.g., heating and cooling).

- Open the device and select the device control (or the control target of the central control) from the list of available controllers in the Controller field. The same list may be also available from the tables in the General view of the zone or the building. For ventilation control, the list is available in the field Ventilation/System type in the General view of the zone.

Connecting the output from controllers to other macros
The lower-lever control macros may get signals from the higher-level control macros. To establish such connection,

- In the higher-level control macro, insert (from the palette) an appropriate Control target object (if not inserted yet). Rename it if required.

- Connect all desired output signals to the appropriate interfaces in the Control target object.

- In the lower-level macro (or in a sub-macro of the lower-level control macro), insert a corresponding Signal source object (if not inserted yes). The new object will be created with the same name as the Control target above. You will be asked to choose a name if multiple compatible control targets exist.

Now the signals are available in the receiving control macro.
The control target and the control source both contain the same list of predefined interface (i.e., signal names). The user may also add custom interfaces (use the same name in the target and in the source; when the source object is created, it contains all user-defined signals defined in the target).

In the same way the control signals are sent to the plant, AHUs, and fan coils.

Signals from devices to controller macros
The device control macros have access to the following signals related to the controlled devices:

<table>
<thead>
<tr>
<th>Signal</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sensor</td>
<td>For heating and cooling devices – the temperature of the sensor selected for the device</td>
</tr>
<tr>
<td>temperature</td>
<td></td>
</tr>
<tr>
<td>Time schedule</td>
<td>For opening, shading, and lighting – the time schedule defined for this device</td>
</tr>
<tr>
<td>Radiation</td>
<td>For shading – the intensity of the solar radiation (including the diffuse one) calculated after all exterior shading [W/m²].</td>
</tr>
</tbody>
</table>

Advanced setpoints
The signals sent in the central zone control macro to the Setpoint target object override the signals defined by the Controller setpoints object. In this way the user may describe custom variable setpoints.

The Setpoint source object may be used in the device controllers and in the central zone controller.

- In the central zone controller it always references the signals coming from Controller setpoints object

- In the device controllers it references the setpoints that are eventually redefined in the
central zone controller.

**Access to parameters of the controlled device**

The control algorithm may depend on parameters defined for controlled devices. For example, the shading control may use the parameter “Level” defined in detailed window. Such dependence may be implemented using parameter mapping.

To map a parameter in a control macro to a parameter in the controlled device,

- Right click the parameter to be mapped and select Mapping and Edit link… from menu;
- Select <macro> in the left side of the mapping dialog
- Click the button Advanced
- In the Code dialog, type (? [:origin par_name] :mapped) and click OK.
- Click OK in mapping dialog.

Here `par_name` is the name of the parameter that is the source of the mapped value. The mapped value is not shown at the standard level, the text “<mapped>” is shown instead. This is because the control is not connected to the device. It is only at advanced level when the copies of the control macro will be really connected to devices (a separate copy for every device) end then the mapped parameters will get the actual values.

**Multiple control targets**

The central zone control may contain multiple Actuator and Functional mode control targets. The user may choose which one is used for every controlled device – either by selecting it in the **Controller** field or by inserting an appropriate control source object in the device control macro.

In the similar way, the supervisor controller may provide different control strategies to different zones and AHU’s.

Currently the central zone control cannot provide different setpoints to different devices. This may be modeled instead by combining central zone control with individual control macros for devices that require individual setpoints.

The output signal should be connected to the pre-defined OUTSIGNALLINK interface reference on the right border of the macro.
7.7. Results

7.7.1. Result – AHU (Air Handling Unit) temperatures

This diagram displays return air, supply air and outdoor air temperatures. The return air temperature is the mixed temperature where each zone’s air is multiplied by weights (number of zones of this type) given in the zone’s form. Air supply temperature gives the temperature, which reaches the zone’s air terminal after any increase in the fans and duct system. Note that the setpoint for the supply air temperature applies to the air temperature before this increase.
7.7.2. Result – Airflow through the Air Handling Unit

The flows accounted for are the combined flows for all zones served by the AHU. The flows in the zone are multiplied with weights (Number of zones of this type) which are indicated in each zone’s form. Flows are volumetric as measured at actual temperature conditions. They may therefore vary slightly with respect to zone setpoint flows, which are given as massflows, due to density variations.
7.7.3. Result – Primary system’s temperatures

The supply and return temperatures for the primary system are displayed. Return temperatures from local cooling and heating devices are weighed together with weights (Number of zones of this type) which are indicated in the zone’s form.
7.7.4. Result – Total heating and cooling

This diagram displays central and local heating and cooling power. For water based circuits, the power is calculated based on the mass flow and temperature changes (supply – return) in respective plant circuit. Thus, this heat is computed after generation losses (COP) have been accounted for but before any distribution and emission losses. Cooling power is accounted for as a positive quantity. The analogous results are presented for local ideal heaters and coolers, although these are not served by the plant.
7.7.5. Result – Main temperatures

This diagram shows the mean temperature for the zone’s air and operative temperatures for the locations of added occupant loads. When Climate model has been selected, the operative temperatures are shown for the position of every occupant load in the zone.

Occupant loads are inserted in the zone form and their position may be altered in the floor surface editor of the zone.
7.7.6. Result – Heat balance

This is the full latent (moist) and sensible (dry) heat balance of the zone. For a sensible only approximate heat balance, that may be easier to understand, log the details of the zone Energy report instead.

The control volume is the zone air wetted surface area, running on the zone side of any room units with an air gap behind. Contributions are divided into the following categories:

<table>
<thead>
<tr>
<th>category</th>
<th>comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>Heat from thermal bridges</td>
<td></td>
</tr>
<tr>
<td>Heat from walls and floors (structure)</td>
<td>In the account, the control volume is just underneath each surface. Accordingly, the measure represents conductive heat through the structure including both storage, net transmission and any internal heat sources such as floor heating. Heat stored in internal masses, e.g. furniture, is also accounted for here.</td>
</tr>
<tr>
<td>Heat from daylight</td>
<td>Heat from sunlight entering through windows or open doors, minus corresponding exiting shortwave radiation. Absorbed and then retransmitted solar radiation is not included here (see below).</td>
</tr>
<tr>
<td>Heat from equipment</td>
<td>Heat from appliances such as computers, printers etc. Emitted as convection or radiation according to user input.</td>
</tr>
</tbody>
</table>
Heat from heating and/or cooling room units

Heat from controlled room units such as chilled beams, radiators and ideal units. For hydronic devices, the split between convection and radiation is automatically calculated (see manual.) NB! Floor heating is not included here but is regarded as coming from floor and ceiling.

Heat from windows (including absorbed solar) and openings

Heat from window surfaces, including both conducted heat and retransmitted absorbed solar radiation. Longwave radiation through openings (open doors) is included here. Incoming solar radiation affects room conditions in two ways:

1. as directly transmitted (short wave) radiation, which is repeatedly reflected at room surfaces but is ultimately absorbed by these

2. as heat which is first absorbed in the window pane/blind and then reaches the room through convection and radiation.

The latter is accounted for here together with window transmission. The first is separately displayed (see below).

Heat from lighting

Electrical light power, emitted as convection or radiation according to user input.

Net losses

Net heat from distribution losses from pipes and ducts that are deposited in the zone. See Extra energy and losses

Heat from occupants (incl. latent)

Includes both sensible (dry) and latent (moist) heat emitted by the occupants. The moisture is ventilated away and will in this way be included in the air flow heat balance.

Heat from air flows

All air flows are accounted here, i.e. mechanical ventilation as well as infiltration and flows from other zones. For a detailed account of airborne heat flows, see also separate result object: Airborne heat flow into zone.
7.7.6.1.  

7.7.7. Result – Air temperature at floor and ceiling

When a gradient calculation in the zone has been selected (non-well mixed zone), all temperatures become dependent on the height from the floor. Examples of influences of this are:

- comfort around occupants
- air removed via return air or leaks
- convection at zone surfaces.

The result object is only available if Climate model has been selected in the zone’s form.
7.7.8. Result – Fanger’s comfort indices

PPD = Predicted Percentage of Dissatisfied
PMV = Predicted Mean Vote

These measures of comfort take into consideration temperature, radiation, moisture and draught as well as occupant clothing and level of activity. PPD varies between 0 and 100 and the ideal value is 5, i.e., at least five percent are always dissatisfied. If occupants in the zone think it is too warm or too cold, PMV varies between +3 (too warm) and -3 (too cold), and should preferably lie close to zero. NB! The measurement for PMV has been multiplied by 10 in the diagram.

The comfort measurement is calculated only for times when respective occupant loads are present.
For further information about the index see ASHRAE Fundamentals.
7.7.9. Result – Air quality

Air age. A measure of how long an average air molecule has spent in the building. If a zone is ventilated by outside air only and is in steady state, this number is $1/\text{air changes per hour}$. The age of air measure takes account also of air that has aged in neighboring zones.

CO2 content given in ppm (with respect to volume), but is scaled here with a factor of 0.01 to make the diagram more understandable. Normal limits during demand controlled ventilation are 1000-1200 ppm, but considerably higher values can occur without health risks.

Air humidity indicated in %, but has been scaled with a factor of 0.1 to make the diagram more understandable. Suitable limits vary greatly with the zone use.
7.7.10. Result – Daylight level

Shows lighting by default on a horizontal surface at the first occupant load. Only daylight, not electric lighting is accounted for. Average light levels in the zone can alternatively be measured if this is selected in System parameters.
7.7.11. Directed operative temperatures

The directed operative temperatures are calculated for the position of the first occupant load in each of the six main directions. The positions of occupant loads are displayed as chairs in the surface editor of the floor. The height coordinate can be given adjacent to the symbol.

The directed operative temperature is calculated as the average of the local air temperature and the mean radiant temperature from surfaces that are visible in the current direction.

The result object is only available if Climate model has been selected in the zone’s form.
7.7.12. Air flow in zone

Displays volumetric air flows through openings, leaks and mechanical ventilation.
7.7.13. Airborne heat flow into zone

Displays heat flows (sensible and latent) via supply air streams through openings, leaks and mechanical ventilation.
7.7.14. Surface temperatures

Displays temperatures of individual zone surfaces.
7.7.15. Surface heat fluxes

Displays heat fluxes through individual zone surfaces. For transparent surfaces or openings, short wave radiation is not included.

7.7.16. Delivered Energy

This report gives an overview of the total energy that has been purchased to (or generated within) the building. The items in the report correspond directly to defined Energy meters. In addition to meter energy, cost, emitted CO2 and used primary energy are also presented, both as absolute values and in relation to building floor area. The conversion factors between meter energy and the other measures are defined in Energy meters. If these factors are missing, no data is printed for the missing item in the Delivered Energy report.

Consumed amount of fuel is measured in terms of its heating (calorific) value in kWh.

Locally generated energy, e.g. from PV, is reported as being negative and can have separate price and other properties, reflecting, e.g., separate feed-in tariffs. Currently, all locally generated energy is sold.
The time evolution of the individual terms can be followed by selecting Log sources in the List of output objects.

### 7.7.17. Result – Systems energy

The report gives an overview of energy flows in the HVAC systems. It is divided into the following tables:

<table>
<thead>
<tr>
<th>Used energy</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>Zone heating</td>
<td>Heat delivered from the central plant or other, possibly local, heat generation devices to the zones. The distributed heat will normally be reduced by distribution and emission losses before it reaches the occupied space.</td>
</tr>
<tr>
<td>Zone cooling</td>
<td>D:o for cooling.</td>
</tr>
<tr>
<td>AHU heating</td>
<td>Heating energy supplied to all heating coils of central air handling units. No distribution losses are applied to the circuit between the plant and the AHU. The heating produced by electrical coils in the central AHU is included.</td>
</tr>
<tr>
<td>AHU Cooling</td>
<td>Energy removed by all cooling coils of air handling units. Note that a significant part of this energy may be latent due to condensation in coils. No distribution losses are applied to the circuit between the plant and the AHU. The cooling produced by electrical air conditioners in the central AHU is included.</td>
</tr>
<tr>
<td>Domestic hot water</td>
<td>Energy delivered to the domestic hot water circuit. The consumption rate is given in Extra energy and losses. Note that actual DHW end use may be smaller due to distribution losses.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Utilized free energy</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>AHU heat recovery</td>
<td>Heating energy recovered in AHU air-to-air heat exchanger or mixing</td>
</tr>
</tbody>
</table>
AHU cold recovery  D:o for cooling.
Plant heat recovery  Heating energy that is fed into the hot tank from the brine circuit heat exchanger, e.g. chiller waste heat or direct exchange with another source connected to the brine circuit such as an ambient air heat exchanger.
Plant cold recovery  Cooling energy that is fed into the cold tank from the brine circuit heat exchanger, e.g. heat pump evaporator waste cold or direct exchange with another source connected to the brine circuit such as a ground heat exchanger.
Solar heat  Heat collected from a solar thermal collector.
Ambient heat  Heat extracted from an ambient air heat exchanger and which is fed to the brine circuit.
Ambient cold  Cold extracted from an ambient air heat exchanger and which is fed to the brine circuit.
Ground heat  Heat extracted from a ground source and which is fed to the brine circuit.
Ground cold  Cold extracted from a ground source and which is fed to the brine circuit.

Generated electrical energy
category  comment
Solar (PV)  Power generated by a photovoltaic unit.
Wind power  Power generated by a local wind turbine.
CHP power  Power generated by a local combined heating and power unit.

Auxiliary energy
category  comment
Humidification  Energy used by any central humidification equipment.
Fans  Energy used by fans. Fan electricity consumption is by default based on computed air flows and user supplied pressure heads and efficiencies.
Pumps  Energy used by pumps. Pump electricity consumption is by default based on computed water flows and user supplied pressure heads and efficiencies.

Data for the distribution losses overview is governed by coefficients specified in Extra energy and losses. Results are presented in the following categories:

Distribution losses
category  comment
Domestic hot water circuit  Heat lost from water in domestic hot water distribution systems, either due to permanent circulation or to intermittent tapping.
Heating  Heat lost from water in hot water distribution systems.
Cooling  Cooling energy lost from water in cold water distribution systems.
Air ducts  Cooling energy lost from ductwork, both from transmission and air leakage.

A given percentage of each loss is emitted into zones according to floor area.
The data for report is collected by energy meter models (EMETER and EMETER2) that exist in Plant and AHU macros. When defining custom Plant and AHU macros, the user should add the missing meter models and check (and fix, if required) the connections of EMETER.INPOWER with variables that calculate the power, as described in the table:

<table>
<thead>
<tr>
<th>Category</th>
<th>EMETER model</th>
<th>Typically connected to</th>
</tr>
</thead>
<tbody>
<tr>
<td>Zone heating</td>
<td>Plant.EmeterLocalBoil</td>
<td>Q[2] in boiler model (type SIMBOIL)</td>
</tr>
<tr>
<td>Zone cooling</td>
<td>Plant.EmeterLocalChil</td>
<td>Q2 in chiller model (type SIMCHIL)</td>
</tr>
<tr>
<td>AHU heating</td>
<td>AHU.EmeterHeat (in every central AHU)</td>
<td>QHEAT in heating coil (type HCSIMCTR)</td>
</tr>
<tr>
<td></td>
<td>EmeterLocHeat (automatically generated when building the advanced level system)</td>
<td>Q in heating coil (type HCSIM) QELACT in electric coil (type HCEL) QLOCALUNITS in zone model (type CEDETZON and CESIMZON)</td>
</tr>
<tr>
<td>AHU Cooling</td>
<td>AHU.EmeterCool (in every central AHU)</td>
<td>QCOOL in cooling coil (type CCSIMCTR) QTOTOUT in cooling coil (type CCSIM)</td>
</tr>
<tr>
<td></td>
<td>EmeterLocCool (automatically generated when building the advanced level system)</td>
<td>QLOCALUNITS in zone model (type CEDETZON and CESIMZON)</td>
</tr>
<tr>
<td>Domestic hot water</td>
<td>Plant.EmeterWater</td>
<td>QDOMWAT in chiller model (type SIMBOIL)</td>
</tr>
<tr>
<td>AHU Heat recovery</td>
<td>AHU.EmeterRecycle (in every central AHU)</td>
<td>QACTUAL in heat exchange model (type HXSIMCTR)</td>
</tr>
<tr>
<td>AHU Cold recovery</td>
<td>AHU.EmeterRecycle (in every central AHU)</td>
<td>QACTUAL in heat exchange model (type HXSIMCTR)</td>
</tr>
<tr>
<td>Plant Heat recovery</td>
<td>Plant.EmeterHotTank</td>
<td>QHX2TANK in hot tank model (type TANKSTRAT). Implemented in ESBO plant only</td>
</tr>
<tr>
<td>Plant Cold recovery</td>
<td>Plant.EmeterColdTank</td>
<td>QHX2TANK in cold tank model (type TANKSTRAT). Implemented in ESBO plant only</td>
</tr>
<tr>
<td>Solar heat</td>
<td>Plant.EmeterSolar</td>
<td>QU in solar collector model (SOLTHCOL). Implemented in ESBO plant only</td>
</tr>
<tr>
<td>Ambient heat</td>
<td>Plant.EmeterAmbHX</td>
<td>Q in circuit control model (FREESUPCTR). Implemented in ESBO plant only</td>
</tr>
<tr>
<td>Ambient cold</td>
<td>Plant.EmeterGrndHX</td>
<td>Q in circuit control model (FREESUPCTR). Implemented in ESBO plant only</td>
</tr>
<tr>
<td>Ground heat</td>
<td>Plant.EmeterPV</td>
<td>P in PV model (PHOTOVOLT)</td>
</tr>
<tr>
<td>Solar (PV)</td>
<td>Plant.EmeterWT</td>
<td>PW in wind turbine model (WINDMILL)</td>
</tr>
<tr>
<td>Wind power</td>
<td>Plant.EmeterWT</td>
<td>PW in boiler model (BOIL1CIRC)</td>
</tr>
<tr>
<td>CHP power</td>
<td>Plant.EmeterCHP</td>
<td>QEL in humidifier model (type STINJCTR)</td>
</tr>
<tr>
<td>Humidification</td>
<td>AHU.EmeterHum (in every central AHU)</td>
<td>QSUP in fan model (type CEFAN) PowerSup in axial fan (type AxialFan)</td>
</tr>
<tr>
<td>Fans</td>
<td>AHU.EmeterFans (in every central AHU)</td>
<td>PPUMP in chiller, boiler, and pump models</td>
</tr>
<tr>
<td>Pumps</td>
<td>Plant.EmeterPump</td>
<td></td>
</tr>
</tbody>
</table>
7.7.18. Result – Energy report for an air handling unit

The report gives an overview of energy flows in an individual AHU.

Data is presented in the following categories:

<table>
<thead>
<tr>
<th>Category</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>Heating</td>
<td>Heating energy supplied to all heating coils.</td>
</tr>
<tr>
<td>Cooling</td>
<td>Energy removed by all cooling coils. Note that a significant part of this energy may be latent due to condensation.</td>
</tr>
<tr>
<td>Heat recovery</td>
<td>Heating energy recovered in AHU air-to-air heat exchanger or mixing box.</td>
</tr>
<tr>
<td>Cold recovery</td>
<td>D:o for cooling.</td>
</tr>
<tr>
<td>Humidification</td>
<td>Energy used by humidification equipment.</td>
</tr>
</tbody>
</table>
Fans

Energy used by fans.

The data for report is collected by energy meter models (EMETER and EMETER2) that exist in the AHU macro. When a custom AHU macro is built, the user should check (and fix, if required) the connections of EMETER.INPOWER to variables that calculate the power, as described in the table below.

<table>
<thead>
<tr>
<th>category</th>
<th>EMETER model</th>
<th>Typically connected to</th>
</tr>
</thead>
<tbody>
<tr>
<td>AHU heating</td>
<td>EmeterHeat</td>
<td>QHEAT in heating coil (type HCSIMCTR)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Q in heating coil (type HCSIM)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>QELACT in electric coil (type HCEL)</td>
</tr>
<tr>
<td>AHU Cooling</td>
<td>EmeterCool</td>
<td>QCOOL in cooling coil (type CCSIMCTR)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>QTOTOUT in cooling coil (type CCSIM)</td>
</tr>
<tr>
<td>Heat recovery</td>
<td>EmeterRecycle</td>
<td>QACTUAL in heat exchange model (type HXSIMCTR)</td>
</tr>
<tr>
<td>Cold recovery</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Humidification</td>
<td>EmeterHum</td>
<td>QEL in humidifier model (type STINJCTR)</td>
</tr>
<tr>
<td>Fans</td>
<td>EmeterFans</td>
<td>QSUP in fan model (type CEFAN)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>PowerSup in axial fan (type AxialFan)</td>
</tr>
</tbody>
</table>

The time evolution of the individual terms can be followed by selecting Log sources in the List of output objects.

7.7.19. Result - Lost work

Too high or too low temperatures in a room result in production losses from workers. In ICE 3.0 some models for this according to Wyon have been included. For operative temperatures
between 20 and 25°C no work is regarded as lost. Above and below these limits experiments indicate an average loss of 2 % in performance per degree.


7.7.20. Result – Zone energy

The report shows the sensible heat balance for a single or a group of zones. (See the Heat balance diagram for a total (wet and dry) heat balance).

Data is presented for each month as well as for the whole simulation period. In addition, each heat flux is divided into the “during cooling,” “during heating” and “rest of time” categories. A gain as for example heat from a piece of office equipment, is beneficial when it occurs when the zone has a heating need. Similarly it is harmful when there is a cooling need. The algorithm for this categorization is further described below.

An overview and a specification of envelope transmission losses are presented. The control volume is inside walls, at the ceiling and at the floor surface. However, in the case of embedded (slab) heating/cooling, the control volume includes the activated layer and thereby contains significant thermal mass. The overview has the following columns:

<table>
<thead>
<tr>
<th>category</th>
<th>comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>Envelope and thermal bridges</td>
<td>Heat gained through external walls, floors, roofs and through thermal bridges.</td>
</tr>
<tr>
<td>Internal walls and masses</td>
<td>Heat gained through internal walls, floors, ceilings and internal masses.</td>
</tr>
<tr>
<td>External window and solar</td>
<td>Net heat gain through external windows, i.e. through long and short wave radiation as well as via transmission trough pane and frame. Advected heat through open windows is included in Infiltration and openings. Note that transmission only is presented in a separate table.</td>
</tr>
<tr>
<td>Mechanical supply air</td>
<td>Heat supplied by mechanical ventilation.</td>
</tr>
<tr>
<td>Infiltration and openings</td>
<td>Heat supplied via air from leaks and openings. For systems with only mechanical exhaust ventilation, all supply air will be accounted for here.</td>
</tr>
<tr>
<td>Occupants</td>
<td>Heat from people in the zone, excluding heat from perspiration.</td>
</tr>
<tr>
<td>Equipment</td>
<td>Heat from equipment in the zone, e.g. computers etc.</td>
</tr>
<tr>
<td>Lighting</td>
<td>Heat from artificial lighting.</td>
</tr>
<tr>
<td>Local heating units</td>
<td>Heat from controlled heating units, e.g. radiators, fan coils etc.</td>
</tr>
<tr>
<td>Local cooling units</td>
<td>Heat from controlled cooling units, e.g. chilled beams, fan coils etc.</td>
</tr>
<tr>
<td>Net losses</td>
<td>Heat from pipes, ducts etc., the leakage from which has been defined in Extra energy and losses.</td>
</tr>
</tbody>
</table>

The time evolution of the individual terms can be followed by selecting Log sources in the List of output objects. This diagram can be used to display a sensible only heat balance for the zone. NB! This balance will not generally sum to zero, since latent sources are neglected and thermal mass can be included in the control volume. The control volume for the Zone energy object includes any embedded heating or cooling coil in the structure and may therefore have a significant thermal mass.
The table for Envelope transmission shows heat flux via transmission only through the building envelope. It has the following columns:

<table>
<thead>
<tr>
<th>category</th>
<th>comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>Walls</td>
<td>Heat gained through external walls</td>
</tr>
<tr>
<td>Roof</td>
<td>Heat gained through the roof.</td>
</tr>
<tr>
<td>Floor</td>
<td>Heat gained through any external floor (towards ambient or the ground).</td>
</tr>
<tr>
<td>Windows</td>
<td>Heat gained via transmission only, through windows and frames</td>
</tr>
<tr>
<td>Thermal bridges</td>
<td>Heat gained through thermal bridges.</td>
</tr>
</tbody>
</table>

The algorithm for categorization will keep track of each gain term and integrate it separately for the categories “during cooling” and “during heating.” When the zone temperature is above or slightly below the Max temperature as specified in the Setpoint collection, all gains are collected in “during cooling”. This is also done when no mechanical cooling exists, i.e. in this case the Max temperature is regarded as “Maximum preferred temperature.”

Similarly, a gain is collected in “during heating” when the temperature is below or slightly above the Min setpoint. “Slightly” in both cases is defined as half of the throttling band for proportional controllers, i.e. by default 1°C. When the distance between Min and Max setpoints is getting too small, “slightly” is instead interpreted as 25% of the dead band.

A heat gain that occurs while the zone temperature is within the dead band (minus “Slightly” on each side), is also integrated. However, this integration is done with an exponentially decaying weighting factor that accounts for if the heat gain is old or new. For example, a heat gain contribution that occurred several days ago – assuming the zone is floating in the dead band – is forgotten, while a gain that is occurring just as the zone about to leave the dead band is counted almost fully. The time constant for this memory is by default 24h but can be selected in System parameters.

7.7.21. Thermal comfort report

<<Not written yet>>